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Callback Solution Guide

Callback Solution Guide

Welcome to the Callback Solution Guide! You can use this guide as a starting point to configure
Callback services.

Find information to help plan Callback

e Solution Overview: Features, Use Cases, Scenarios
¢ Architecture: Components, Key Advantages
* Prerequisites:
e Hardware, OS, Browser, Java, Genesys Requirements

* Integration with GVP or Media Server

Find instructions to configure Callback

Once you have set up the Prerequisites, find procedures to configure Genesys Callback.

e Strategy for queuing

e Accept inbound calls

* Enable outbound calls

¢ Enable Call Progress Detection

¢ Enable Callback Ul for Administrators

Provision your Callback Services

Find procedures to create and configure the Callback services required to implement scenarios.

* Access Uls

e Add a Callback Service
¢ Manage Callbacks

* Set up Play Treatments
¢ Set up Office Hours

¢ Define Capacity

e Add Exception Patterns
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e Enable Status Notifications for Callback

Provisioning should be performed through the GMS Service Management Ul. Read the
complete help here.

Learn about scenarios

Find more details about the available scenarios and Service Configuration

¢ User Terminated Immediate
¢ User Terminated Delayed
e User Terminated Scheduled

¢ User Terminated Delayed Agent Preview

Learn about options

¢ Callback Service Options Reference

Learn about Callback and Service APIs

Once your Callback Service is ready, you can start implementing your application.

APIs related to Callback Services, builtin services, and ORS scenarios are detailed in GMS API
References.

¢ Callback Services API

e Calendar API

« Capacity API
For custom samples, see:

e ClassicCallbackSample illustrates how to implement an IVR (Genesys Voice Platform VoiceXML)

application that communicates with GMS and performs classic Callback scenarios.

e Custom Callback Sample implements an On-Dial plugin to interface with the GMS Callback service.
Developers should use this sample as a reference to build a Composer application that is invoked as a
plugin from GMS Callback.
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The Service Management Ul also includes a Sample panel to test your Callback Services.
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Solution Overview

Callback is built on top of the Genesys Mobile Services (GMS) platform, which enables mobile and
other applications to use Genesys callback capabilities from their applications. Integration with the
contact center callback functionality is accomplished through APIs that can be accessed through the
internet and deployed into your network infrastructure.

Scope of Use

Typical usage scenarios of callback include:

e Schedule, immediate, or delayed callback requests.

* Preview callback requests.

* Proactive notification.

e Schedule callback with enhancement multimedia confirmation.

e Schedule an immediate return call or a callback at a convenient time of the customer’s choosing, based
on operating business hours.

e Check and display agent availability by providing estimated wait times.

e Support for mobile push notification to provide an alert when agent is available.
In addition, Callback includes:

e Samples to integrate with Genesys Web Desktop.
¢ APIs to integrate with your own environment.
¢ An intuitive interface to simplify management and reporting of callbacks.

e RESTful APIs, optimized for mobile, web, and IVR.

Use Case: IVR Callback

Requirement: If your contact center is busy, use IVR to offer an option for Callback while retaining
the caller’s position in queue, in order to free up valuable IVR resources and optimize contact center
resources.

Callback Solution
¢ Use GME Stats API to check the Estimated Wait Time for the caller and determine if the caller should be
offered a callback option.

» Use Callback to offer the caller an option to hang up and call back when an agent is available, while
retaining the caller’s position in queue.

e The call is virtually queued and called back when an agent is available
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Tip

Callbacks can also be scheduled at the caller’s convenience.

Use Case: Credit Card Use Verification

Scenario: When a credit card is used abroad without a previous arrangement, the bank must verify
that the user is authorized to accept or reject the transaction.

Solution:

e Send native Push notification to a registered banking app on the customer’s mobile device.

e Offer Click-To-Connect to an agent with contextual information, such as the credit card number and the
user location.

» Offer help via callback from an agent.

Tip

You can also offer to contact the user with backup methods, such as email and SMS.

Use Case: Vehicle Roadside Assistance

Scenario: Scenario: An insurance company offers a Vehicle Roadside Assistance service. When the
car breaks down, the driver uses the mobile app to get assistance.

Solution:
e Offer Connect Me to deliver the driver’s location and account information to the contact center that can
forward the information to a towing company.
e Offer callback when all agents are busy.

e Send native Push notification to provide status of assistance. For example, tow truck is dispatched with
ETA

Callback User's Guide 8
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Supported Callbacks

‘Carrier = 11:39 AM =

Contact Us

Call me back in...

Callback includes pre-defined scenarios that you can easily implement through the Callback

There are two types of scenarios for Callback:

* Immediate: callback happens as soon as an agent is available.

* Scheduled: callback occurs at an agreed to time in the future.

In the graphic shown here, the app offers the customer a scheduled callback.

For instance, the following basic scenarios are available:
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Call flow for User Terminated Immediate

Genesys PSTN t J

Callback
Customer Agent

App requests a callback

-

User is informed of success

Callback initiates phone call

——

Call is placed over PSTN

|

Call is routed to best resource

I

In this scenario, the customer requests an immediate callback, that is, as soon as the agent i
available.

Start Callback
[+] Start Callback

Callback service: Sends a message to expect a call, to the mobile device immediately.

Callback service: Calls the mobile device.

Mobile device: Accepts the call.

Callback service: ldentifies that a human has answered the call.
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Dial Access Number

[+] Connect Agent

Connect to Agent

Callback service: Reserves t

arget to route call.

Callback service: Routes the call to the target agent.

Callback service terminates.

Call flow for User Terminated Delayed

Genesys
Callback

Customer

Callback service: Plays treatment until target is available.

App requests a callback number

-y

Callback requested queued

Access number returned

a

PSTN

Agent

Callback request
reached front of queue

User initiates call to PSTN

Ty

Genesys platform is notified

Call is routed to best resource

S
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In this scenario, the customer schedules a callback.

Start Callback

[+] Start Callback
*Callback service: Returns session ID to the user.

» Callback service: Waits for an agent to be available.
» Callback service: Notifies mobile device when an agent is available.

* Next: Mobile device is expected to send a connect request to confirm the user's availability.

Connect

[+] Connect
* Callback service: Immediately returns access information to the mobile device.
* Callback service: Waits for the voice call to arrive.

* Next: Mobile device is expected to dial the access number.

Dial Access Number
[+] Dial Access Number
e Inbound service: Locates the GMS service associated with the arrived voice call.

* Inbound service: Delegates the call to be processed by the Callback service.

Callback service: Reserves the target to route the call.

Callback service: Routes the call to the target.

Callback service terminates.
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Architecture

Callback is deployed on top of the Genesys Mobile Engagement Platform that allows mobile and other
applications, for example, IVR and Web, to connect and use Genesys Callback. The Callback
complexity of integrating Callback with the contact center is hidden and embedded through simple
REST APIs that are:

e Optimized for the Mobile and Internet Data network

¢ Easily deployed in existing customer network infrastructures

Components

IVR Genesys Servers 1

—>
'})) > GVP ORS

Native App - URS I

"m » SIP Server

HTTP
Load Balancer

I T

- l HTTP
Mative App
v
-m } I I Cassandra Cluster
HTTP(S)
Web Load | >
Balancer GMS Node N
WWW > -
= T
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Architecture

The main components for Callback are:

Genesys Mobile Services (GMS) - This component controls and exposes the Genesys API functi
external applications by REST APIs, and provides critical callback services (for example, callba
management). GMS provides a user interface to manage the provisioning and deployment of ¢
services. This same user interface also provides basic callback service monitoring capability.

Orchestration Server (ORS) - This component provides various callback communication proces
callback inbound treatments, and matching services.

Genesys Voice Platform - This component provides custom treatments through SCXML or Voice
plugins as configurable options for the Callback Service template. If you don't need IVR, you ci
replace it with a Media Server.

SIP Server - This component provides play treatments, Call Progress Detection (CPD), and outb
management.

Universal Routing Server - This component routes interactions.

Also consider reading the Universal Routing Voice Call Back White Paper that details two types of
Voice Call Back (VCB) solutions managed by Universal Routing Server (URS):

* Pre-emptive Agent Reservation

¢ Dialing Notifications

Key Advantages

¢ A multi-channel, integrated solution that provides customer service access to context, such as customer
profile, history, and location

e Tightly integrated with Genesys routing and does not disrupt queuing

¢ Optimized REST and Ajax Push interfaces for mobile, web, and IVR

* Flexible connection for adding callback anywhere in the interaction: click-to-connect voice, push
notification, chat, delayed or immediate

¢ Native Estimated Wait Time, based on URS/Stats Server

Callback User's Guide 14
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Prerequisites

Modified in 8.5.2

Callback is provided through Genesys Mobile Environment components and requires that your system
meets the software requirements established in the Genesys Supported Operating Environment
Reference Manual for Genesys Mobile Services (GMS), as well as meeting the following minimum

requirements:

Hardware Requirements

The following are minimum requirements:

¢ CPU: Quad Core
* Memory: 4GB
¢ Disk: 160GB

¢ At least 2-3 nodes recommended for redundancy and availability

OS Requirements

¢ Genesys Supported Operating Environment Reference Guide

For Linux installations, the Linux compatibility packages must be installed prior to
installing the Genesys IPs.

Browser Support

* Supported Operating Environment Reference Guide

Callback User's Guide 15
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Prerequisites

Java Requirements

Java 64 bits

Before 8.5.206.04: Support for JDK 8 only

Starting in 8.5.206.04: Support for Open JDK 8

Starting in 8.5.208.09: Support for Open JDK 11 and for Oracle DK 11
Starting in 8.5.300.02: Support for Open JDK 17

Starting from 8.5.300.02, GMS no longer supports JDK 8 and 11.

Tip

Edit JAVA HOME to point to the DK installation folder, for example,

C:\Program Files\Java\<your JDK>.In some scenarios, the GMS installer may fail
to find Open JDK 1.x. The workaround is to install Oracle JDK first, proceed with the
installation, then once GMS is installed, point the JAVA_HOME variable to Open)DK.

Cassandra Support on Linux

Modified in: 8.5.230.06

GMS now supports Datastax Driver

¢ Cassandra 4.X: Tested version is 4.0

Tip
When you deploy Genesys Mobile Environment for Chat APl V2, Email APl V2, and

Open Media API V2, Cassandra is required only if you enable mobile push notifications.

Genesys Environment

Modified in 8.5.200.07, 8.5.201.04

Callback User's Guide
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In addition to having a Genesys Management Framework 8.1 environment installed and running, the
following table lists the Genesys components that are used with a GMS installation.

Genesys Component

Orchestration Server (ORS)

Universal Routing Server (URS)

Interaction Routing Designer
(IRD)

SIP Server

Chat Server

Interaction Server
Universal Contact Server (UCS)
E-mail Server (ES))

Minimum Version Required

» 8.1.400.26

e 8.1.400.74 for GMS
8.5.201.04 and higher

8.1.400.45

8.1.400.26

8.1.100.67

8.1.000.26

8.5.105+

8.5.109+

8.0.200.11
8.5.200.19
8.5.103.01

Comments

Optional, installed, and running:

e An HTTP port must be enabled

in the related Application
object.

e The ORS server must use the
Orchestration Server type

in Configuration Manager.

e Deploy ORS in non-clustered
mode. As a result, an ORS
primary outage does not
recover callback sessions.
However, GMS detects and
re-schedules callbacks on
ORS Backup. GMS similarly
recovers from ORS session
failures.

You need a minimum of ORS
8.1.300.30 to be able to do Load
Balancing with GMS.

Mandatory, required for the GMS

services, and if you plan to use
URS-based dialing in Callback
applications.

Mandatory, required for
strategies running on URS.

e SIP or Inbound Voice is
required for agents.

e S|P Server is recommended
for outbound calling for
Callback.

Used for Chat support.

Required if you plan to use
features related to file
management.

Required if you plan to use
Digital Channels Chat over
CometD API feature.

Used for Chat support.
Used for Digital Channel.
Used for Digital Channel.

Callback User's Guide
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Genesys Component

Stat Server

Media Server

Resource Manager

Workspace Desktop Edition

Minimum Version Required
8.x

8.1.410.33

8.1.410.13

(optional) 8.5.111.21

Integrating with GVP or Media Server

Comments
Used to obtain statistics.

Used for Callback services, in
order to play treatments and use
Call Progress Detection (CPD) for
outbound calls.

Used for Callback services, in
order to play treatments and use
Call Progress Detection (CPD) for
outbound calls.

Support for Genesys Callback.
This component is not
mandatory.

Genesys Voice Platform (GVP) provides VoiceXML features in addition to the Media Server features.
You need GVP only if you need VoiceXML. In any other case, Media Server is sufficient and will provide

better performances without GVP.

See GVP Documentation for further details.

Historical Reporting

Mandatory Genesys Components

Component
Orchestration Server 8.1.400.24
Universal Routing Server 8.1.400.22
Interaction Concentrator 8.1.506.07
Genesys Info Mart 8.5.005 (GA)
Reporting and Analytics Aggregates (RAA) 8.5.000.02
Genesys Interactive Insights (GI2) 8.5.000.02

Minimum Version

Callback User's Guide
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Configure Callback

Configure Callback

Before you start configuring Callback, make sure that you setup and installed your
Genesys Environment.

Configuring a Callback service involves:

¢ Importing a URS strategy.
e Setting up inbound and outbound calls.

¢ Setting Roles for the Callback Ul.

Then, you will be able to create a Callback service in the Callback Ul, associated with one of the
Callback scenarios detailed in the Scenarios section.

Callback User's Guide
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Configure Callback Set up URS Strategy for Queuing

Set up URS Strategy for Queuing

Enable HTTP Interfaces in URS

Create a Listening HTTP Port in URS

URS will listen on this port for incoming HTTP requests. Basically, this steps turns URS into an HTTP
server.

Routing Parameters Reports Administration Centralized Logs Web Engagement ?

Configuration

Home > Applications > Applications > Universal_Routing_Server Properties

|E2 Clone I Delete I Move To

General

Ports Add

Connections

ID & Port & Connection 2 HA S
Ports

default 7202
Tenants

http 5590 http
Options
Permissions
Dependencies %

Application Options

Cancel

In Genesys Administrator Extension, edit your URS application.

Add an HTTP listening port with a port ID http in the Ports tab. Make a note of this port number as
you will need it later when configuring GMS and ORS-based services.

Callback User's Guide 20
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Configuration

Home > Applications > Applications > Universal_Routing_Server Properties 1 clone 1 Delete Il Move To
General
Application Options Q, Quick Filter Add %X More
Connections
Key El value El
Ports
» default H ! . H
e Do not configure this port in the http section
Tenants
: v e if you already added it to the Ports tab!
Options
_verbose 3
Permissions
log_file C:\legs\Universal_Routing_Server\UR_Server HTTP.log
Dependencies
[ http_port 5530
Application Options {b
¥ log
alarm
all C:\logs\Universal_Routing

You can also do this by creating the http port option in the http section of your Application
Options tab.

Warning

This HTTP port needs to be created in one place only.

Enable Web HTTP Replies in URS

URS uses the httpbridge module to send target information back to GMS. To make this possible,
create a web HTTP port that will be used to reply. URS will be able to perform external HTTP requests,
for example, to submit timetodial events to GMS, and so on.

The listening http port created in the previous section and the web port defined
below MUST have different values.

Callback User's Guide 21



Configure Callback Set up URS Strategy for Queuing

Home = Applications = Applications > Universal_Routing_Server Properties & Clone T Delete | Move To

General

Ports Add

Connections

h} B Port B Connection B HA Sync 5 Listening Mode
Ports .

default 7202 Unsecured
Tenants

http 5540 http Unsecured
Options

web 5580 http Unsecured
Permissions

Dependencies

Application Options

In Genesys Administrator Extension, edit your URS application. Add an HTTP port with a port ID web in
the Ports tab.
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Configuration

Routing Parameters

Centralize

Home > Applications > Applications > Universal_Routing_Server Properties

Clone [ Delete I Move To

General
Application Options Q Quick Filter Add  £X More
Connections
Key & Value v
Ports
Tenants > hitp Do not configure this port in the web
Options > log section if you already added it to the
Ports tab!
Permissions v web
Dependencies _verbose 3
Application Options enable_web_access true
http_log_buffering false
http_log_file Ci\logs\Universal_Routing_Server\UR_Server_...
http_port 5580

wfm_polling_interval 1

Cancel

You can also do this by creating the http port option in the web section of your Application
Options tab.

e http _port = 5580 (or some other port, used internally)

Warning

This HTTP port needs to be created in one place only.
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Configure URS Delay Strategies

You must deploy URS delay strategies. This step is required because when a service request is
received by GMS, the request is sent to ORS for execution. ORS then sends a request to URS to create
a virtual interaction and to place it in the specified virtual queue. When an agent is available, URS
sends an asynchronous response containing the selected target information to GMS, via a URL
specified at the time of the creation of the virtual interaction. For samples, you will create a new
virtual queue in which to place the interactions, however, for a real-world scenario, the virtual queue
must be selected appropriately.

To deploy URS delay strategies, open Genesys Administrator Extension.
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Create a dedicated Virtual Queue

Home = DNs = Switches = SIP_Switch = DN = Virtual. .. &3 clone ﬁ Delete | Move To
General
Number * Type*
Default DNs GMS_VQ Virtual Queue v
Options Switch*
SIP_Switch
Permissions
Association Register *
Dependencies True v
Alias Route Type *
GMS_vQ_SIP_Switct] Default [s v
DN Group
|
Override
v Use Override
Login ID Switch-specific Type
1
Number Of Trunks
0
Cost Contract Site
Im |
Tenant
. +| State Enabled
Environment

Navigate to Switching > DNs > Switches > SIP_Switch > DN > Virtual Queue and create a virtual
queue GMS _VQ. Save and configure the alias GMS_VQ SIP Switch. You will need this alias when you
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will configure the urs virtual queue option of your Callback service.

Enable ORS to pull interactions and URS to receive routing

requests.

Configuration

Home = Applications = Applications = Universal_Routing_Server Properties 18 Clone T Delete I Move To
General
Application Options Q. Quick Filter Add XX More
Connections
Key E Value E
Ports
¥ default -
Tenants
use_ivr_info true
Options
use_agent_capacity true
Permissions
automatic_attach true
Dependencies
compat_treatments true
Application Options
call_tracking true
report_targets true
route_consult_call true
#event_arrive {b ringing
targets_order random
strategy ORS

Edit the Universal Routing Server Application and select the Options tab. Enable ORS to pull
interactions by setting the strategy option to ORS in the default section.

Now, you can download the URS Strategies and import them into IRD. See the download section
below to manage the downloadable files.

Configure Multiple Targets

The option _target in the URS Queuing section of your callback service allows you to configure one or
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Set up URS Strategy for Queuing

more URS targets (as detailed in the option's description).

To configure multiple targets, you must create a JSON array of targets (maximum 15) and for each
target, you provide a statistic condition that the system will check. This condition specifies when to
switch to the next target. If the condition is not matched, the interaction will be queued. Otherwise,

the system will test the condition of the next target,

Start Queueing
Process

Timeout
L 3 ¥
Cancael Select Flrst Target
r
' . Yes Is last Mo
Queue.Submlt target?
Routed To Agent
(] T
Stat
Queue Submit  ~ N° Cond
hatch?
Timeout
Yes
L
Mext Target

as detailed in the diagram below.

Stat
Cond Mo
Specified
?
Yes
]
Set Stat Check to

NO agents logged in

The condition is defined by the parameters stat to check, stat operator (< or >) and

stat value.
For example, if you set:

{
"target": "GMS AG Kilfoil@Stat Server.GA",
"timeout": "15",
"clear": false,
"stat to check":
"stat operator":
"stat value": "1"

"StatAgentsAvailable",

< ’

¢ The system will change to the next target in the list if StatAgentsAvailable < 1 (no agentis

available).

e The system will queue the interaction to the target GMS_AG_Kilfoil@Stat Server.GA only if
StatAgentsAvailable >= 1 (which means that at least one agent is available). If the duration
specified in the target timeout has passed, and if the agent is not selected, then the statistic condition
for the next target is checked before queuing the interaction for the next target. You can also expand to

the next target if clear = false.

Callback User's Guide
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If you do not set a condition by using stat to check, stat operator, and

stat value, then the tested condition is set by default to no logged in agents.
That means that the interaction is queued to a target only if at least one agent
belonging to the target is logged in.

The stat _to_ check property can be set to any of the values supported by the Statistics parameter
passed to the IRD function SData(Target, Statistics), unless target is a skill expression. If
target is a skill expression, you must choose one of the following values:

e RStatAgentsReadyvoice—agents ready for voice media.
e RStatAgentsReady—agents ready for any media.
* RStatAgentsTotal—agents logged in

The JSON code below is a sample of value for the target option and includes 5 different targets.

[

"target": "GMS AG Kilfoil@Stat Server.GA",
"timeout": "15",

"clear": false,

"stat to check": "StatAgentsAvailable",
"stat operator": "<",

"stat value": "1"

"target": "GMS AG Milburn@Stat Server.GA",
"timeout": "10",

"clear": false,

"stat to check": "StatAgentsAvailable",
"stat operator": "<",

"stat value": "1"

"target": "GMS AG Monique@Stat Server.GA",
"timeout": "30",

"clear": false,

"stat to check": "StatAgentsAvailable",
"stat operator": "<",

"stat value": "1"

"target": "GMS AG Oladipo@Stat Server.GA",
“timeout": "15",

"clear": false,

"stat to check": "StatAgentsAvailable",
"stat_operator": "<",

"stat value": "1"

"target": "GMS AG Sippola@Stat Server.GA",
"timeout": "15",

"clear": false,

"stat to check": "StatAgentsAvailable",

"stat operator": "<",

Callback User's Guide
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"stat value": "1"

Use of EWT VQ TARGET in the WaitForTarget IRD Strategy

In Estimated Wait Time scenarios, you can use the EWT VQ_TARGET variable to peg a non-
configured Virtual Queue (VQ) to access the URS LVQ function for this VQ from your inbound routing
application.

The EWT _VQ_TARGET parameter is a copy of the _urs_ewt virtual queue that you can configure in
this purpose.

Since the VQ is not configured, it is internal to URS, no EventQueued or
EventDiverted events will be issued.

To peg the VQ, proceed to the following changes:

1. Configure the _urs_ewt_virtual_queue option with a non-configured virtual queue name.

2. Download the GMS Callback WaitForTarget strategy available in the URS Strategies for Download section
below.

3. Open Interaction Routing Designer (IRD), select the Routing Design / Strategies tab, then load and
compile the GMS Callback WaitForTarget strategy.

4. Add a function block to the WaitForTarget workflow as following:
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[*% Routing Design - WaitForTarget_lvg test

JJ File Edit View Tools Help

ELERIEE R L] |

[BQaé o BEEDe.s = |mra| [|rwesex
LIIIIIIID Log Version 2.72 Lo
N, | Prerequisites: R,
:::::::::::::::::@. oo IRD 8.1.400.26 Sl
S| | URs 8140047 SEEEEEEN
oo e - GMS 8.5.201.04 S
ol R ) SERREREEEE
B R N HHEHE I
| extension aftrbutes .?P##%@I.D@I.e.::::::::::::::::::::::::::
e ey
N _eadyroutabla Mark non routable - - -

5. Edit the function block:
e Under Select expression, enter a new expression name.
* Under Data > Name, select SelectDN.
* In the parameters' table, configure:
e Virtual Queue Name = EWT _VQ TARGET
e Priority =0
¢ SelectionFlag = StatSelectMin

e Target = LOSTFOREVER@.Q
Note: In this example, LOST FOREVER is the name of the non-configured VQ.
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Set up URS Strategy for Queuing

&5 Function properties

General |
— Expression
~|[= [selectDN
[ EWT_VQ_TARGET.D." StatSelectMin,LOST_FORE
VER@.Q7]
—Data
Type Mame
RouteCall a Add |
Calllnfo Routed
Corfiguration Options RouteDelay Veerify |
Data Manipulation Router
Date/Time RwgData
Force SData
List Manipulation SDatalnTenant
Miscelaneous v i Varables |
i o
Parameter Value
Yirtual Queue Name _EWT WO TARGET
Priority 0
Statistics
Selection Flag StatSelectMin
Target LOST_FOREVER®@.O

Retum value type: STRING farget). This function comespands to the initial steps of the A
operation of @ Target-Select object: creating an intemal router queue as a part of a
prescribed virtual queue, inguiring from Stat Server on the availability of any of the listed

L

o< |

Cancel

Help

* Save and compile the block. The WaitForTarget block is now available and ready in the Strategies

tab.

Of course, if you do not use the block, it does not affect the existing WaitForTarget strategy.

¢ These changes can be lost when you upgrade GMS to a newer version. You will have to
redo the steps above if you install a new version of the URS WaitForTarget strategy.

* You can also rename your modified URS strategy and use the _urs_prioritization_strategy
callback service option to select your URS strategy name instead of using the

WaitForTarget default one.
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EWT Usage

This configuration ensures that you can use the lvq URS HTTP request using the connid parameter of
your callback as max to get the URS calculation results for the Estimated Waiting Time and the
position in the Virtual Queue.

curl -v http://<URS_host>:<URS http port>/urs/call/max/lvqg?<parameters>

To get detailed information about this query, check the following URL:
http://<URS_host>:<URS_http_port>/urs/help/call/lvq

URS Strategies for Download

When you upgrade GMS, you need to import the Callback Template from your GMS
installation directory. Start the Service Management Ul, upload the <GMS
Installation Directory>/service templates/callback.zip file, and restart ORS.

GMS version ZIP Instructions

8.5.200.09 and higher GMS_URS_Strategy 85200 v2.64.1.zip 1. Download and unzip the zip

file containing the URS

8.5.207.05 and higher GMS_URS_Strategy_85200_v2.66.zip LB S,

2. Open Interaction Routing

. Designer (IRD).
8.5.208.09 and higher GMS_URS_Strategy 85208 v2.72.zip

3. Import the strategy
WaitForTarget.zcf, and
subroutine
SetRouteDelay.zcf, using
File > Import From File on the

. , respective tabs.
8.5.230.06 and higher GMS_URS_Strategy 85230 v2.73.zip

4. Open the strategy and
subroutine.

5. Compile and save.

e Starting in 8.5.109.08, the URS Dial Success Rate is set to 85% when new callbacks are created to
improve the callback performance.

e Starting in 2.64.1, the DialOutSuccessRate function of the WaitForTarget strategy is no longer
invoked to allow the enhanced VCB algorithm within Universal Routing Server to work properly. If your
application requires the legacy VCB algorithm to work, change the strategy to invoke the
DialOutSuccessRate function as in earlier versions of the strategy.
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You do not need to load the strategy in ORS because ORS will request it when needed.
See the Interaction Routing Designer help file for information about using IRD.

Additional Deployment Steps
Prerequisites:

If you are upgrading Callback from GMS 8.5.004.xx and earlier, make sure that you have the following
components and versions installed:

e Interaction Routing Designer (IRD) 8.1.400.26

¢ Universal Routing Server (URS) 8.1.400.39

Deployment Changes

. Uninstall your existing IRD.

. Install IRD 8.1.400.26.

. Delete the existing WaitForTarget strategy.

. Delete the existing SetRouteDelay subroutine.

. Download the strategies for GMS versions 8.5.114.09 and higher.
. Import into IRD.

. Compile both strategy and subroutine.

. Uninstall your existing URS.

. Install URS 8.1.400.39.

© 00 N O U B~ W N -

Do not skip step 7. This step is mandatory to ensure that the strategy and subroutine
are properly saved and loaded into IRD.
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Accept Inbound Calls

For some voice scenarios, you must create an SCXML scenario to manage inbound calls related to
Callback. The customer retrieves a number to call that is associated with a list of DNs dedicated to
the Callback scenarios. This page details how you create configuration objects and scripts related to
these inbound calls.

Setting up Acceptance of an Inbound Call

To enable the Callback service to accept an inbound call, Orchestration Server (ORS) requires a
SCXML file to manage inbound calls. On this page, samples use the inbound.scxml available in the
<GMS installation directory>\service templates\callback.zip file. Unzip the file. The
inbound.scxml file is located in the <GMS installation directory>\service templates\
callback\src directory.

Tip
You can customize the inbound.scxml file or create new SCXML files dedicated to
Callback in this directory.
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Create a Callback Inbound Script Resource

Configuration ~ Routing Parameters eports

Home = Scripts = Scripts = GMSInboundUlSample Properties

1 clone i Delete

General
Options Q, Qquick Filter
Options
Key B Value
FEIEE URL of the inbound.scxml file

¥ Application
Dependencies

¥ ApplicationParms

Cancel

url http://135.39.45.125:8010/genesys/1/document/service_template/callbac...

_treatment_customer_connect http://localhost:8010/genesys/1/document/service_template/callback/Re...
_treatment_find_agent_fail http://localhost:8010/genesys/1/document/service_template/callback/Re...
_treatment_waiting_for_agent http://localhost:8010/genesys/ 1/document/service_template/callback/Re...
app_find_agent_timeout 120

app_gms_offer_callback true

app_gms_service_name samples

app_gms_service_uri http:(/135.39.45.125:8010/genesys/1/service/samples
app_selected_agent_group Customer_Service

Navigate to the Environment > Scripts section of Genesys Administrator Extension and click New
to create the script resource.

1. Enter a name, for instance GMSInboundUISample, select the SCXML type, and click Save.

2. In the Options tab, enter the Application > url of your SCXML file:
http://<gmshost>:<gmsport>/genesys/1/document/service template/callback/src/
inbound.scxml

3. Then, create the following parameters in the ApplicationParms section:

app_find agent timeout = <timeout in seconds when routing to agent for GMS match fails>
app_selected agent group = <agent group for GMS match fails>

treatment for no match = <treatment file prior to routing on GMS match fail>

require access code = <true/false>

require ani = <true/false>

4. Save your script object.
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Create DNs for your Callback Inbound Script Resource

Configuration Routing Parameters

Home = DMs = Switches = SIP_Switch = DN = Routing Point = 8025 Properties &2 clone T Delete I Move To
General .
Options Q, Quick Filter Add  £X More
Default DNs
Key B Value E
Options

¥ Orchestration
Permissions
application script:GMSInboundUiSample
Dependencies

o\

Browse or create DNs of type Routing Point in Switching > DNs > Switches > SIP_Switch > DN
> Routing Point'. Check the Options tab. The Orchestration.application value must be set to
script:<gms-inbound-sample-script> where gms-inbound-sample-script is the name of the
inbound script that you have just created. In our example,
Orchestration.application=script:GMSInboundUISample.

Setting up Acceptance of a Classic Inbound Call

What are the differences between an Inbound Call and a Classic Inbound Call?

In a typical Callback scenario, a service is created first and then, the call arrives/initiates. In a Classic
call scenario, the arrival of the call results in the creation of a Callback service.

The Classic inbound service does the following:

1. Creates a Callback (user originated) service.

2. Transfers the call to the Callback service created in the previous step.

To create and accept an inbound call, you must set up a routing point to load the Classic Inbound
workflow.

The IPD ClassicCallInbound Entry.scxml file can be downloaded from the Classic
Callback Sample page.
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Before configuring your script, you must first setup the classic callback sample: See: Running the
Sample.

Setting up your Classic Inbound script

Configuration ~ Routing Parameters eports

Home = Scripts = Scripts = Callback > GMSClassicinbound Properties

i Delete I Move To

General .
Options Q, Quick Filter Add  £X More

Options
Key 2 Value 2
Permissions
¥ Application
Dependencies

url {b http://135.39.45.125:8080/ClassicCallbackSample/...
¥ ApplicationParms
app_find_agent_timeout 120

app_gms_offer_callback

Create an Enhanced Routing object. Navigate to the Environment > Scripts section of Genesys
Administrator Extension and click New to create the script resource.

1. Enter a name, for instance GMSClassicInbound, select the SCXML type, and click Save.

2. In the Options section, enter the URI of your SCXML file in the Application.url option:
http://<gmshost>:<gmsport>/ClassicCallbackSamplel/src-gen/
IPD ClassicCallInbound Entry.scxml

3 Then, create the following parameters in the ApplicationParms section:

app_find agent timeout = <timeout in seconds when routing to agent if GMS Callback fails>
app_selected agent group = <agent group to route to if GMS Callback fails>

app_gms_offer callback = true

app_gms_service uri = http://<gmshost>:<gmsport>/genesys/1l/service/<callback service name>

4. Save your script object.

The <callback service name> parameter must match the name of the Callback
service that you will add to the Service Admin Ul.
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Create DNs for your Classic Callback Inbound Script Resource

Configuration  Routing Parameters  Reports dministration Centralized Logs eb Engagement

Home = DNs = Switches = SIP_Switch = DN > Routing Point > 8214 Properties Il Move To

General .
Options Q, Quick Filter Add %X More
Default DNs
Key ] Value 2
Options
¥ Orchestration
Permissions

application script:GMSClassicinbound
Dependencies

Browse or create DNs of type Routing Point in Switching > DNs > Switches > SIP_Switch > DN
> Routing Point. Check the Options tab. The Orchestration.application value must be set to
script:<gms-classic-sample-script> where gms-classic-sample-script is the name of the
classic script that you have just created. In our example,
Orchestration.application=script:GMSClassicInbound.
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Enable Outbound Calls

Modified in 8.5.2

This configuration is required for voice scenarios. See the Genesys Voice Platform Deployment Guide
for additional details.

Callback uses Media Server via SIP Server to make outbound calls. SIP Server communicates with
Media Server using MSML and requires the following configuration to enable outbound calls.

Set Valid Digits (Optional)

Configuration ~ Routing Parameters  Reports dministration Centralized Logs eb Er

Home = Switches = Switches = SIP_Switch Properties

General
Options

Access Codes

Key s Value
Default Access Codes
¥ gis
Options
valid-digits +0123456789
Permissions
¥ 0OCServer

Dependencies
channel_num

Valid customer numbers should include a + sign if needed. If true, edit the valid-digits option in
the gts section of your SIP Switch object:

[gts] valid-digits = +0123456789

Refer to ORS documentation for further details.
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Set the Prefix Dial Out Option

To make sure that the system will be able to call, configure the prefix_dial_out option in your
callback service with the Service Management Ul.

Set the Default Country Option

By default starting in 8.5.108, callbacks for unreachable phone numbers and premium numbers are
disabled (see _disallow_impossible_phone_numbers and _disallow_premium_phone_numbers options).
Therefore, you must configure the default_country option in your Callback service.

* Phone numbers are tested against Google's library for parsing, formatting, and validating international
phone numbers.
¢ GMS 8.5.108.02 integrates version 7.2.8 and uses the Apache License Version 2.0.

e The list of premium numbers is available in Wikipedia.
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How to Configure the MSML Service

Home = DNs = Switches = SIP_Switch = DN = VOIP Services = MSML_Service Properties 18 clone T Delete I Move To

General
Options Q, Quick Filter Add 1XM
Options
Key . Value
Permissions
¥ TServer
Dependencies
contact sip:demosrv:5070
contact.mcp sip:demosrv:5090
contact.rm sip:demosrv:5070
make-call-ric3725-flow 1
prefix msmi=
refer-enabled false
ring-tene-on-make-call false

service-type msml
sip-filter-media video
subscription-id Environment

userdata-map-filter

Open Genesys Administrator:

* Navigate to Switching > Switches > SIP_Switch > DN > VOIP Service and edit the MSML_Service
object.

* Make sure that the following options are configured for MSML_Service to enable outbound:

make-call-rfc3725-flow=1
refer-enabled=false
ring-tone-on-make-call=false
userdata-map-filter=*
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Create a Routing Point DN Dedicated to Outbound Calls

Configuration

Home = DMs = Switches = SIP_Switch = DN = Routing Point = New Properties
General
Number * Type#
Options 8999 Routing Point v
Switch *
SIP_Switch
Association Register*
True N
Alias Route Type*
8999_SIP_SwitcH Default v
DN Group
|
Override
v Use Override
Login ID Switch-specific Type
1
Number Of Trunks
0
Cost Contract Site %
] |
Tenant
. | State Enabled
Environment

Navigate to Switching > Switches > SIP_Switch > DN > Routing Point and create a Routing
Point object with, for instance, name set to 8999 and alias set to 8999 SIP Switch.

Then, use this DN to set the option _route_point in your Callback service. For example, route point
= 8999 SIP Switch.
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This routing point is dedicated to callback outbound calls and you must not configure
any other strategies in its Annex tab.

How to Configure Calls Placed from Agent DNs

Added in 8.5.108.02

Outbound calls will be placed from agent DNs if you configure the following options in your callback
service:

_userterminated first connect party=AGENT
_agent preview via rp=false
_agent first via rp=false

Additionally, for agents involved in this callback scenario, set the following configuration in each
agent DN Annex:

section TServer
refer-enabled=false
make-call-rfc3725-flow=1

Advanced Settings for Agents on External Switch

For a user-terminated callback with option userterminated first connect party set to CUSTOMER,
the outbound call will be placed from the route point specified by option route point. This route
point must be on a SIP Server type switch.

If the agents are on a different switch, you must set the callback service option

_ixn _redirect confirmto false. This is due to a limitation in how the routing to agent operates. In
this scenario, a new call is created, the callback SCXML will not receive the events for this call and
will not be able to confirm that the agent answered.

To handle the case where the agent does not answer, you can set the option ixn redirect hints
option to enable particular handling by the other switch. For example, you can set the following value
for a Cisco switch.

_ixn redirect hints = {"extensions" : {"NO ANSWER TIMEOUT" : "5","NO ANSWER ACTION" :
"notready","NO ANSWER OVERFLOW" : "some DN"}}

This configuration enables a no answer timeout of 5 seconds, sets the agent to Not Ready Upon No
Answer, and, upon no answer, routes the call to the DN specified.
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Outbound Call Ringing Period Timeout (No Answer)

You can modify the ringing period timeout for the outbound call by changing the value of the
_ixn_createcall_timeout option (in Advanced Parameters). If the call is not answered within this
period, the outbound call attempt will end in error and will be retried later, according to the values
set for _max_dial_attempts and _dial retry timeout. The default and maximum value of

_ixn createcall timeout is 32 seconds.

The call_timeguard_timeout option sets the timeout (msec) for the Call Progress Detection (CPD)
result to be determined after the call is answered. If this timeout occurs, the result will be set to
human answer. The recommended value for callback CPD is 5000 or greater.

The Orchestration application option cti-transaction-timeout sets the maximum time for the
outbound call request to completed. Set this to a value greater than ixn createcall timeout.

Increasing the Ringing Period Timeout

For some environments, a ringing period timeout of 32 seconds is not long enough for the call to
reach voice mail. This is particularly true when calling a mobile phone, for example. A ringing period
timeout greater than 32 seconds can be achieved by the following configuration.

e Set ixn_createcall_timeout to the desired value (and the Orchestration application option cti-
transaction-timeout accordingly, see above).

* For the following refer to "Increasing Ringing Period for Predictive Calls" in the SIP Server Deployment
Guide.

Configure Voice over IP Service DN

e This is the DN used to issue the outbound call request to to Resource Manager / Media Server.

¢ In the Annex T-Server section, configure predictive-timerb-enabled=false.

Configure MCP Application

» Configure the sip.timer si option to a value greater than the _ixn_createcall_timeout value.

e Configure the sessmgr.acceptcalltimeout option to a value greater than the sip.timer_ si value.
This prevents the MCP application from interfering with the SIP level timers.
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Call Progress Detection (CPD)

You must enable the answering machine connection for user-terminated scenarios with Call Progress
Detection (CPD) capability. This feature is tied to SIP Server and MSML Service.

Enable CPD in your SIP Server

Home = Applications = Applications = SIP_Server Properties & clone T Delete Il Move To

General

Application Options Q am x Add XX More
Connections
Key E Value 2
Ports
F
¥ TServer
Switches
am-detected connect
Tenants
clamp-dtmf-allowed false
Options
clid-withheld-name PRIVATE
Permissions
emergency-recording-filename SCONNIDS

Dependencies

ims-sip-params
Application Options
recording-filename SUUIDS_SANIS_SDNISS_SDATES_STIMES_

sip-pass-from-parameters

Cancel

1. Edit your SIP Server Application, and set TServer/am-detected = connect.

2. Enable MSML, which is required so SIP Server can communicate with GVP as a Media Server to delegate
outbound calls, play treatments, and CPD.

e TServer/msml-support=true

e TServer/refer-enable=true
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Enable Callback Ul for Administrators

The Callback Ul enables you to create services based on the provided Scenarios and is embedded in
the Service Management Ul of Genesys Mobile Environment. To access the Callback Ul, make sure
that GMS is started and that your user owns Supervisor or Administrator permissions.

Setting permissions to Callback Administrators

Configuration Manager

Access Groups
Home > Persons > Persons
Agent Groups
Capacity Rules [] select © New i More @, Show Quick Filter Direct... Persons (Person Folder)
Persons
Roles Username B First Name N Last Name = Agent
Skills
z admin admin
L archiveUser_tenant1
$ Lecadmin becadmin becadmin
E bobdem% Bob Demo 4
cim
cloudadmin
Cloudsupervis... v
A cobrowse cobrowse
Carole

Open GAX and select the Configuration Manager section. In the Accounts menu, select Persons
to get the list of configured users.

Edit the person who will be logging into the Service Management Ul. You are going to give this user
the permissions to read/write data into Callback related configuration objects (for example, GMS
Application, Business Attributes, Transaction Lists for Resources/Patterns, and so on).
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Home > Persons > Persons > bobdemo Properties |E Clone T Delete m Move To

General
( DBID: 8984) Options Q. QuickFilter
Member Of Key 4 Value
Ranks No items
Skills
Agent Logins
Options @ New x
Permissions

Section *
Dependencies gms

4

Accessible Objects Key*

roles

Cancel Value
/—\, lAdministratod
®El

In the Options tab, click Add to set the gms/roles option:

e Enter gms for Section,
e Enter roles for Key,
¢ Enter one of the following values:
e Supervisor: Role used to monitor and configure Callbacks only.

e Administrator: Role used to administer the creation of Callback Services. This role provides access
to all panels and includes the Supervisor role.

e CallbackReadOnly: Role used to provide read-only access. The user can see the Callback panel
without Create, Update, or Delete capabilities. This role was introduced in 8.5.226.03.
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Set up Historical Reporting

Starting in 8.5.105.12, Genesys Callback reports callback metrics through
UserEvents. You can enable this feature in your callback service. When enabled, GMS
sends the UserEvents to the configured DN. You can then configure your reporting
tools to listen to the User Events for this DN and report on callback details.

Prerequisites

Mandatory Genesys Components

Component Minimum Version
Orchestration Server 8.1.400.24
Universal Routing Server 8.1.400.22
Interaction Concentrator 8.1.506.07
Genesys Info Mart 8.5.005 (GA)
Reporting and Analytics Aggregates (RAA) 8.5.000.02
Genesys CX Insights (GCXI) 9.0.007.03

Historical Reporting Architecture

Reporting on Genesys Callback relies on the user-event mechanism to provide Callback-related
metrics and requires Interaction Concentrator, Genesys Info Mart, and Reporting and Analytics
Aggregates (RAA) to collect and organize data to produce a database from which Genesys CX Insights
(GCXI) can rapidly extract the needed data.
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Mobile App

ORS Node
N
P Session API
T-Server
Web App GMs
User Events
wWWW ’ SCXMNIL Session » Reporting DN
=
4
ICON Voi
Genesys Read olee
RAA Info Mart
GCXI Server
| [ —
L—-—"‘d
regate
Aggres Transform Interaction
i Create Database
Info Mart G_CUSTOM_
Reports Database DATA_S table

1. Genesys Callback reports callback metrics through UserEvents to the configured DN. SCXML strategies
that you load through the templates in the Service Management Ul collect metrics and then pass the
metrics as user data (KVPs) with two UserEvent events, one sent at the start of the session and
another, at the end of the session. Genesys Info Mart has certain minimum requirements for the KVPs
that must be sent. The out-of-box templates include these KVPs, as well as other KVPs that Genesys
Info Mart requires for meaningful reporting. See Genesys Info Mart KVP Requirements for details.

2. Interaction Concentrator (ICON) stores the user data (KVPs) attached to these events into the
G_CUSTOM DATA S table of the Interaction Database (IDB).

3. Genesys Info Mart transforms the data into the CALLBACK FACT table of the Info Mart database; this
format can be more quickly loaded into reports.

4. Reporting and Analytics Aggregates (RAA) aggregates the data; in other words, RAA summarizes and
organizes the data from Genesys Info Mart in such a way that Genesys CX Insights (GCXI) can extract
meaning.

5. Genesys CX Insights (GCXI) then presents two out-of-box callback reports: Callback Summary Report
and Callback Details Report.
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Callback Summary Report
Report Date(s): UN2014 to 123172014
Queve: ALL
Callback Type: ALL
Channel: ALL
Tenant: ALL
I verormere
P cansack_va
Declined Customer Connected Succe
Caliback Type Channel Day Offered Accopted Attempled % Cancelled 5 Abandoned
Count % Count L Count
IMMEDIATE VR 20140818 1 1 [] 0.00% 1 1 100.00% 0.00% 100.00% o
SUB TOTAL: 1 1 0 0.00% 1 1 100.00% 0.00% 100.00% o
P pertormance_ves_va
Declined Customer Connected Suey
Caliback Type Channel Day Offered Accopted Attempled % Cancelled s Abandoned
Count L Count L Count
IMMEDIATE R 2014-09-19 E 364 n B51% 364 364 100.00% 0.00% 0.2T% 363

For example, for reporting purposes, the following are some of the keys that GMS sends in
UserEvents related to Outbound calls:

+ CB_T_SERVICE_START

+ CB_SERVICE_ID

« CB_D _CALLBACK OFFER

e CB_N_CALLBACK OFFERED
_CB_T_CALLBACK_OFFERED
_CB_T_CALLBACK_ACCEPTED
_CB_T_CUSTOMER_CONNECTED
_CB_N_IS_ SNOOZED
_CB_T_NEXT _REDIAL_ATTEMPT
+ CB_N_CALLBACK_MEDIA ATTEMPTS
« CB_T_LAST DIAL_ATTEMPT
_CB_N_AGENT_ADDED _TO_IXN

The keys that GMS sends depend on the scenario. To get a complete list of the keys that might be
sent, refer to the Callback KVPs reference on this page.

Important

Ifthe CB T CALLBACK OFFERED and CB T CALLBACK ACCEPTED KVPs must be added
to the original session that initiated the callback request, the callback request must
include the _originating_interaction_id option. In this scenario, in the callback request,
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set the originating_interaction_id value to the interaction ID of the inbound call that
is managed by the ORS session.

Genesys Info Mart KVP Requirements

The following KVPs are mandatory. Genesys Info Mart will not create a record for the callback event if
the KVP is missing from the UserEvent.
« CB_SERVICE_ID
+ CB_T_SERVICE_START
« CB_D _CALLBACK OFFER
_CB_N_CALLBACK_OFFERED
_CB_T_CALLBACK_OFFERED

Ifthe CB T CALLBACK OFFERED and CB T CALLBACK ACCEPTED KVPs must be added
to the original session that initiated the callback request, the callback request must
include the _originating_interaction_id option. In this scenario, in the callback request,
set the _originating_interaction_id value to the interaction ID of the inbound call that
is managed by the ORS session.

The following four KVPs need to be sent in both UserEvents and as call-based attached data in
TEvents.The duplicated KVPs enable Genesys Info Mart to associate the callback event with
interaction data.

e (B T CALLBACK ACCEPTED

» (B T SERVICE START
_CB SERVICE ID
~CB T CUSTOMER CONNECTED

For meaningful reporting, Genesys Info Mart requires several other KVPs, depending on the callback
scenario. See the Callback KVPs reference, below, for the complete list.
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e The CB SERVICE ID is returned by the GMS API in response to the callback request.
For Inbound Calls, where the in-queue callback offer was presented and accepted,
_CB_T _CALLBACK ACCEPTED, CB T SERVICE_START, and CB_SERVICE_ID must be
attached at the time at which the callback was accepted.

e For Virtual and Outbound Calls, CB_T _CUSTOMER CONNECTED must be attached at the
time at which the customer was connected.

Virtual Queues

As a best practice, Genesys recommends creating virtual queues associated with the following
interaction types:

e Virtual Queue for Inbound calls—This queue is where the regular inbound calls are going to be reported.
Those calls are callbacks that were not offered or, offered and rejected.

¢ Virtual Queue for Virtual callbacks—This queue is where the virtual callbacks are going to be waiting for
an agent.

e Virtual Queue for Outbound calls—This is where the callback application will place the real outbound call
when it gets confirmation that the right person is connected. The call is removed from this queue after
it is successfully delivered to an agent or is abandoned by the customer.

Virtual queues (VQ) that are used for reporting will make metrics effective, but they
are not used for routing in this context.

Related Resources for Historical Reporting

You may also be interested in reading:

¢ The Genesys Info Mart Physical Data Model documentation for your RDBMS.
¢ The Reporting and Analytics Aggregates Physical Data Model documentation for your RDBMS.

Configure Historical Reporting

Genesys Info Mart and Genesys CX Insights (GCXI) support for callback offered
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through GMS is provided out-of-box, with no additional configuration required. To see
callback data in GCXI reports, however, you need to modify the configuration for other
products as explained in this section.

Configure a Reporting DN
Open Genesys Administrator or Configuration Manager and create a new DN of type Trunk Group

DN. The name of the DN is used inside SCXML scripts, so it should be meaningful and recognizable.
For example: Sip Switch > DN > REPORTING

Configure your Callback Service

Callback Delayed
Q- Reporting v + Add New Advanced Parameters ¥ Refresh

Name s Value E Description 3

& _customer_number Request Parameter - Customer's phone number. Can be used to match the call
with service data when call direction is set to USERORIGINATED. Also used
when call direction is USERTERMINATED to establish connection with the
customer

& _service & callback

_type ors

v Reporting (5) \

_rep_userevent_dn REPORTING DM to which the reporting user event is sent. If _rep_userevent_enable is set to
true, a value for this parameter is required.

& _rep_userevent_enable true If set to true, callback data is reported via user events to the switch and dn
specified (_rep_userevent_switch and _rep_userevent_dn).

_rep_userevent_switch Sip_Switch Switch to which the dn (_rep_userevent_dn) belongs. If _rep_userevent_enable is
set to true, a value for this parameter is required.

_reporting_aggregator_url URL to which the reporting events will be sent when Reporting Aggregator us
enabled.

_use_reporting_aggregator If enabled, reporting events will be sent to the configured Reporting Aggrega
URL.
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Edit your callback service in Callback and Mobile Engagement > Configured Services,
expand the Reporting section:
* Setthe rep userevent enable option to true to enable reporting.

* Setthe rep userevent dn option to the Trunk Group DN that you created previously, used as
destination DN of the reporting events.

* Setthe rep userevent switch option to the Switch name where you created this DN. This is
Switch used to report the events.

Configure Orchestration Server

In the connections of your Orchestration Server application, add the T-Server used to define the
reporting Switch and DN in the GMS service configuration. For example, Sip Switch.

Configure Interaction Concentrator

To make Callback reporting work, you need to configure Interaction Concentrator (ICON) for Voice.
See here for details.

Set the KVP list

¢ Configure ICON to store the KVP data provided in the UserData section of EventUserEvents. ICON will
store this data in the G_CUSTOM DATA S table of the Interaction Database (IDB):
ICON > Options > custom-states/store-event-data=all

By default, store-event-data is set to none.

e Configure ICON to store required duplicate KVP data provided in the UserData attribute of TEvents.
ICON will store this data in the G_USERDATA HISTORY table. To enable this storage, modify your
ccon_adata spec.xml file to capture the four TEvents KVPs described in the Callback KVPs reference
below:

« CB_T CALLBACK ACCEPTED
« (B T _CUSTOMER CONNECTED
« CB_T SERVICE START

« (B SERVICE ID

Tip
See the ccon_adata spec GIM example.xml file in the Genesys Info Mart installation
package for an example of the required modification.
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Check Interaction Concentrator Connections

Make sure that Interaction Concentrator is connected to the T-Server that is servicing the switch
specified in the Callback Service.
For example: Sip Switch.

Start Interaction Concentrator and use logs to verify that it registered on the REPORTING DN.

Interaction Concentrator does not produce historical records for virtual interactions.

Configure Reporting and Analytics Aggregates

Edit the Genesys Info Mart application to enable the agg-feature\enable-callback option:
agg-feature\enable-callback=yes

Tip

See here for details about the configuration of your RAA application.

Configure Workspace

Important: In a Callback use case with preview, reporting user data is attached to the call that
appears on Agent Desktop (WDE). Once the callback is finished, from a GMS Callback point of view,
the agent is managing wrap-up operations for the call and sends a user request to the reporting
server using the callback user data. The reporting server sees this data as an additional reporting
operation.

To avoid sending this additional reporting data, the agent desktop application can configure the
following option in the interaction-workspace section:

interaction.disposition.use-attached-data=false

Verify Reporting Data

1. Run your scenario by triggering Genesys Mobile Services and Orchestration Server (ORS) APIs directly.

2. Make sure user events are being delivered to Interaction Concentrator applications by checking T-Server
logs. You should see something like this:
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00:34:20.757 Int 04543 Interaction message "RequestDistributeUserEvent" received from
516 ("OrchestrationServer")

-- Absent ThisDN, REPORTING was used

@00:34:20.7570 [0] 8.1.000.62 send to client: message EventACK

AttributeEventSequenceNumber 0000000000000ef8
AttributeCustomerID "Environment'
AttributeTimeinuSecs 757000
AttributeTimeinSecs 1348817660 (00:34:20)
AttributeReferencelD 431

AttributeThisDN '"REPORTING'
AttributeUserEvent RequestDistributeUserEvent

00:34:20.757 Trc 04542 EventACK sent to [516] (00000003 OrchestrationServer 192.168.27.50:40727)

@00:34:20.7570 [0] 8.1.000.62 distribute user event: message EventUserEvent

AttributeEventSequenceNumber 0000000000000ef9
AttributeCustomerID "Environment'’
AttributeTimeinuSecs 757000
AttributeTimeinSecs 1348817660 (00:34:20)
AttributeUserEvent EventUserEvent
AttributeUserData [347] 00 Oc 00 00..
'gms_AgentAvailable' '1348817660755"

‘gms_AgentConnected' t
'gms_IxnCompleted' v
‘gms_ServiceName' "inbound-delay
‘gms_ServiceStartAt' '1348817660553"
‘gms_ServiceStoppedAt' v
‘gms_SessionEventSeq' 3
'gms_SessionId' '65UA6ISSIH76R340BNDQ2DGODGOO0OO36"
‘gms_UserConnected' t
‘gms_UserId' t
‘gms_WaitingForAgent' '1348817660744'
'gms_externalld' t

AttributeANI '777"

AttributeDNIS ‘333"

AttributeReferenceID 431

AttributeThisDN '"REPORTING'

00:34:20.758 Trc 04542 EventUserEvent sent to [508] (0000000c Icon Voice 192.168.27.50:42678)
00:34:20.758 Trc 04542 EventUserEvent sent to [588] (00000004 Stat Server 192.168.27.50:40728)

00:34:20.758 Trc 04542 EventUserEvent sent to [592] (00000005 Universal Routing Server
192.168.27.50:40744)

Callback User's Guide

56



Configure Callback Set up Historical Reporting

3. Check your Interaction Concentrator logs and the G CUSTOM DATA S table in Interaction Database
and make sure that data is recorded properly.

For example, you should see in Interaction Concentrator logs:
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00:39:19.
00:39:19.
00:39:19.
00:39:19.

into the

00:39:19.
00:39:20.

569 Int
751 Int
766 Int
987 Trc
queue

987 Trc
001 Trc

04543
04543
04543
25016

25003
25004

Interaction message "EventUserEvent" received from 65200 ("SIP Server@REPORTING")
Interaction message "EventUserEvent" received from 65200 ("SIP Server@REPORTING")
Interaction message "EventUserEvent" received from 65200 ("SIP Server@REPORTING")
Persistent Queue GUD: transaction 10929 is committed. 5 records written

Database queue [GUD]: persistent queue transaction 10929 is being processed.
Database queue [GUD]: persistent queue transaction 10929 is processed, committed

and removed. 5 records are written.
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4. Optionally, you can also check the content of the CALLBACK FACT table in the Info Mart database to
make sure that the transformation process is correctly executed as well. For example, you can try the
following query:

SELECT * FROM dbo. CALLBACK FACT

ADDED_TS I DS_AUDIT_KEY I EVENT_SEQUENCE I CREATE_AUDIT_KEY I TENANT_KEY I SERVICE_ID FINAL_RECORD | EWT_READY_TO_START_IXN I EwT_WHEN_OFFERED I POS_READY_TO_START_IXN I POS_WHEN_OFFERED I CALLBACK |
1| 1485324803 | S2e4 3174 10002 1 44517282647 fcd-438a-adda-cHRESZ 261 ) ) 0 a a 0
2_‘ 14E6324821 | 9864 3232 10002 1 44517282647 fcd-438a-adda-cHRESZ 261 1 ) 0 a a 0
3| 1485327830 9864 3952 10008 1 4455930861 6f94-40fc-a3a3-Blcadddcdec2 0 0 0 a a 0
4 | 1485327908 964 40m 10008 1 4455930861 -6/94-48fc-a3a3-B1cadddcBoc 1 0 0 a a 0
8 | 1485331525 9864 484z 10008 1 445-1623902ff-4447-403-9bBc-4125c7 22489 0 0 0 a a 0
B | 1485331543 Sae4 4501 10008 1 445-1B5502ff-4447-40f3-3bBc- 412607 2248890 1 ) 0 a a 0
7| 1485336725 9353 3168 10018 1 445-558096he-cAE6-4206-h045-a1 7hEIc04641 - O 0 0 a a 0
8| 1485335743 9953 3228 10018 1 445-558096he-cA56-42b6-b045-a1 ThE 304641 1 0 0 a a 0
9 | 1485336434 9953 3465 10018 1 445136 TEff-20fc-4cbT-8202-7 a3 59646CE 0 0 0 a a 0
10| 1485336452 9953 3524 10018 1 445136 TEff-20fc-4cbT-8202-7 a3 59646CE 1 0 0 a a 0
11| 1465338916 9953 4122 10020 1 44513348edf-1f0d-467d-a625- e Fraf203%e9 ) ) 0 a a 0
12 | 1465338034 9953 4180 10020 1 44513348edh-1f0d-467d-a525- de Pat 2e 399 1 0 0 a a 0
13 | 145400440 9953 4583 10020 1 445-ab1 21229 hh(la-4170-bfdd- 168029581 0 0 0 a a 0
14 | 1485400456 9953 4641 10020 1 445-3b1 a223-bb0a-4f70-bf4d-1 680629581 1 0 0 a a 0
15 | 1485408362 3353 B4E5 10021 1 M5 7hoE0chE-abBe-de7e-Baa?-2eflcaddabl O o 0 a a 0
1B | 145408880 9353 B523 10021 1 M5 7boE0ch6-abBe-de7e-Baa? (2e62ca44abf 1 ) 0 a a 0
17 | 1485411643 9978 3209 10021 1 445-didadB36-d70d-4032- 0350 a7edPhel 3287 O 0 0 a a 0
18 | 1465411665 3978 3268 10021 1 445-0i4adB96-d700-4092-b95¢-aTedPEe1 3287 1 0 0 ] ] 0
19| 1485411915 10023 3418 10095 1 445-21345be-31d0-43eb-0b0e-beeB31237109 - 0 0 0 a a 0
20 | 145417833 10023 3475 10086 1 445-£1345hef-81d0-43eb-Bb0e-beeB31 237109 1 ) 0 a a 0
21 | 14e5481078 50016 17603 50088 1 M5 E53ab04d-97eh-41be-Bo74-6o1 244506206 O ) 0 a a 0
22 | 14E5481006 50016 17668 50165 1 445-659ab04d 9754 1be-Be74-5e1 244206205 1 0 0 a a 0

How to Pass Reporting KVPs of the Inbound Call in the Callback
Request

Some historical reporting KVP values are known only by the IVR or application that requests the
callback service. Including these KVPs in the historical reporting is optional. If you want to include
them, the values can be passed in the HTTP request that starts the Callback service. The following is
the list of the KVP parameters that can be passed in the HTTP request. Each maps to the
corresponding CB X KVP.

e cb t callback offered

e cb d callback offer

e cb ewt when callback was offered

e cb _pos when callback was offered

e cb t callback accepted

e cb dim channel

e cb dim callback offer type

e cb dim offer timing
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e cb n callback offers per session

e cb d last callback offer

If the agent submits the completed reason in the disposition result, the system will set
the reporting key CB DISPOSITION to the provided COMPLETED reason.

Ifthe cb t callback offeredand cb t callback accepted KVPs must be added
to the original session that initiated the callback request, the callback request must
include the _originating_interaction_id option. In this scenario, in the callback request,
set the originating_interaction_id value to the interaction ID of the inbound call that
is managed by the ORS session.

Reference: Callback KVPs

The following table describes the KVPs that, if sent by GMS in UserEvents, Genesys Info Mart uses to
enable Callback reporting.

The following four KVPs must also be sent as call-based attached data.

« CB_SERVICE_ID
« _CB_T_SERVICE_START

« CB_T_CALLBACK_ACCEPTED

« CB_T_CUSTOMER_CONNECTED

The sample attached-data specification file in the Genesys Info Mart IP includes these
four KVPs by default.
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KVP

_CB_TENANT DBID

_CB_DISPOSITION

_CB_SERVICE_ID*

_CB_ORIGINATION_IXN_ID

Introduced: GMS 8.5.200.07

_CB_FIRST OUT IXN_ID

Introduced: GMS 8.5.200.07

_CB_LAST OUT _IXN_ID

Introduced: GMS 8.5.200.07

Description
The Tenant DBID.

Callback state using the format <state>.<sub
state> where:

¢ <state> can be set to: SCHEDULED, QUEUED,
ROUTING, PROCESSING, COMPLETED.

e <sub state> can be set:
REDIAL LIMIT REACHED, CANCELLED, AGENT,
ABANDONED IN QUEUE, REJECTED,

PUSH SEND, PUSH DELIVERY_ CONFIRMED,
PUSH SEND ERROR, FAILED, CONNECTED,
TRANSFERRED TO RP.

The ID of the callback service request. Depending
on the scenario, the value equals the ID of the
GMS service instance or ID of the ORS session.

The ID of the inbound call where the callback was
originally offered and accepted. You must pass the
_cb origination ixn_id parameter in your Start
Callback query when creating a callback request.
If you do not pass the cb origination ixn id
parameter, the value of CB_ORIGINATION IXN ID
will be undefined. For chat scenarios, this ID
should be the chat interaction ID.

The call ID of the first outbound call that the
callback service created.

The call ID of the last outbound call that the
callback service created.

Info Mart Database Target

CALLBACK_FACT.TENANT_KEY

CALLBACK_DIM_3.DISPOSITION (referenced
through CALLBACK_FACT.CALLBACK_DIM_3_KEY)

CALLBACK_FACT.SERVICE_ID

CALLBACK_FACT.ORIGINATION_IXN_ID

CALLBACK_FACT.FIRST_OUT_IXN_ID

CALLBACK_FACT.LAST_OUT_IXN_ID
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KVP

_CB_DIAL 1 _RESULT

Introduced: GMS 8.5.200.07

_CB_DIAL 2 RESULT

Introduced: GMS 8.5.200.07

_CB_DIAL 3 RESULT

Description Info Mart Database Target

The result of the first callback dialing attempt.
One of the following values:

CREATE_CALL_ERROR
BUSY

NO_ANSWER
ANSWERING_MACHINE
ERROR_TONE

FAX

PERSON CALLBACK_DIAL RESULTS.DIAL_1_RESULT

CONNECTED (referenced through
CALLBACK FACT.CALLBACK DIAL RESULTS _KEY)
FAILED TO_ESTABLISH_CUSTOMER_ORIGINATED_MEDIA

PUSH_DELIVERY_CONFIRMED
PUSH_SEND_ERROR
PUSH_DELIVERY_NOT_CONFIRMED
USERORIGINATED_CONNECTED

Notes:
FAILED_TO_ESTABLISH_CUSTOMER_ORIGINATED_MEDIA is a
result that must be reported by the user application;
otherwise, there is no CTI data that will enable Genesys
Callback to identify this result.

The result of the second callback dialing attempt.
See CB_DIAL_1 RESULT for possible values.

CALLBACK DIAL RESULTS.DIAL 2 RESULT
(referenced through
CALLBACK FACT.CALLBACK DIAL _RESULTS_KEY)

The result of the third callback dialing attempt. CALLBACK DIAL RESULTS.DIAL 3 RESULT
See CB_DIAL_1 RESULT for possible values. (referenced through
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Introduced: GMS 8.5.200.07

_CB_DIAL_4_RESULT

Introduced: GMS 8.5.200.07

_CB_DIAL_5_RESULT

Introduced: GMS 8.5.200.07

_CB_T DIAL 1

Introduced: GMS 8.5.200.07

_CB_T DIAL 2

Introduced: GMS 8.5.200.07

_CB_T DIAL 3

Introduced: GMS 8.5.200.07

_CB_T DIAL 4

Introduced: GMS 8.5.200.07

_CB_T DIAL 5

Introduced: GMS 8.5.200.07

_CB_IXN_START_IGNORING_AVAILABILITY

Description

The result of the fourth callback dialing attempt.
See CB_DIAL 1 RESULT for possible values.

The result of the fifth callback dialing attempt.
See CB DIAL_1 RESULT for possible values.

UTC Timestamp of the first dialing attempt.

UTC Timestamp of the second dialing attempt.

UTC Timestamp of the third dialing attempt.

UTC Timestamp of the fourth dialing attempt.

UTC Timestamp of the fifth dialing attempt.

For premise callback,
~CB_IXN START IGNORING AVAILABILITY will

Info Mart Database Target

CALLBACK_FACT.CALLBACK_DIAL_RESULTS_KEY)

CALLBACK DIAL_RESULTS.DIAL 4 RESULT
(referenced through
CALLBACK FACT.CALLBACK DIAL RESULTS KEY)

CALLBACK_DIAL_RESULTS.DIAL_5_RESULT

(referenced through

CALLBACK _FACT.CALLBACK_DIAL_RESULTS_KEY)

CALLBACK_FACT.DIAL_1_TS

CALLBACK_FACT.DIAL_2_TS

CALLBACK_FACT.DIAL_3_TS

CALLBACK_FACT.DIAL_4 TS

CALLBACK_FACT.DIAL_5 TS

CALLBACK _DIM_4.DIAL_IGNORING_AVAILABILITY
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Introduced: GMS 8.5.200.07

_CB_FINAL_RECORD

_CB_EWT WHEN_READY TO_START MEDIA_IXN

_CB_EWT WHEN_CALLBACK_WAS_OFFERED

_CB_POS_WHEN_READY_TO_START_MEDIA_IXN

_CB_POS_WHEN_CALLBACK_WAS_OFFERED

_CB_D_CALLBACK_OFFER

_CB_OFFER_EWT _INBOUND_VQ

Introduced: GMS 8.5.111.04

_CB_N_ABANDONED_DURING_CALLBACK_OFFER

Introduced: GMS 8.5.111.04

_CB_CUSTOMER_ANI

Description
always be 0.

Indicates whether this is a final record about this
callback service: 0 = No, 1 = Yes.

The value of Expected Wait Time (EWT), in
seconds, for the service request when the contact
center was ready to start the first callback
interaction, such as an outbound dialing attempt.

The value of EWT, in seconds, at the time the
callback was offered.

The customer position in the queue when the
contact center was ready to start the first callback
interaction, such as an outbound dialing attempt.

The customer position in the queue when callback
was offered.

The duration of the callback offer, in seconds.

Estimated Wait Time for the queue where rejected
calls and not offered callbacks are being placed.
This value is identical to
_CB_EWT_WHEN_CALLBACK_WAS OFFERED if the
same Virtual Queue is used to place accepted
callbacks.

Indicates whether the caller dropped the call
without explicitly accepting or rejecting the
callback offer: 0 = No, 1 = Yes.

ANI of the customer for in-queue scenarios. This
value can match
_CB_CUSTOMER_PHONE_NUMBER if the same

Info Mart Database Target

CALLBACK_FACT.FINAL_RECORD

CALLBACK_FACT.EWT_READY_TO_START_IXN

CALLBACK_FACT.EWT_WHEN_OFFERED

CALLBACK_FACT.POS_READY_TO_START IXN

CALLBACK_FACT.POS_WHEN_OFFERED

CALLBACK_FACT.CALLBACK_OFFER_TIME

CALLBACK_FACT.EWT_WHEN_REJECTED

CALLBACK_DIM_4.ABANDONED DURING_CB_OFFER
(referenced through
CALLBACK FACT.CALLBACK DIM 4 KEY)

CALLBACK_FACT.CUSTOMER_ANI
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KVP

Introduced: GMS 8.5.111.04

_CB_T_SERVICE_END

Introduced: GMS 8.5.111.04

_CB_D_CUSTOMER_WAITED_BEFORE_OFFER

Introduced: GMS 8.5.106.14

_CB_D_WAITING_FOR_AGENT OFFLINE

_CB_D_ESTABLISH_MEDIA_IXN

_CB_D_CUSTOMER_CONNECTED_WAITING_FOR_AGENT

_CB_T_CALLBACK_ACCEPTED*

_CB_T_CALLBACK_OFFERED

_CB_T_READY_TO_START_MEDIA_IXN

_CB_T_CUSTOMER_CONNECTED*

Description

number is confirmed or entered. Could also be
empty if the ANI is not detected.

UTC timestamp for when service was completed
or terminated.

The amount of time, in seconds, the customer
waited in the queue before a callback was offered.

The amount of time, in seconds, the customer was
waiting offline for an agent to become available.

The amount of time, in seconds, it took to
establish the callback interaction, such as an
outbound call.

The amount of time, in seconds, the customer was
waiting to be connected to the agent after the
callback interaction was established.

The UTC timestamp when the callback offer was
accepted.

The UTC timestamp when the callback was
offered.

The UTC timestamp when the contact center was
ready to start the callback interaction. The value
matches the time of either an outbound dialing
attempt or a push notification prompting the
customer to start a call or chat session.

Note: Set this value only once, before the first dial attempt.

The UTC timestamp when the customer was
reconnected to the contact center and started

Info Mart Database Target

CALLBACK_FACT.SERVICE_END TS

CALLBACK_FACT.WAITED_BEFORE_OFFER_TIME

CALLBACK_FACT.WAIT_AGENT_OFFLINE_TIME

CALLBACK_FACT.ESTABLISH_MEDIA_IXN_TIME

CALLBACK_FACT.CONN_WAITING_AGENT TIME

CALLBACK_FACT.CALLBACK_ACCEPTED_TS

CALLBACK_FACT.CALLBACK_OFFERED_TS

CALLBACK_FACT.READY_START_MEDIA_IXN_TS

CALLBACK_FACT.CUSTOMER_CONNECTED_TS
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KVP Description Info Mart Database Target
waiting for an agent to be connected.

Indicates whether the agent was successfully

~CB_N_AGENT_ADDED_TO_IXN added to the callback interaction: 0 = No, 1 = Yes.

CALLBACK_FACT.AGENT_ADDED_TO_IXN

Number of times the callback interaction failed to

CB_N_TRANSFER_TO_AGENT_FAILED
- - - - - transfer to the agent.

CALLBACK_FACT.XFER_TO_AGENT_FAILED

Indicates whether the customer abandoned the
_CB_N_CUSTOMER_ABANDONED_WHILE_WAITING_FOR_AGENT  callback interaction while waiting to be connected = CALLBACK FACT.ABANDONED_WAITING
to an agent: 0 = No, 1 = Yes.

Indicates whether the customer was disconnected
_CB_N_TIMEOUT_WHILE_WAITING_FOR_AGENT because the timeout for waiting for an agent was CALLBACK_FACT.TIMEOUT_WAITING
reached: 0 = No, 1 = Yes.

Indicates whether the interaction required agent

CB_N_IXN_REQ AGENT :
~CB_N_IXN_REQ_ assistance: 0 = No, 1 = Yes.

CALLBACK_FACT.IXN_REQ_AGENT

Indicates whether callback was offered, at least

CB_N_CALLBACK_OFFERED : .
- - - once, during the session: 0 = No, 1 = Yes.

CALLBACK_FACT.CALLBACK_OFFERED

Indicates whether a callback offer was accepted: 0

CB_N_CALLBACK_ACCEPTED
- - - = No, 1 = Yes.

CALLBACK_FACT.CALLBACK_ACCEPTED

The total number of callback attempts or

CB_N_CALLBACK_MEDIA ATTEMPTS o
- - - - notifications, both successful and unsuccessful.

CALLBACK FACT.CALLBACK _ATTEMPTS
The UTC timestamp when the callback service
started. This value represents either the time of CALLBACK _FACT.SERVICE_START_TS,

the callback request or the time that the callback ~ CALLBACK_FACT.START_DATE_TIME_KEY
offer was played, depending on deployment.

The DBID of the virtual queue used to find the
target agent. Genesys Info Mart uses this value in
combination to identify the RESOURCE_KEY to
use.

_CB_T_SERVICE_START*

_CB_DIM_VQ DBID CALLBACK _FACT.RESOURCE_KEY

The configuration type ID of the virtual queue
VQ CFG_TYPE_ID used to find the target agent. Genesys Info Mart CALLBACK_FACT.RESOURCE_KEY
uses this value in combination to identify the
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KVP

VQ_CFG_TYPE

_CB_DIM_VQ

_CB_DIM_CHANNEL

_CB_DIM_CALLBACK_OFFER_TYPE

_CB_DIM_TYPE

Description
RESOURCE_KEY to use.

The configuration type of the virtual queue used
to find the target agent. Genesys Info Mart uses
this value in combination to identify the
RESOURCE_KEY to use.

The virtual queue used to find the target agent.
Genesys Info Mart uses this value in combination
to identify the RESOURCE_KEY to use.

The interaction channel from which the callback
originated. One of the following values:

* IVR
- WEB
* MOBILE

The type of callback offer that was presented to
the customer. For example, after business hours,
SCHEDULED is the only available option; during
business hours, business rules might allow only
the WAIT_FOR_AGENT option or a combination of
SCHEDULED and WAIT_FOR_AGENT. One of the
following values:

+ SCHEDULED
« WAIT_FOR_AGENT

« COMBINED_SCHEDULED_AND_WAIT_FOR_AGENT

* IMMEDIATE

The type of callback the customer requested. One
of the following values:

Info Mart Database Target

CALLBACK_FACT.RESOURCE_KEY

CALLBACK_FACT.RESOURCE_KEY

CALLBACK DIM_1.CHANNEL (referenced through
CALLBACK_FACT.CALLBACK_DIM_1_KEY)

CALLBACK DIM_1.CALLBACK OFFER _TYPE
(referenced through
CALLBACK FACT.CALLBACK DIM_1 KEY)

CALLBACK_DIM_1.CALLBACK_TYPE (referenced
through CALLBACK_FACT.CALLBACK_DIM_1_KEY)
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KVP Description Info Mart Database Target

¢ IMMEDIATE - The interaction is created right
away while the customer is waiting for the
agent (in an online chat session or waiting for
a voice call).

e WAIT_FOR_AGENT - The interaction is delayed
until the agent is about to become available or
actually becomes available (as in an agent
first scenario).

e SCHEDULED - The time for the callback
interaction is negotiated with the customer.

The order in which the final callback interaction
was connected. One of the following values:

¢ CUSTOMER_FIRST CALLBACK DIM 1.CONNECT ORDER (referenced
_CB_DIM_CONNECT ORDER - =l -
- AGENT FIRST PREVIEW through CALLBACK _FACT.CALLBACK_DIM_1 KEY)

« AGENT FIRST_NO_PREVIEW

The result of the final dialog for the callback. One
of the following values:

e RIGHT_PERSON
e RESCHEDULED

« CANCELLED CALLBACK DIM_2.DIAL_DIALOG_RESULT
_CB_DIM_DIAL DIALOG_RESULT (referenced through
* TRANSFERRED TO RP CALLBACK FACT.CALLBACK DIM_2 KEY)
e PERSON
e CANCEL

e ERROR_TONE
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KVP

_CB_DIM_CALL_DIRECTION

_CB_DIM_FINAL_DIAL_RESULT

Description

Important: If an error occurs during the callback outbound call,
the value of _CB_DIM_FINAL_DIAL_RESULT might overlap with
_CB_DIM_DIAL_DIALOG_RESULT.

The direction of the final callback interaction. One
of the following values:

CUSTOMER_TERMINATED - Outbound Callback
scenarios in which the contact center is dialing
out to the customer's number.

CUSTOMER_ORIGINATED - Inbound Callback
scenarios in which the contact center notifies
the customer-facing application that it is time
for the callback interaction, after which the
application creates the interaction (such as a
call or chat), obtaining the phone number if
necessary. In this scenario, a customer call
comes into the contact center as a regular
inbound call, but it is recognized as the
callback interaction.

The result of the final callback dialing attempt.
One of the following values:

CREATE_CALL_ERROR
BUSY

NO_ANSWER
ANSWERING_MACHINE
ERROR_TONE

FAX

PERSON

Info Mart Database Target

CALLBACK_DIM_2.CALL_DIRECTION (referenced

through CALLBACK_FACT.CALLBACK_DIM_2_KEY)

CALLBACK_DIM_2.FINAL_DIAL_RESULT (referenced

through CALLBACK_FACT.CALLBACK_DIM_2_KEY)
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_CB_DIM_OFFER_TIMING

KVP

Description

CANCEL

CONNECTED

FAILED TO_ESTABLISH_CUSTOMER_ORIGINATED_MEDIA
PUSH_DELIVERY_CONFIRMED
PUSH_SEND_ERROR
PUSH_DELIVERY_NOT_CONFIRMED
USERORIGINATED_CONNECTED
REDIAL_LIMIT_REACHED
ABANDONED _IN_QUEUE

FAIL

UNKNOWN

RESCHEDULED
FAIL_FAX_REACHED

Notes:

1. FAILED_TO_ESTABLISH_CUSTOMER_ORIGINATED_MEDIA is a
result that must be reported by the user application;
otherwise, there is no CTI data that will enable Genesys
Callback to identify this result.

2. CANCEL is set when the on_dial plugin returned
action=CANCEL.

Specifies whether the callback offer was made
during operational (business) or non-operational

hours. One of the following values:

ON-HOURS

Info Mart Database Target

CALLBACK_DIM_2.0OFFER_TIMING (referenced
through CALLBACK_FACT.CALLBACK_DIM_2_KEY)
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KVP

_CB_DIM_FINAL TARGET

_CB_ORS_SESSION_ID

Introduced: GMS 8.5.114.09

_CB_EWT WHEN_READY TO_START LAST MEDIA IXN

Introduced: GMS 8.5.200.07

_CB_POS_WHEN_READY_TO_START LAST MEDIA_IXN

Introduced: GMS 8.5.200.07

_CB_PRIORITY_WHEN_CALLBACK_ACCEPTED

Introduced: GMS 8.5.200.07

_CB_PRIORITY_WHEN_CUSTOMER_CONNECTED

Introduced: GMS 8.5.200.07

_CB_PRIORITY_AT THE_END_OF ONLINE_WAIT

Introduced: GMS 8.5.200.07

Description
e OFF-HOURS

The routing target that was used to find the
agent.

The Orchestration Server (ORS) session ID used to
manage the callback. If multiple sessions were
used (for example, because an ORS session
terminated unexpectedly during the callback), the
last session ID is reported.

Estimated Wait Time in seconds when the last dial
attempt was made or the last push notification
sent.

Position in queue when the last dial attempt was
made or the last push notification sent.

Priority of the interaction (real or virtual) when the
callback offer was accepted.

Priority of the virtual interaction when the
customer was connected.

Priority of the virtual interaction when the
customer was connected to the agent.

If the customer abandoned while waiting in queue, then this
value is the priority of the call when the customer
disconnected.

Info Mart Database Target

CALLBACK_DIM_3.FINAL_TARGET (referenced
through CALLBACK_FACT.CALLBACK_DIM_3_KEY)

CALLBACK_FACT.ORS_SESSION_ID

CALLBACK_FACT.EWT_WHEN_LAST DIAL

CALLBACK_FACT.POS_WHEN_LAST DIAL

CALLBACK_FACT.PRIORITY_WHEN_CB_ACCEPTED

CALLBACK_FACT.PRIORITY_WHEN_C_CONNECTED

CALLBACK_FACT.PRIORITY_WHEN_A_CONNECTED
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KVP

_CB_EWT THRESHOLD WHEN_OFFERED

Introduced: GMS 8.5.200.07

Description
Value of the EWT threshold used to decide

whether the callback offer should be made or not.

Pass this value as an argument of the application
that is responsible for making the callback offer.

Info Mart Database Target

CALLBACK_FACT.EWT_THRESHOLD_WHEN_OFFERED

*This KVP must be sent twice -- as call-based attached data in a TEvent and as UserEvent-based user data.
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Restore Virtual Queue Position Upon
Resubmit

In some scenarios, the Orchestration Server (ORS) fails to handle a callback session that is in the
QUEUED state and GMS will resubmit the callback service request to another ORS.

Starting in 8.5.106.16, GMS can maintain the queue priority and interaction age by passing in
calculated settings. This is possible only if you enable the Restore Virtual Queue Position Upon
Resubmit feature by configuring your GMS application and callback service as detailed in this page.

Enable the Restoring of Virtual Queue Position Upon Resubmit

To enable this feature, set the callback/enable-restore-vqg-position to true in your GMS
application. By default, the option is true and enables the feature. As result, both the virtual call
priority and interaction age will be restored when GMS will resubmit the callback.

How to set your Virtual Queue Priority

The Virtual Queue Priority depends on the following callback service options:

e urs _vq priority—Priority to be set for the virtual interaction when submitting to
_urs_virtual queue. If you leave this option blank, no priority will be set.

e urs_vq_priority increment—The amount by which the priority will be incremented. For example, 10
to increment the priority by 10 each time. If you leave this option blank, the incrementation of the
priority is disabled.

e urs_vq_priority increment interval—Number of seconds between each incrementation of the
priority. For example, 60 to increment the priority every 60 seconds. If you leave this option blank, the
incrementation of the priority is disabled.

You can either set these options in your callback service through the Service Management Ul, or pass
them the HTTP request that starts your callback Service.

These values will be used to calculate an updated urs vq priority value using the following
formula:

_urs_vqg priority + urs vq priority increment * floor( (current time - callback start time) /
urs vq _priority increment interval )
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If one of the urs vq priority, urs vq priority increment, or
_urs_vq _priority increment interval options is not set, GMS does not update the
urs_vq _priority parameter when resubmitting the callback.

Interaction Age

Ifthe urs call interaction age parameter is neither set in the callback service nor passed in the
HTTP request that starts the service, it is set upon resubmit to a value based on the callback start
time. Otherwise, the originally provided value of urs call interaction age is maintained upon
resubmit.
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Configuring Callback in SIP Cluster
Environment

If you are configuring Callback and a SIP Cluster in a multiple URS environment, additional

configuration steps are required to ensure that agent reservation conflicts do not occur when a single

agent becomes available and there are multiple URS instances trying to dial and route a call to the

same agent.

For more information on this scenario, read Deploying SIP Cluster.

Configure Virtual Queues

First, in your virtual queues configured for your SIP cluster, ensure that enough agents will be
available by creating, in the Options tab, the section _ ROUTER _ that contains the
agent reservation option.

For example:

[ ROUTER 1]
agent reservation=8

There are two underscores at the beginning of the section name and two underscores
in the ending of section name, that is, 4 underscores in total.

To determine the correct value for agent reservation, see Agent Availability for Routing in the SIP
Cluster Solution Guide.

Configure SIP Cluster Nodes

For each VQ SIP Server node of your SIP Cluster, create a  ROUTER __ section that includes
agent reservation=false.

[ ROUTER 1
agent reservation=false
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Configure URS

For each URS HA Pair in your environment, follow the below instructions:
e Work on one URS HA pair at a time.

¢ Make changes to the URS instance, which currently operates in a backup mode

1. Add connections to VQ SIP Server nodes in the Connections tab.

2. For each connection, make sure that:
Connection Protocol=addp

Trace Mode=Trace on Both Sides
Remote timeout = 11
Local timeout = 7

Port ID = default

3. In the Options tab, edit the vcb option in the default section:

vcbhb=30:120:60:1:20:0:1:50:1000

4. Apply changes to the URS backup instance.
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Callback and Mobile Engagement Ul

Before you start using this interface, make sure that your GMS application is up and
running, and that you properly configured your user permissions.

Scope of Use

o
S Mobile Services

(%

Services and Tools Callback Context Services Journey Timeline

Callback Ul is provided through the Service Management User Interface of the Genesys Mobile
Services (GMS) at the following location: <GMS Local Host>:8080/genesys

e Services and Tools Ul
* Access Reporting tools.
* Test your Callback Scenario with a Sample interface.
* Manage the exception list for Callback services.
e Service Templates: Upload the Callback templates.
* Services:

e Create a Callback service implementing a given scenario.
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¢ Manage Call Center operating hours and holiday schedules by implementing an Office Hour
service.

¢ Callback Ul: Manage completed and scheduled Callbacks.

For further information and detailed help about the Admin Ul, refer to the Service
Management Help.

Implement a Callback Service

If you already have configured Callback as detailed in the Configuration chapter, you can now create
your callback service:

e First, add a Callback Service using the Services Tab. This Callback service will implement the scenario of
your choice.

e Once the Callback Service is instantiated, you must configure some of its parameters according to the
chosen scenario.

¢ You can implement additional Callback features by configuring sections such as Treatments, Reporting,
or Exception Patterns in your service's details.

¢ Once you are done with your service configuration, you can start using it:
* You can create and manage callbacks in the Callback Ul.

* You can use the Callback Services API to implement an application.

Scenario Sample

The Sample tab in the Tools menu supports the scenarios described in the Callback Scenarios. This
sample can be used to test that your Callback configuration works.

For more information about the sample, as well as a download option, see the Lab Sample in the
Service Management Help.
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Callback and Mobile Engagement Ul Add a Callback Service

Add a Callback Service

Modified in 8.5.207
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After Callback is configured, you must create a Callback Service for each Callback scenario that you want to implement. Then, you can manage
Callback interactions in the Callback Ul.

e To create a Callback service, you need Administrator permissions.

¢ You must set up Office Hours if you want to implement Scheduled Callback.
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Load the Callback Service Template

L]
% Maobile Services

Service Templates
Capauny d

+ Upload  §§ Delete Q-

] Service Templates

Id 3 Default Value ] Description
Capacity _capacity Click to edit 2 Dimentional Matrix specifying the number of agents availablg
Get Service per time slot
Match Interaction
: lick 1 I 1t VT
Office Hours _capacity_add Click to edit Dimentional Matrix for specific days. Overrides _capacity
b _timezone utc Timezone matching days of week and time range definition
Request Chat Defaults to UTC
Request Interaction

Open the Service Management Ul, and navigate to Services and Tools > Tools > Service Templates. By default, callback should be part of the
Service Templates list.
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If not, you must load the Callback service template before you can create a Callback service. The callback.zip template is located in the <GMS
installation directory>/service_templates directory.

Once the callback template has been loaded, it is available in the filter drop-down list of the Services tab.
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Add a Callback Service

Create a Callback Service

Add New Service

Service Template

callback

Service Name

Callback Delayed

Common Default Configuration

User Terminated Delayed v
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Navigate to the Services and Tools > Services tab. There, you can manage your services based on the templates. The services and categories
can be collapsed or expanded for easier viewing.

1. Click Create.

2. Enter a Service Name: This name will be used as the {callback-execution-name} parameter in your Callback queries.

3. Select your Common Default Configuration. These configuration scenarios are detailed in the Callback Scenarios section of this guide.

Service Created
4. Click Add. An information message confirms the service Creatio . mmm"—

The new Callback service appears in the Configured Services list.

The service is also created in the service. {callback-execution-name} section of your GMS configuration.
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Configured Callback Services
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Add a Callback Service

, }
+ Create [ Delete Q- Select All V4
%, Configured Services 4+ Add New Advanced Parameters  ® Expand All ¥ Refres
Mame H Value g Description
Callback Delayed
match-interaction '0 na
|_max_ors_submit_at 3 O-pt! Il Maximum number of times request for execution will be
request-access ) )
] ) tempts submitted to ORS. After it is reached request is removed
request-interaction . .
from persistent queue and discarded.
1 oOffice Hours . . . )
& 3600 This is the maximum amount of time (seconds) to wait for
) i the agent to accept and answer the call after customer is
Businesshours Mawndato ry _max_time_to_wait_f g p
or_agent_on_the_call connected
& This is the max number of times to retry transfer of the call
—_max_transfer_to_ag to the agent
ent_attempts
& _media_type voice IMedia type of the interaction the service is expected to
handle. This is required for URS to select agent with proper
' media capabilities.
Request parameter for APl queries i
_orig_service_id Request Parameter } Id of the service that originated
uest. Example: VR service, web session
& _snooze_duration 300 After agent availability notification is received, user can
snooze the notification for the specified duration.

w
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Key parameters for the service are automatically populated with the appropriate default values. For cluster configurations, all changes made in a
service will be replicated into the entire GMS cluster.

To configure your Callback service, refer to the configuration options described in the associated scenario page. See the
Callback scenarios for further details.

The parameters have the following characteristics:

¢ Mandatory parameters - are identified with a lock icon; you cannot rename them or remove them.

e Optional parameters - you can rename them by hovering your cursor over the value field (you will see a pencil icon), click, and then enter the new value.
You can delete optional parameters by clicking the Delete button.

e Advanced parameters - can be displayed by selecting the Advanced button in the upper right.

e Request parameters - are identified with an Request Parameter label in the Description.

Request parameters are usually provided within the request itself. Genesys recommends that you do not configure the
Request parameters through this Ul, otherwise, the parameter within the request will be overridden. If a value was entered
through this Ul and you wish to remove it at some later date, you can click the garbage can icon and the value becomes not

specified.
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Adding your Service to Virtual Service Groups
Introduced in 8.5.207

To add services to a given virtual group, add the _service_groups option to your service and enter a comma-separated list of group names.

For example, let's consider adding the 'support’ service group by adding _service_groups = 'support' to the
callback-support and callback-blackfriday-support services.

Then, you can use this virtual group to filter the services displayed to an agent. See Setting Permissions for further details.

Accessing Callback Services and Records with the Callback API

The URLs used by the Callback APl are dependent on the name of the Callback service that you have just created. Callback services are available at
the following URL:

http://<host>:<port>/{base-web-application}/service/callback/{callback-execution-name}

For instance, if you create a callback service named callback-for-mobile, then {callback-execution-name} is callback-for-mobile and the
callback service is available at:

http://<host>:<port>/{base-web-application}/service/callback/callback-for-mobile

For further details, see Callback API.
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Manage Callbacks

Updated in 8.5.207

Link to video

The Callback Ul displays the list of Callbacks that are still alive. After the Callback due date (which is
the desired_time parameter), the service record will appear in the Ul for the amount of time
configured in the _ttl parameter (in seconds).

Callback records can have the following states:

e SCHEDULED - Request is handled by Callback Management service (there are no sessions started in
ORS). While in this state, the request will be handled by Management when the specified desired time
is upcoming.

* QUEUED - Callbacks actively waiting for an agent in ORS/URS; the agent not assigned yet.

ROUTING - Agent is reserved but the call is not yet routed to the agent.
PROCESSING - Callback being handled by assigned agents.

COMPLETED - Callback was completed with _callback reason, for example, timed-out, cancelled, and
so on.

PAUSED - Callback was paused. See Pausing Callback for details.

You must have the appropriate Supervisor role in order to use the Callback UlI.
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Callback Ul Overview

2  Mobile Services

(=]

Mext 7 Days v
String to search on

Create Callback Advanced Options . ¥ Refresh
+ & P selected field A~
7
2 Callback(s) Found ¥ 59 x ‘ Phone Number v
State g Desired Callback Time (GMT+2) v Phone Number g Service Name s
SCHEDULED 7/5/2017 11:10:00 5510 Preview V4
SCHEDULED 7/6/2017 10:10:00 5510 Preview V4

4 Back to top

Genesys Maobile Services 8.5.110.07

The following features are available:
* The drop-down at the top left gives you the option to display Callbacks using a pre-defined range for the
past day, week, or month; or for the next day, week, or month.
¢ Refresh - You can force the interface to refresh the list of Callbacks.

e Search Box - You can select a column field in the drop-down at the right of the Search Box. Then, the
interface filters the results dynamically as you type.

Limitations of the Interface

e The total number of callbacks that the table can display is 100000.
¢ Callbacks are displayed in pages of 100 items for Internet Explorer and 250 for other browsers.

e There is a dropdown which you can select to get pre-defined ranges or set a custom range.
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Advanced Options

Configure Columns

@ Add Column Field

X
Configure Custom Date Range
@ Add Custom Date Range
Range Mame Days Days

b 4

Filter Table by States and Service

States Services
SCHEDULED Callback Delayed
QUEUED
ROUTING
PROCESSING
COMPLETED

Advanced Options - Opens a new window where you can customize how the Callback Management
table displays:

¢ Add Column Field - You can add your own custom column field to display in the table. This option can
be useful when you have created your own properties that you want to display in the table. You can add
more than one field, which will display in the same column. In this case, to enhance readability in the
single column, you can use the Alias option, and create a short name to display.
To enable new Column Fields, configure disable-additional-columns-from-callbacks = true in your
GMS application.

* Filter Table by States and Service - You can include one or more states to display in the table, and/
or you can select a service to display in the table. Note: You can only select one service at a time to
display.
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¢ Max # of Callbacks per Service - Default is 500.

Filtering Callbacks by User
Introduced in 8.5.207
If you configure a list of services in the services option, in the gms section of the Agent's

configuration options, the Callback Ul filters the callbacks that the administrator can see based on
this configured list. See also Adding your Service to Virtual Service Groups.
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Create or Schedule a Callback

Add New Callback

Callback type

Immediate

Service Mame

scheduled

Callback Parameters

Customer Number

Urs Virtual Queue

Request Queue Time Stat

Additional Properties

_email

foo

Cancel

You can submit or schedule a callback request by clicking Create Callback. A new dialog opens and
you can add a new Callback to be displayed. You can select the Callback Type and Service Name,
add your own properties to the Callback, and enter the following Callback Parameters:
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e _customer_number - Your Callback number.

e _urs_virtual_queue - Queue to use for this Callback if several virtual queues are used for Callback with
identical configuration. If you are defining the urs_virtual queue here, you must then remove this
option from the Callback Service (through Genesys Administrator), because it cannot be defined in both

places.

* _request_queue_time_stat - Queue statistics. For example,
"ExpectedWaitTime;Queue;8999@SIP_Server;Environment".

Make sure to set _wait _for_user _confirm to false in the selected service.

Edit a Callback

-]
S Mobile Services  WMonito Callback
Custom Date Range v /42017 T20mv Submit

& Create Callback #* Advanced Options X Refresh % Cancel Callbacks

7 Callback(s) Found v Phone Number v
State & Desired Callback Time (GMT+2) v Phone Number B

™ QUEUED » 7/4/2017 11:44:01 5110 Preview @
SCHEDULED 7/4/2017 13:40:00 5114 Preview
SCHEDULED x Vs
Edit Callback
SCHEDULED 7
-
»

Callback Time

Cancel Callba%

Back

Current Callback Information

T/4/2017 11:4401

Callback Number 5110

ys Mobile Services 8.5.110.07

In the Callback table, for Callbacks that can be edited, a blue pencil displays in the last column.
Clicking this pencil displays the edit options for that Callback.
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* You can choose to reschedule the Callback (only for SCHEDULED Callbacks).

¢ You can choose to cancel the Callback.

Reschedule a Completed Callback

6 Callback(s) Found w Phone Number w
Service ID 4 State % Desired Callback Time (GMT-5) » Phone Number % _foo %
118-dc527ec0-4df1-4c28-b4d9-898178092e6c SCHEDULED 2/21/2018 18:10:00 8887 Not Specified ra
118-b8fedadf-c731-412d-8412-7a554119d 809 SCHEDULED 2/23/2018 00:00:00 80808080 Not Specified rd
118-82e6f6b9-2aff-4129-b3f4-ddb2900ab67d SCHEDULED 2/26/2018 00:00:00 9999090 Not Specified rs

)
118-fabc2f59-2380-47c2-a623-fcB70588ad56 COMPLETED {CANCELLED_BY_ADMIN) 3/1/2018 00:00:00 11111 Not Specifie ey

118-e61e5bfc-5bd5-4cch-b219-092614c89e21 COMPLETED (CANCELLED_BY_ADMIN) 3/2/2018 00:00:00 11151 Not Specified =]
118-665bbd02-bd78-4781-2630-3e9e0180a91d SCHEDULED 3/2/2018 00:20:00 placenolder rd
®

Reschedule Completed Callback K

Last Callback Information

Last Callback Time 3/2/2018 00:00:00

Callback Number 11151515

Desired Callback Time
Desired Date 3/2/2018

Check Availability

Available Time Slot 3/2/201800:00:00  ~

Edit Customer Lookup Keys

foo | placeholder] |

Introduced in 8.5.200

In the Callback table, you can reschedule completed Callbacks that show a blue repeat icon in the
last column. Clicking this icon displays the Reschedule options for that Callback.

* The properties and user data of the completed callback are merged with the parameters of the newly
scheduled callback.

* You can choose to cancel the operation.
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Get Additional Details about the Queued State

3 Callback(s) Found T( 1 ) Expand the state

State $ Desired Callback Time (GMT+2) v
QUEUED w 8/7/2017 17:35:57
QUEUED w 8/7/2017 17:39:56
QUEUED w 8/7/201717:40:09

4 Backto top

3 Callback(s) Found w

State - Desired Callback Time (GMT+2) A
QUEUED & 8/7/20 (57
Position in queue: Not in queue Additional Queue
QUEUED w 8/7/2017 17:39:56 I'I-"I.FO i a‘f,'f'Oh I's
QUEUED v 8/7/2017 17:40:00 displayed

4 Back to top

You can expand the QUEUED state to get ORS-level diagnostics about the queued Callback.

The following information can be displayed:
« Estimated wait time: The estimated time that the customer will wait for the callback. For example:
46.5 seconds
* Position in queue: The callback's current position in the queue. For example: 3
¢ Agents Logged in: The number of agents that have logged in. For example: 3

Callback type: The type of callback. For example: WAIT FOR AGENT

Callback version: The version of the ORS Callback strategy. For example: v2.39
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¢ Channel: The callback channel. For example: WEB
¢ Dial attempt number: The number of dials that the agent has attempted. For example: 2
» Dial Result: The result of the callback dial. For example: PUSH DELIVERY NOT CONFIRMED

e EWT at first outbound call: The estimated wait time when the first outbound call happened. For
example: 22.5

* EWT at callback offer: The estimated wait time when the callback is offered. For example: 0
¢ Is snoozed: Shows whether the callback is snoozed or not. For example: false
* ORS session ID: ORS session ID of the callback. For example: QONEEH6C74C6NACO1GO15B5AESO00005

* Position at first outbound call: The callback's position in the queue when the first outbound call
happened. For example: 3

¢ Position at callback offer: The callback's position in the queue when the callback is offered. For
example: 3

e Current priority: The callback's priority. For example: 0
* Routing target: The callback's target or skill expression. For example: GMSCallbackAgents@stat.GA

¢ Time of first outbound call: The time when the first outbound call happened. For example: 1/3/2017
11:26:21

* Time callback was accepted: The time when the callback is accepted. For example: 1/3/2017
11:26:02

¢ Time of next outbound call: The time when the next outbound call happened. For example: 1/3/2017
11:27:24

Bulk Cancel and Export of Callback Records

Added in: 8.5.110

First enable this feature in your GMS configuration by creating a features section in
your GMS application, then by setting disable-bulk-cancel-and-export-callback to
false.

Bulk Cancel

Make sure to select an appropriate Time Range to filter callbacks, then make a callback selection to
activate the Cancel Callbacks button. When you click this button, the Cancel Callbacks
Confirmation dialog opens, displaying the selected callback cancellations.
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© Cancel Callbacks Confirmation

Cancel All Callbacks in Current Time Range

Callbacks to Cancel in Current Page: 2

212-49ac87cb-3a33-4da5-a921-41e821150111 SCHEDULED 5/30/2017 17:25:00 IARRRRY Callback
212-7163999e-6cd0-4801-9732-e6ach 5604743 SCHEDULED 5/30/2017 19:25:00 IARRRRY Callback

Close Confirm and Cancel Callbacks

You can either:

¢ Continue with the selections you have made and click confirm to cancel them.

* Check Cancel All Callbacks In Current Time Range, to override your previous callback selections
and delete all callbacks in the current time range. In that case, the list of displayed callbacks
disappears from the dialog window. Confirm to cancel the records.

© Cancel Callbacks Confirmation

[ Cancel All Callbacks in Current Time Range

Close Confirm and Cancel Callbacks

The resulting display shows all the callbacks that you have selected to cancel and that are now in
COMPLETED (CANCELLED BY ADMIN) state.
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o
S . .
o Mobile Services

Today v

# Create Callback ¥ Advanced Options i Refresh ¥ Download Reports @

100 Callback(s) Found v Phone Number v
State & Desired Callback Time (GMT-4) v Phone Number - Service Name $
COMPLETED (CANCELLED_BY_ADMIN) 7/12/2017 1215:33 2315464 user-terminated-workspace
COMPLETED (CANCELLED_BY_ADMIMN) 7/12/2017 12:15:33 2315465 user-terminated-workspace
COMPLETED (CANCELLED_BY_ADMIN) 7A12/2017 1215:33 2315467 user-terminated-workspace
COMPLETED (CANCELLED_BY_ADMIN) T7/12/2017 1215:33 2315468 user-terminated-workspace

Download the Reports

Then, Download Reports dialog can provide two files:

* Export Cancelled Callbacks allows you to export a CSV file that includes all of the recently canceled
Callbacks. Click the Refresh button beside the label to get an updated report if the one downloaded
seems out of date.

¢ Cancellation Summary Report is available only if you recently canceled some callbacks. This report
shows the cancellation status of the recently Cancelled Callbacks.

Download Reports

Report Type

& Export Cancelled Callbacks

| |
Cancellation Summary Report €@

Configure Custom Date Range in Advanced Options

As detailed previously, the Custom Date Range selection in the drop-down list enables you to
specify a start time and end time for the displayed callbacks. If you are often using the same date
filters, consider saving these filters in advanced options.

1. In the Callback Panel, click Advanced Options, then Add Custom Date Range.

2. Add your date filters with appropriate names.

3. Once saved, they will appear at the bottom of the drop-down list.
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Mt T Days

Create Callbachkl ¥ Advanced Oplions
0 Callback(s) Found
W _._,_E""‘-”-FF "W&zp

Advanced Options

I'.-::-nfl:]llu' Caluming

inchade Service il Column

© Add Column Field

Duwys shead
2 X

dend Week [ =
Filter Table by States and Service
States Services

SCHEDULED Sampies.

QLAEUED Termanaled preview

ROUTING

PROCESSING

COMPLETED

- =n

Configure Aliases to Display Custom Fields

Introduced in: 8.5.111

You can configure aliases for additional Column Names that display the custom fields passed in your
Callback queries parameters. To do so:
1. Make sure that disable-additional-columns-from-callbacks is false in your GMS configuration.

2. Allow the list of the parameters that you wish to see displayed by using the filter-keys and returned-
keys options.

3. Create a list of aliases for the parameters that you wish to see displayed by using the
callback_column_alias option.
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For example, if you pass the LOB parameter in your callback queries, enable its alias as follow in the
callback section:

filter-keys= callback state, callback reason, request queue time stat,
_request ewt service, vq, LOB

returned-keys= desired time, callback state, callback state, callback reason,
_ors_session _id, LOB

callback column alias = {" LOB": "Line Of Business"}
Custom Date Range v 7/25/2017 7/26/2017 Submit

o Create Callback J* Advanced Options ¥ Refresh + Download Reports

10 Callback(s) Found w Phone Number v
State 4 Desired Callback Time (GMT-4) v Phone Number % Service Name 4 Line Of Business 4
SCHEDULED 7/25/2017 14:00:00 10015 user-terminated-workspace Secondary rd
SCHEDULED 7/25/2017 14:00:00 10016 user-terminated-workspace Special Projects Fa
SCHEDULED 7/25/2017 14:00:00 10013 user-terminated-workspace Primary rd
SCHEDULED 7/25/2017 14:00:00 10017 user-terminated-workspace Not Specified Fa
SCHEDULED 7/25/2017 14:00:00 10011 user-terminated-workspace Primary rd
SCHEDULED 7/25/2017 14:00:00 10020 user-terminated-workspace Not Specified Fa
SCHEDULED 7/25/2017 14:00:00 10014 user-terminated-workspace Not Specified V4
SCHEDULED 7/25/2017 14:00:00 10019 user-terminated-workspace Not Specified V4
SCHEDULED 7/25/2017 14:00:00 10012 user-terminated-workspace Not Specified Vd
SCHEDULED 7/25/2017 14:00:00 10018 user-terminated-workspace Not Specified rd

A Back to top

Then, the Callback Ul will display the LOB values in the Line Of Business column.

If you wish to display multiple custom values, the Ul will group them in the Custom Fields column.
For example, if you wish to display the values for the LOB and service type query parameters,
configure the alias as follow:

filter-keys= callback state, callback reason, request queue time stat,
_request ewt service, vq, LOB, service type

returned-keys= desired time, callback state, callback state, callback reason,
_ors_session id, LOB, service type

callback column alias = {" LOB": "Line Of Business", " service type": "Service Type"}
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Custom Date Range

v 7/25/2017

= Create Callback ‘P Advanced Options

10 Callback(s) Found ¥

State

SCHEDULED

SCHEDULED

SCHEDULED

SCHEDULED

SCHEDULED

SCHEDULED

SCHEDULED

SCHEDULED
SCHEDULED
SCHEDULED

A Back to top

b

Desired Callback Time (GMT-4)

7/25/2017 14:00:00

7/25/2017 14:00:00

7/25/2017 14:00:00

T/25/2017 14:00:00

7/25/2017 14:00:00

7/25/2017 14:00:00

7/25/2017 14:00:00

T/25/2017 14:00:00

7/25/2017 14:00:00

7/25/2017 14:00:00

7/26/2017

Phone Number

10015

10016

10013

10017

10011

10020

10014

10019

10012

10018

Submit

¥ Refresh

Service Name

user-terminated-workspace

user-terminated-workspace

user-terminated-workspace

userterminated-workspace

user-terminated-workspace

user-terminated-workspace

user-terminated-workspace

userterminated-workspace

user-terminated-workspace

user-terminated-workspace

ap

¥ Download Reports

Phone Number

Custom Fields

Service Type : Service 1
Line Of Business : Secondary

Service Type : Service2
Line Of Business : Special Projects

Line Of Business : Primary

Line Of Business : Primary

Service Type : Service3

Then, the Callback Ul will display the LOB and service type values in the Custom Field column.
The aliases will identify each custom field.
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Submit
¥ Refresh + Download Reports
Fhone Number w
) ) State
Service Name 5 Custom Fields
Desired Callback Time (GMT-4)
user-terminated-workspace Service Type : Phone Mumber
Line Of Busine _
Service Name
user-terminated-workspace Service Type : Line Of Business
Line Of Businc=a R L]
user-terminated-workspace Line Of Business - Primary s

Note that you can also use the aliases to search and filter the list of displayed Callbacks.

Tip
Keys for Custom Fields do not need to start with underscores: you can use LOB or
LOB for the name of your Custom Field.
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Play Treatments

The following configuration is required for voice scenarios.

Set up Play Treatments

© Callback Delayed
+ Create [ Delete Q- Select All V4
%, Configured Services + Add New Advanced Parameters  ® Expand All ¥ Refresh
Name 4 Value % Description %
Callback Delayed N N > N
match-interaction Terminated (17)
request-access
request-interaction S Csce I resiment
(4)
[ Office Hours
a {"file""http:/flocalhost:8080/gene Music file to be played when call is not answered by the user
Business-hours _treatment_call_failu sys/1/document/service_templat and is forwarded to answering machine. Empty value will
re_answering_machi e/callback/Resources/SampleTre pick the voice file from the callpack template. This
ne atments/call_fail_ans_machine.w parameter accepts a URI as a string or as a JSON formatted
av","hints":{"am-beep- string. JSON formatted string can be used to specify hints to
detection™"on"}} the RequestApplyTreatment. Example,
{file""nttp-//localhost: 8080/ genesys/1/document/service_t
emplate/callback/Resources/SampleTreatments/call_fail_a =
ns_machine.wav”,'hints":{"am-beep-detection™:"on"}}
a {"file"."http:/flocalhost:8080/gene Music file to be played when the customer answers the
_treatment_custome sys/1/document/service_templat callback. This parameter accepts a8 URI as a string or as a
_connect e/callback/Resources/SampleTre JSON formatted string. JSOM formatted string can be used
atments/call_fail_ans_machine.w to specify hints te the RequestApplyTreatment. Example,
av","hints":{"am-beep- {file""nttp-//localhost:8080/genesys/1/document/service_t
detection™"on"}} emplate/callback/Resources/SampleTreatments/call_fail_a
ns_machine.wav”,'hints":{"am-beep-detection™:"on"}}
a {"file""http://local ic file to be played when the service fails to find the &

_treatment_find_age ‘Max Time To Wait For Agent on

You can configure the treatments to play in the Callback and Mobile Engagement > Configured
Services tab. Expand your Callback service and then, expand Voice Treatments.

e If you are using Genesys Media Server, place the treatment files that will be used by the Callback
service in the <MCP Install Dir>/GMSApplications directory and enter the name of your file.

* For other media servers, enter the URL of your files.

In voice scenarios, the customer call can be placed in a virtual queue, waiting for an agent. You can
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set up custom treatments for calls waiting for an agent:

e To play some music while the customer is waiting for an agent, set the
_treatment waiting for agent option to your music file location (as stated above).

e If you configure the max time to wait for agent on the call option for the waiting for agent state
and if this timeout occurs, the service will play the music file set by the option
_treatment find agent fail option.

Customize Treatments for User Terminated Calls

The outbound call has Call Progress Detection (CPD) enabled. If a human answers the call, the Media
Server provides the CPD result in the call state parameter of the request submitted to your
SCXML plugin. The interaction ID is provided in the interaction id parameter, which is set to
undefined if the call is not answered.

If you implement one of the user terminated callback scenarios, you can define treatments for
outbound calls by using an SCXML plugin, a VXML application, or by setting Callback built-in
treatments through your service options. Callback built-in treatments are part of the the Callback
template strategy and they will be executed if you set options that start with _treatment, such as
_treatment customer connect, treatment call failure answering machine,
_treatment find agent fail, and so on.

The figure below is a simplified diagram of the flow for the treatments. The table that follows details
the Callback service options that configure the condition points in the diagram.

Plugin XML
D— Enabled Enabled Check Call State
machine
. Yes
Machine
Treatment
Invoke Plugin Invoke VXML R
fax Treatment
¥
¥ Disconnect I
Check Reply route_to_agent
cancel
retry [ error
¥
Disconnect
¥
* Continue -
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Customization

Plugin Enabled = yes

VXML Enabled = yes

On Connect Treatment = yes
(optional)

Machine Treatment

Retry Limit Exceeded = yes

Answer type

machine, human

human only

human only

human only
answering machine

all

Implement an SCXML Plugin

Genesys
Callback
CPD-Enabled

Customer

Requests a callback

SIP Server
Dlal Dlal
CPD-results
Call State
Invoke

Response (message, action)

Options
_plugin on dial url = <URL
of your SCXML strategy>

_plugin_on_dial_invoke_on_call_failed =
true

~plugin on dial url = <URL
of your SCXML strategy>

_plugin_on_dial_invoke_on_call_failed =
true or false

_on_customer_connect treatment url
= <URL of your VoiceXML
application>

_treatment_customer_connect
= <music file location>

_treatment call failure answering machine
= <music file location>

Number of dial attempts >
~max_dial attempts

Media Server

Plugin

Calculate
Next action

Exit

If a user requests a new Callback Service which is CPD-enabled, Callback sends a request to the SIP
Server to dial a call and waits for CPD-Results to invoke the SCXML plugin. The SCXML plugin
performs the custom treatments. Callback waits for the plugin response, which includes the following
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values:

e Mandatory: action and message.

e Optional: customer number, customer _number prefix, and delay.

Then, Callback executes the action.

If the customer ends the call while the plugin is executing, the plugin should detect
hangup by the customer and return the response with its action set to cancel or
retry, and its message set to interaction deleted. Otherwise, the plugin message

value should always be set to 0K.

Invoke your Plugin

Callback invokes the SCXML plugin by starting an SCXML session with the full path to an SCXML entry
page provided in the plugin on dial url option, for example:
_plugin on dial url = http://server:port/StrategyName/src-gen/IPD Pluging Entry.scxml

The Callback strategy generates the Callback parameters listed in the table below, and adds them to
the <session:start> request, in the request-specific attribute of the request's body:

Parameter name Parameter description

JSON-formatted call state object returned by ORS
on a successful CPD. Set to a value from the
_genesys.ixn.callState documented
enumeration.

Possible values are:

_call_state ’

Ok=0 (human answer)
NoAnswer=7

SilDetected=8
AnsweringMachineDetected=9

FaxDetected=17

Set to the interactionlD, or undefined for the no

_interaction_id

_customer_number

answer case.
Customer number dialed prior to the plugin

invocation.
_gms_service_id GMS Service ID responsible for this Callback.
_ors_service_id ORS Service ID responsible for this Callback.
user data User data passed to the user request when starting
- - Callback.
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Number of outbound attempts made to connect to

_dial_attempt the customer (includes the current attempt).

Time To Live (in seconds) that Callback waits to
receive a response. Callback must receive the
response before TTL expires to continue the
£l processing of the Callback service request;

- otherwise, the Callback session will exit with an
error. The TTL value is set by the
_plugin on dial timeout option of your Callback
service in the Admin Ul.

HTTP URL to which the plugin must send the
_reply_url asynchronous response after the execution of the
plugin logic.

The plugin strategy needs to use these parameters for various purposes. You can get examples of
how you can use them in the code of the Custom Callback Plugin Sample.

Invoke Plugin For No Answer or Machine Answer

By default, the plugin on dial invoke on call failed option of your callback service is true
and invokes the plugin if the outbound call is not answered or is answered by machine.

To disable the plugin invoke in that scenario, you must set the
~plugin on dial invoke on call failed option to false.

In @ no answer scenario:

e The interaction id parameter is set to undefined.

e The call state parameter is set to NoAnswer (7).

In this scenario, the plugin should return a reply message with its action parameter
set to cancel or retry.

In a machine answer scenario:

* The call state parameter is set to AnsweringMachineDetected (9).

 If the SIP Server configuration has the TServer / am-detected option set to connect, the call remains
connected and _interaction_ id is set to the corresponding voice interaction ID. In that case, the
plugin can play a message to be recorded.

e Otherwise, SIP Server hangs up the call and interaction id is set to undefined.
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Invoke Plugin with Attached Call

By defaut, the plugin on dial associate ixn option is set to true in your Callback service's
configuration and passes the control of the voice interaction (call) to the plugin.

e Before returning the reply, the plugin must detach the call to allow Callback to regain control of the
interaction. See the Custom Callback Plugin Sample example for further details. The Plugin sample
includes a re-usable sub-workflow that performs the detach interaction step and returns the plugin
response.

e The plugin must monitor the interaction.deleted event; if this event occurs, the plugin must return a
reply with its message parameter set to interaction deleted and its action parameter set to either
cancel or retry.

Disabling the plugin's interaction control (by setting plugin on dial associate ixn to false)
provides compatibility with the earlier release of the plugin feature.

Genesys recommends to pass the interaction's control to the SCXML plugin to ensure
the best compatibility with Composer strategies. Composer's various interaction-
related blocks are configured by default to handle the interaction.added and
interaction.present events that occur when the interaction is associated to the
plugin session.

Invoke Plugin with no Attached Call

Composer strategies are built to start processing when an interaction is attached to the Orchestration
session, but the plugin is invoked with no attached interaction if you set the following options in your
Callback service configuration:

e plugin on dial invoke on called failed=true and the call failed

e plugin on dial associate ixn=false

If there is no attached call, the Callback session sends an event named plugin.start to the plugin
session and you must force the strategy to start by adding the following event to the interaction
process diagram of the strategy. Refer to the Custom Callback Plugin for an example of the Composer
plugin strategy that includes this event handling in the interaction process diagram.

Name = plugin start
Event = plugin.start
Body:
<log expr="'plugin.start in IPD event handler. Starting application with no interaction'"/>
<assign location="system.SessionID" expr=" sessionid"/>
<assign location="system.StartEvent" expr="_event"/>
<assign location="App StartEvent" expr="_event"/>
<raise event="application.start">
<param name="interactionid" expr="undefined"/>
</raise>
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Return the Plugin Response

By sending a request to the existing session (<session:fetch>), the plugin returns an asynchronous
response to the Callback URL received in the reply url parameter of the query. The response is
included in parameters named action and message. For example:

<session:fetch requestid="requestId" srcexpr=" data. reply url"
method=""'post'" timeout="30">
<param name="action" expr="replyAction"/>
<param name="message" expr="replyMesg"/>
</session:fetch>

Action returned Type of answer Callback behavior

cancel all Callback cancels the request.

Callback routes the call to an agent. If an agent is
not immediately available, the music file
configured by the treatment waiting for agent
parameter is played.

route to agent human or machine

Callback routes the customer call to the destination
specified by the message parameter. The
destination can be any valid value for the
destination of a Composer "Force Route" block, for
example an ACD Queue, Destination Label, or
Routing Point.

The router priority and age of the call are respectively set in the
GMS_URS PRIORITY and RouterData70 attached data keys.

* You can retrieve and use the GMS_URS PRIORITY
value to set the interaction priority if the

route_to_rp human or machine interaction is added to another queue.

e The RouterData70 value will automatically be
used by URS to set the interaction age if the
interaction is added to another queue.

Limitation: Once the customer interaction is
routed to the desired route point, GMS issues
the reporting user event and the GMS callback
ends. As a result, there will be no further
reporting data.

Callback dials out again unless the maximum
retry all number of retry attempts has been reached, in
which case the request is cancelled.

The plugin can optionally return a customer number, a customer number prefix, or a retry time delay
in seconds. If included, these values override the service configuration values.

If the callback service has the ixn redirect hints parameter set to {"extensions":
{"CPNDigits": "5557777"}}, the value of the CPNDigits key is updated in the returned
customer number value. See the Callback Service Options Reference for a description of the
_ixn redirect hints parameter.

The following example includes the optional parameters:
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<session:fetch requestid="requestId" srcexpr=" data. reply url"
method=""'post'" timeout="30">

<param name="action" expr="'retry'"/>

<param name="message" expr="'0Ok'"/>

<param name="delay" expr="300"/>

<param name="customer number" expr="'555-2336"'"/>

<param name="customer number prefix" expr="91"/>

</session: fetch>

Invoke a VXML Interface

The sequence for executing a VXML application is the same as that for the plugin detailed above,
except that the VXML application is only invoked for human answers. The built-in treatment path is
taken for the other cases.

The requirements for the VXML response are identical to the plugin case, but the response must be
returned in an exit namelist object named treatment result. For example:

<var name="treatment result" expr="{'action':'route to agent', 'message': 'Ok'}"/>

<exit namelist="treatment result"/>

Busy Tone and Fax Machine Detection

When the system detects a busy tone or a fax machine, GMS changes the value of the call state
Callback strategy parameter of the on-dial plugin. As detailed in the Interaction Interface Object
Model page, call state=6 for a busy tone, and call state=17 for a fax machine.

In addition, GMS supports the following scenarios for busy tone and fax machine detection:

* If you are using an on_dial plugin and if you configured
_plugin on dial invoke on call failed=true, the on_dial plugin is invoked and any configured
treatment is applied.

e If you don't use an on_dial plugin or if you configured
_plugin on dial invoke on call failed=false:

* The busy call state results in a retry of the call, similarly to a no answer scenario, until GMS reaches
the value of max_dial attempts option.

e The fax call state results in the callback service ending with status COMPLETED /
FAIL FAX REACHED.
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Create Office Hours

* You must set up Office Hours if you want to implement Scheduled Callback and
Disposition Dialog.

* Office Hours are used when requesting Callback API to create an immediate or a
scheduled callback. See Start or Schedule a Callback for more information.

Upload the Office Hours Template

In the Services and Tools > Tools > Service Templates tab, make sure that the Office Hours
template is available. Otherwise, click Upload to add the office-hours.zip to the Templates list.

Create the Office Hours Service

°
DO Mobile Services Monitor Services Office Hours Callback ools « default +

© business-hours <1> Edit settings to fix /-\\ Calendar Table

calendar timezone ssues ,
+ Create  fj Delete [¥ Regular Office Hours X Settings

[~ oOffice Hours Day ® Week G GMT+

e e Time Monday Tuesday Wednesday * Thursday Friday

exceptions
All Day

hours1

1AM
2 AM
3 AM

4 AM
@ Create Office Hours 5 AM
6 AM
7 AM

8 AM 2 Regular Office 2 Regular Office 2 Regular Office 2 Regular Office t2Regular Office
9 AM Hours Hours Hours Hours Hours
10 AM 8:00 AM - 12:00 PM 8:00 AM - 12:00 PM 8:00 AM - 12:00 PM 8:00 AM - 12:00 PM 8:00 AM - 12:00 PM
11 AM
12 PM

Genesys Mobile Services 8.5, 20004

Click Create in the Office Hours tab, select office-hours in the filter and configure the business-

Callback User's Guide 113


https://docs.genesys.com/Documentation/GMS/8.5.2/API/CallbackServicesAPI#Start-Callback

Callback and Mobile Engagement Ul Create Office Hours

hours service.

Set your Calendar Timezone

Settings

Show All Day Row
@ on

Popovers

@ on

Checkbox
@ on

Time Interval per Block

00:30:00 w

First Day of the Week

Sunday w

Office Timezone

UTC

Display Timezone

UTC

B —— ==

Lo V
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The Display Timezone is the timezone of your Calendar view and is set to the Browser timezone by
default. The Office Timezone is bound to the timezone parameter of the Office Hours service.

The Calendar view is in Read-Only mode if your Display Timezone and Office Timezone are different.

In that case, the interface shows a warning message and does not allow you to edit the Calendar
view.

[+] Show me the message

The calendar is in read-only mode because the office timezone is not equal to the displayed timezone

To fix this issue, click Settings and fix your Office Timezone and Display Timezone by setting
identical timezones.
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Add Office Hours to your Callback Service

Callback Delayed
Q- Select All ry
+ AddNew [ Delete Advanced Parameters  ,® Expand All ¥ Refresh
Name 3 Value e Description e
~ Chat (1)
~ General (18)

& _attach_udata single_json Specifies the format in which the user data should be
attached to the interaction prior to routing to agent. Select
data_id to attach only the storage data_id (key:
GMS_UserData). Select single_json will attach all user data
as one json object (key: GMS_UserData). Select
separate_keys to attach each user data as a separate key.
Mame of the key will be the same as the user data key.

] _business_hours_ser e - Specifies a configured office-hours service. Request Desired
vice Time is verified against the defined regular and specific

& _call_direction USERTERMINATED When value is USERORIGINATED, this implies the user
(device) will initiate the call to be connected to the agent. If
USERTERMINATED is specified, then the enterprise will
initiate the call to the specified target.

_capacity_service Specifies a configured capacity service. Agent availability iz
- ined capacity and capacity

5 Mobile Services 8.5

Select your Callback Service and expand the General category. Find the business hours service
parameter and select your Office Hours instance in the drop down list.
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Create Regular Office Hours

© Business-hours (")

[¥ Regular Office Hours

Time Monday Tuesday

1AM

2 Al Select your

3 AM

4 A1 OFFI'CE’, Hours

5 AM
B AM
TAM

8 AN 2 Regular Office

9 .AM Hours Hours
10 AM

8:00 AM - 5:30 PM

Select your Office Hours service in the Configured Service tab.

& Regular Office

8:00 AM - 5:30 PM

Wednesday
Wed-Wed 08.00.AM-
06.00.PM

Calendar Table
Today LY Settings

Day ® Week GMT+0000

Thursday Friday

2 Regular Office 2 Regular Office

Hours Hours
8:00 AM - 6:00 PM 8:00 AM - 6:00 PM

In the Calendar view, make sure that Regular Office Hours is checked.

Select your Office Hours service in Configured Services. You can add Office Hours by selecting a
timezone in your Calendar view; the Office Hours interface shows up. Or, you can switch to the

Table view and edit options there.
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Switch Views to Check Office Hours

Business-hours ~ Switeh Calendar Views Calendar Table

Regular Office Hours " May 1, 2016 = May 31, 2016 > Today LX Settings

Week ® Month

Day

Sunday Monday Tuesday Wednesday Thursday Friday Saturday

1 2 3 = 5 6
I 2 Regular Off I 2 Regular Off

8 9 10 11 12 13
I 2 Regular Off I 2 Regular Off

15 16 17 18 19 20
I t2 Regular Off I 2 Regular Off I 2 Holiday I 2 Holiday

22 23 24 25 26 27 28
I £ Regular Off I 2 Regular Off

29 30 3
I £ Regular Off I 2 Regular Off

I £ Regular Off I 2 Regular Off

If you add Office Hours to one or more days in the week, the results apply to all months and weeks.
Switch to the Month view to see the actual Office Hours of the month.

Callback User's Guide 118



Callback and Mobile Engagement Ul Create Office Hours

Add Holidays and Exceptions

Business-hours [\ Uncheck Calendar Table

Regular Office Hours - May 11, 2016 > Today E LX Settings

Time Wednesday 05/11

1 an \(\ Click on a specific day in your calendar to

® Day O Week O Month GMT+0(

2AM
3AM Add Holiday or Exception
4 AWM Wed-Wed 04.00.AM-05.00.AM
5AM
x
6 AM
7 A New Office Hours
8 AM 2 Regular Office Hours
9 AM 8:00 AM - 6:00 PM Block Type
10 AM
T @ Holiday (holiday) () Exception (bh_add)
T This is an Annual Event
1PM
2PM Weeks Selected:
AL 01/09/2023 - 01/15/2023
4PM
ST 01/09 (Monday) 01/13 (Friday)
) 01/10 (Tuesday) 01/14 (Saturday)
& 01/11 (Wednesday) 01/15 (Sunday)
01/12 (Thursday)

You can set certain dates as Holidays so they will not be used for Callback and certain dates as
Exceptions (or Special Office Hours) for days that require additional hours.

To add these special events, uncheck the Regular Office Hours parameter, then click in the
Calendar view on the appropriate date to open the dialog box. By default, the special event is added
to the current year.
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New Office Hours

Block Type

(® Holiday (holiday) () Exception (bh_add)
[ This is an Annual Event

Weeks Selected:

01/09 - 01/15

01409 0113

01/10 0114
¢ 01/11 01/15

0112

Cancel

When you create the holiday or the exception, if you select the This is an Annual Event option, the
holiday or exception is planned annually, not only for the current year.
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Exceptions Always Apply

Business-hours

Regular Office Hours - May 1, 2016 =

No Callback on Holiday

Monday Tuesday

2 3

I 2 Reqular Office Hou
800 AM - 530 PM

2 Regular Office Hou I <

9 10
I 2 Regular Office Hou I 2 Regular Office Hou

16 17
I 2 Regular Office Hou I 2 Regular Office Hou

30 3

May 31, 2016 *

Wednesday

Holiday

Regular Office Hou

I 2 Regular Office Hou I 2 Regular Office Hou I 2 Regular Office Hou

23 24 25
I 2 Regular Office Hou I 2 Regular Office 2 Regular Office

Special Office Hours (Exception)

Calendar Table \

LX Settings

Today E

Day O Week @ Month GMT+000C

Thursday Friday

4 5
ular Office Hou I 2 Regular Office Hou I 2 Regular Office H

12 Regular Office Hou I 12 Regular Office Hou

18 19 20

27

Special Office Hou 2 Reqular Office Hou

2 Regular Office Hou

I 2 Regular Office Hou I 2 Regular Office Hou I 2 Regular Office Hou I 12 Regular Office Hou I 12 Regular Office H

I 2 Regular Office Hou I 2 Regular Office Hou I 2 Regular Office Hou I 2 Regular Office Hou

I 2 Regular Office H

If you set a Holiday and an Exception on the same day, then the Exception applies. The office is
opened during the hours configured in the Exception.

If Regular Hours, Holiday, and Exception are set on the same day, then Holiday blocks Regular Hours,
but the Exception still applies and the office is opened during the Exception's hours.
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Add Holidays and Exceptions from the Table view

© Business-hours

Q- Select All

Value

utc #

Calendar Table

I Delete All Parameters  ,® Expand All ¥ Refresh

Description 7

Timezone matching days of week and time range definition. Defaults
to UTC.

v Holidays (1)

a1

5/11/2016

=] 5/19/2016

Days when the office will be closed. Use syntax Tyyyy-IMM-dd”. For
example _holiday5="07-15"

Days when the office will be closed. Use syntax Tyyyy-]MM-dd'. For
example _holiday5="07-15'

1 2 3 4 5 5] T

15 16 17 1BZD by

22 23 24 25 26 27 2B

2 30 N

~ Special Office Hours (1)

1
(
€1
(

You can also add Holidays and Exceptions by editing the associated options in the Table view. If you
do not check the Annual Event option, the holiday or exception is added to the current year.

Callback User's Guide

122



Callback and Mobile Engagement Ul Create Office Hours

Add Holidays and Exceptions from the Table view

, Calendar Table
© Business-hours

Q- Select All i
I Delete All Parameters  ,® Expand All ¥ Refresh
Value 7 Description 7
utC # Timezone matching days of week and time range definition. Defaults
to UTC.
v Holidays (1) Il
5/11/2016 Days when the office will be closed. Use syntax Tyyyy-IMM-dd”. For
example _holiday5="07-15"
) ‘ 5/19/2016 | . Days when the office will be closed. Use syntax yyyy-IMM-dd”. For
$ M T W T F s I
— 1 1 2 3 a4 s & 7
8 9 10 11 12 13 14 (1
15 16 17 18 0 2
N 22 23 24 25 26 27 28 ol
23 30 31
~ Special Office Hours (1) Il

You can also add Holidays and Exceptions by editing the associated options in the Table view.

Import Rules in Office Hours

The Import Rules feature enables you to set up Regular Hours, Holidays, and Exceptions (Special
Office Hours) that you want to apply to several Office Hours services. The imported content (options
and setup) becomes part of the Office Hours service.

e Further changes to the imported services (Regular Hours, Holidays, Exceptions) instantly apply to all the
Office Hours services that imported the rules.

¢ The Import Rules feature ignores the timezones defined in the imported service.
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Tip
The Import Rules feature allows you to create and manage a single Office Hours,
Holidays, and Exceptions calendar that is applicable to multiple team calendars.

Use Case: Import Holiday Rules

Let's consider that you have several offices in the United States, sharing the same federal
holidays and vacations. In that scenario, you can create a dedicated Office Hours called
Federal USA Holidays, and then import it in your U.S. offices, instead of manually adding
the same holidays to your Calendar views for each service (0ffice New York and Office
SFO in the example below).

Use Case: Import Exception Rules

Let's consider that, every two weeks during spring, all of your offices are opened on
Wednesday evenings from 6-9 p.m. for a special event called Special Deal. In that scenario,
you can create an Office Hours service called Special Deal Events where you create the
needed extra hours. Then, you can import this rule in each concerned office (0ffice New
York, Office SFO, and Office Amsterdam in the example below).

Note that Special Deal Events will apply even if Regular Hours and Holiday are set for a given date, as explained
above.

Set up Rules in a Dedicated Office Hours Service
/—

© Special Deal Events

Calendar Table

+ Create [ Delete Regular Office Hours May 1, 2016 - May 31, 2016 » Today X Settings

B Office Hours Day O Week ® Month ~ GMT+0200
All Offices Monday Tuesday Wednesday Thursday Friday
Federal USA Holidays 2 3 4 5
Office Amsterdam
Office New York g 10 1 12 1
Office SFO
Special Deal Events 16 17 18 19 20

Special Office Hou

23 24 25 26 27

30 3

Special Office Hou
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To set up these rules, create a new Office Hours service. In this example, two services are created:
Special Deal Events and Federal USA Holidays.

Import Rules in Office Hours Service

Calendar Table

Office SFO
Q- Select All s’
Bl Clone [ Delete All Parameters ™ Expand All ¥ Refre
Value e Description
America/Los_Angeles Timezone matching days of week and time range definition. Defaul
to UTC.
A Holidays (0) Click, then select the Office Hours to import g\
—
v Imported Rule Calendars (2) / a
L T ——
4 Federal USA Holidays An option that specifies an existing office hour to import into the
current office. Note: The timezone of the imported office will be
disregarded.
Special Deal Events An option that specifies an existing office hour to impaort into the

current office. Mote: The timezone of the imported office will be
disregarded.

Imported Schedule Calen% ﬁ

—————— e ———

Switch to Table view and expand Imported Rule Calendars. Click E'—'I' to add a new rule line, then
select the appropriate Office Hours service.
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View Imported Rules

Calendar Table

© Office SFO

+ Create  fj Delete Regular Office Hours “ May 30,2016  — June 5, 2016 > Today E L1 settings

M office Hours Day ® Week O Month  GMIT-0700

All Offices Mon 05/30 Tue 05/31 Wed 06/01 Thu 06/02 Fri 06/03

Federal USA Holidays

Z Holida
Office Amsterdam All Day I ¥

Office Mew York

Office S50 - &, Imported from Federal USA Holidays

Special Deal Events
3AM
4 AM
5 AM N
6 AM 7:00 AM - 5:30 PM

: 2 Regular ice %2 Regular ice %2 Regular ice 2 Regular Ice 2 Regular ice
AN 2 Regular Off 2 Regular Off 2 Regular Offi 2 Regular Offi 2 Regular Offi
8 AM Hours Hours Hours Hours Hours
9 AM 7:00 AM - 5:30 PM 7:00 AM - 5:30 PM 7:00 AM - 5:30 PM T:00 AM - 5:30 PM 7:00 AM - 5:30 PM
10 AM
11 AM
12 PM
1PM 7
o Impbrted from Special Deal Brents
3PM
4PM
5PM
& PM
7PM
8 PM
9PM

2 Special Office
Hours
6:00 PM - 9:00 PM

UENESYE MULDIE DEVILES 6.0, U4

Switch to the Calendar view to display the results of the imports. In this example, you can see that
the Special Deal Events and Federal USA Holidays are imported in the Office SFO service.

If you update an Office Hour service (for instance, Special Deal Events or Federal USA Holidays),
you will see these updates replicated to the Office Hours services importing the modified calendars
(here, 0ffice SFO).

You can also click Settings and see the imported Offices Hours in the list of Displayed Calendars.
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Import Schedules in Office Hours

You can import Schedules from other Office Hours Services to combine working hours of multiple
teams and shifts in the same Office Hours service. In this scenario, you can create a main Office
Hours service (A1l 0ffices in the example below) into which you can import all the Office Hours
schedules (Regular Hours, Holidays, Exceptions, and timezones). This results in the union of the
imported Office Hours schedules within the timezone of the main Office Hours.

Tip
The Import Schedules feature helps you to manage teams dispatched in different
timezones.

Import Schedules in Office Hours Service

Calendar Table

© All Offices
+ Create g Delete Q- Select All V4
B office Hours All Parameters ™ Expand All ¥ Refres
) Value B Description
All Offices
FECIE AR Europe/Paris Timezone matching days of week and time range definition. Default
Office Amsterdam to UTC.
Office Mew York
Office SFO ~ Holidays (0)

Special Deal Events

imported Rule Calendars (0) - Click, then select the Office Hours to import

e —

=
v Imported Schedule CalendarV (

Office Amsterdam An option that specifies an existing office hour to import into the
current office. Note: The timezone of the imported office will be
considered.

2 R
"

\ _/

office New York An option that specifies an existing office hour to import into the
current office. Note: The timezone of the imperted office will be
considered.

office SFO An option that specifies an existing office hour to import into the
current office. Note: The timezone of the imported office will be
considered.

W _#_‘J/

/\

Switch to Table view and expand Imported Schedule Calendars. Click El to add a new rule line,
then select the appropriate Office Hours service.
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Display Imported Schedules

Al Offi " Calendar Table
Al UTees Current Timezone
+ Create [ Delete fceMours < May30,2016 -  June52006  »  Today [[Sf % settings Day ® Week O Month
[ office Hours Time Men 05/30 Tue 05/31 Wed 06/01 Thu 06/02 Fri 06/03
All Offices: All Day
R 2 Regular Office Hours 2 Regular Office Hours 2 Regular Office Hours 2 Regular Office Hours
Office Amsterdam 1AM 4:00 PM - 2:30 AM 4:00 PM - 2:30 AM 4:00 PM - 2:30 AM 4:00 PM - 2:30 AM
Office New York ——
3AM
Office SFO AAM
Special Deal Events 5AM
6AM
7AM
Office SFO
SFO Lu @ © @ © ©
g AM Regulalav Regulai Regula Regular Regular
Office ;.. Office Office Office Office
10 AM 12:00 AM
Amsterdam Hours Hours Hours Hours Hours
1AM 8:00 2:00 8:00 2:00 2:00
New York 12EM AM - AM- AM - AM- AM-
6:00 6:00 6:00 6:00 6:00
1PM @ PM @ PM @ PM @ PM @
K Regulal Regulai Regulal Regular Regular
3PM Office Office Office Office Office
Hours Hours: Hours Hours
4PM @ 1:00 @ 1:00 @ 1:00 9 1:00 9
5PM Regular b= Regular b= Regular il Regular il Regular
office mno Office 10:00 R poffice 1000 § pffice 1000 § pffice

Genesys Mobile Services 8.5

Switch to the Calendar view to see the results of the imports.

In this example, the A1l 0ffices service combines the schedules of the 0ffice SFO, Office New
York, and Office Amsterdam services.

The timezones, Regular Hours, Holidays, and Exceptions are aggregated in the Calendar view that
shows the callback coverage for the three offices.

You can also click Settings and see the imported Offices Hours in the list of Displayed Calendars.

Office Hours Options Reference

For a list of Office Hours options, see the Office Hours section of the Genesys Mobile Engagement
Options Reference Guide.
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Create Capacity Service

o
G Mobile Services  Monitor ~ Services  Office Hours

Q cap_1000x24x7

+ Create  fj Delete E
%, Callback =+ Add New (_ ) Advanced Parameters
Callback Delayed Name s Value ¢ Description
allback Delaye
Il capacity @& Capacity Wnn, Tue, Wed, Thu, Fri, Sat, Sun] Multiple properties that start with the _capacity_
7/ describe capacity allocation through the course ¢
cap_1000x24x7 The JSON structure specifies the day of the weel

capacity for hourly slots during that day. Days of

Vi

Get are numbered as recommended by 1S0-8601 fror
(Monday) to 7 (Sunday). _capacity_1: {1 : {"090C
7,"1100": 10,"1200": 10 } } or _capacity_2 : {2 :{
"1000": 5,"1100": 7,"1200": 7 }}

LoadBalancer-checker

gms-status

& _capacity_1 {"
{"1000™:1000,"1100™1000,"1200":
1000,"1300":1000,"1400":1000,"15
00":1000,"1600":1000,"1700":1000
,"1800":1000,"1900":1000,"2000":1
000,"2100":1000,"2200"1000,"230
0":1000,"0000™1000,"0100"1000,"

@&, Match Interaction

match-interaction

o)

Request Access

request-access

esys Mobile Services 8.5.200.00.b

The Capacity Service enables you to define the number of scheduled callbacks that are allowed for
Callback for a given time slot in the week. Then, your Callback service refers to your Capacity service
and to your Office Hours service to adjust the agent availability and the number of scheduled
callbacks.

You can define exceptions for dates when fewer or more scheduled callbacks are available, and you
can define as many Capacity services that you need to match your Callback services.

Make sure to update the existing calendar configuration to set the correct timezone for your Capacity
service. For instance, if you configured "EST", or "PST" timezones with the configuration, your
parameters must use the timezones defined for Java such as "America/Toronto", or "Europe/Paris".
See Wikipedia to get the list of correct timezones.

Create a Capacity Service

Create a new service and select capacity in the list of templates.
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Once this service is created, you can use the Capacity API.

You also need to create an Office Hours service.

Link your Capacity to your Callback Service

o
< Mobile Services Monitor Services  Office Hours

(=]

© Callback Delayed
+ Create  fj Delete Q ~ capa Select All 7
%, Callback + AddNew ffj Delete @ )Advanced Parameters ™ Expand All

Value E Description

ar

Name
Callback Delayed

Il capacity v General (2)

cap_1000x24x7 M _capacity_service Cho . = Sets a configured capacity service. Agent availabilit
verified against the defined capacity and capacity ex

Get cap_1000x24x7 "

& _media_type voice Media type of the interaction that the service is expel

i

LoadBalancer-checker
handle. This option enables URS to select an agent w

gms-status . . e .
the appropriate media capabilities. This is a default v

automatically populated when using the predefined L

@&, Match Interaction i A )
Terminated scenario. You do not need to change this

match-interaction

o

Request Access

request-access

esys Mobile Services 8.5.200.00.b

If your Callback service needs variable capacity levels, you must map its capacity service
parameter value with the name of the Capacity service that you have created.

Callback services that need fixed capacity levels can continue to use the
_max_request_by time_bucket option. But, if your Callback service includes both
_capacity _service and _max_request_by time_bucket options, then
_max_request by time bucket is ignored.
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Add Capacity
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Capacity
Q-
+ Add New Advanced Parameters  {_* Ref]
Hame s Value
& Capacity s 2 Dimentional Matrix specifyMg the number of agents
available per time slot.
Capacity Exception { 1 Dimentional Matrix for specific days Nyvgrrides _capacity.
& _service x
& Service OapaCIty
L Timestamp sun Mon Tue Wed Thu Fri Sat Set Slot
_type 00:00
01:00
T 02:00
03:00
04:00
05:00
06:00
07:00
08:00
09:00 5 10 10 10
10:00 5 10 10 10
11:00 5 10 w [ ]
12:00 5 10 10
13:00 5 10 10
14:00 L 10 10
15:00 5 10 10
16:00 L 10 10
17:00 5 10 10
18:00 5 10 10
19:00
20000
21:00
22:00
2300
Set Day

Cancel Reset m
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Edit the Capacity value to open the Capacity grid widget. Enter your capacity per Day or Hours, then
Save.

Values above 999 are accepted but may not display properly in the Ul.

Capacity
Q-
+ Add New Advanced Parameters & ¥ Refres

Mame * Value 5 Description

& Capacity [Mon, Tue, Wed, Sun] 2 Dimentional Matrix specifying the number of agents
available per time slot.

Capacity Exception s 1 Dimentional Matrix for specific days. Overrides
_capacity.

& _service & capacity

& Service uTC Timezone matching days of week and time range

Timezone definition. Defaults to UTC.

_type builtin

You can see for which days of the week the Capacity service is defined.
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Add Exceptions

Capacity
Q-
<+ Add New Advanced Parameters £ * Refj
K Mame B Value 7 Description
& Capacity [Mon, Tue, Wed, Thu, Fri, Sat, 2 Dimentional Matrix specifying the number of agents
Sun] available per time slot.

Capacity Exception @ 1 Dimentional Matrix for specific days. Overrides _capacity.
& _service & capacity
& Service utc Timezone matching days of week and time range definiti
Timezone Defaults to UTC.

_type builtin

For more flexibility, you can set exceptions for the Capacity service. You can enter dates with
different capacities for federal holidays, vacations, and so on.

Edit the Capacity Exception value to open the interface.
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Capacity Exception
Click (+) to modify the

I S capacity for this date
oiras (]
< July 2016 - \

S M T W T F 8
12

3“55759 x

011 12 13 14 15 18 CaDaC\ty Exceptlon

17 18 19 20 21 22 23

24 25 26 27 28 22 3 Capacity Exceptions Timestamp  Capacity = Timestamp  Capacity
o 2016-07-04 x 00:00 12:00 2
01:00 13:00 2
Add Capacity Exception
/\/ 02:00 1400 2
03:00 15:00 2
04:00 16:00 2
You can add wore 50 1700 )
exceptions heve, or edit later 06:00 18:00 L
. 07:00 19:00 1
the _exception value —
08:00 1 20:00
09:00 1 21:00
10:00 2 22:00
11:00 2 23:00

You can add as many exceptions as you need. You can also even update later to modify your capacity.
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Capacity
Q-
+ Add New [ Delete Advanced Parameters & ¥ Ref]
Name B Value & Description
& Capacity [Mon, Tue, Wed, Thu, Fri, Sat, 2 Dimenticnal Matrix specifying the number of agents
available per time slot.
) Capacity Exception [2016-07-04] 1 Dimentional Matrix for specific days. Overrides _capacity.
& _service & capacity
& Service uTtc Timezone matching days of week and time range definiti
Timezone Defaults to UTC.

_type builtin

Click Save to update your Capacity data. A popup message displays the operation result.
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Display Sub-capacities and Sub-exceptions

Capacity
Q-

Name

+ Add

Value

New @ ) advanced Parameters Refresh

A

& Description &

& Capacity

& _capacity_1

& _capacity_2

& _capacity_3

& _capacity_7

[Mon, Tue, Wed, Sun]

1
{100010,"1100™10,"1200"10,
"1300":10,"14007:10,71500"10,"
1600%10,"17007:10,"1800"10,"
& 090010}

2~
{1000:10,"1100™:10,"1200™10,
"1200"10,"1400%:10,"1500":10,"
1600™10,"17007:10,"1800"10,"
& 0900°:10%}

& {'3-{"1000%10,'0900":10}}

7
{"1000":5,"1100™:5,"1200":5,"13
00™5,"1400"5,"1500™:5,"1600":
571700"5,"1800™5,"0900"5)}

2 Dimentional Matrix specifying the number of agents
available per time slot.

To display the list of sub-capacities and sub-exceptions, enable Advanced Parameters.
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Exception Patterns

Genesys Callback allows implementing patterns to be checked before performing the callback
attempt. The Patterns tab enables you to configure exceptions; for example, phone numbers. You
can define as many patterns as you wish, then add them to your Callback services.

Customer Phone Numbers

For the customer number parameter used in Callback, note that the system internally adds a + sign
to the phone number by default. As a result, if _customer number=12345678901, it will become
_customer number=+12345678901 in the system before going through the processing of the patterns
exception. So, to define patterns exception for specific phone numbers, you need to add the + sign at
the start of your pattern exception, for example:

[cb errors]
12345678901=\+12345678901

Create a Pattern Group

o
S Mobile Services  Monitor Services Office Hours Calback  Tools ~ default ~

© Callback_exceptions

iii Delete Q- ? Help + Add New ' Refresh

/-;-Add

il Pattemns

ar

Name Value

Callback_exceptions exceptionl 555.*

patterns_1
exception2

Add New Pattern Group

New Pattern Group Name

cal \back_ermrsl

Genesys Mobile Services 8.5, 20008
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Navigate to Services and Tools > Tools > Patterns. Click Add to define a new group of patterns.
Enter a name.

Create an Exception Pattern

o
3 Mobile Services  Monitor  Services  Office Hours  Callback  Tools v default ~

© callback errors Add a new exception /—\
+ Add  ff Delete @\ ? Help + AddNew [ Delete * Refresh
#l Patterns Name s Value
Callback_exceptions ¥ 911 M 5 Click here to set the value

callback_errors

patterns_1

Select a group. Then, in this group, click Add New to create as many patterns than you need.
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Test your Exception Pattern

°
S Mobile Services  Monitor  Services  Office Hours  Callback  Tools v default ~

© callback_errors (1) Enter a string to test your pattern
+ Add i Delete @\o ? Help + Add New ¥ Refresh
il Patterns Name Kvalue Vi
Callback_exceptions 911 % a11-
callback_errors
patterns_1 bad-emails [0-9a-zA-Z]+@badrobot.com

() If any, the matching pattern gets selected

Genesys Mobile Services 8.5,200.0

Select a group. You can test the value of a pattern against this entire group. Type a value in the input
field, and if a match is found, the corresponding table row will be highlighted.
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Add the Pattern Group to your Callback Service

o
S Mobile Services Monitor ~ Services  Office Hours

O | callback
Q- _exc General 7 + AddNew [ Delete i Advanced Parameters  &_* Refresh
m L9
Name 3 Value E Description
v General (1)
[ _exceptions : List of the exception patterns that should be verified before processing this callback
callback_exceptic ¥ x

request. See the Pattern configuration for details.
@ Default Value

Genesys Mobile Services 8.5

Navigate to Services and Tools > Services and expand your Callback service. In the General
section, set the name of your Pattern Group as the value of the exceptions parameter.
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How to get Help about Supported Patterns?

A regular expression defines a search pattern for strings. Regular expressions can be used
to search, edit and manipulate text

Regular Expression Description
Matches any character
“regex Regex must match at the beginning of the line
regex$ Regex must match at the end of the line
[abe] Set definition, can match the letteraorborc

[abc] [vz] Set definition, can match a or b or ¢ followed by either v

orz

When a "*" appears as the first character inside [] then it
negates the pattern. This can match any character except
aorborc

Ranges, letter between a and d and figures from 1to 7,

will not match d1

Click the Help button to get more information about the supported patterns. For additional details,
refer to Oracle Java Lesson: Regular Expressions.

Here are some examples:

911=911-

date=(0[1-9]1|1[0-9]|2[0-9]1|3[01]).(0[1-9]|1[012]).[0-9]{4}
date2=(0[1-9]|1[012]1)[- /.1(0[1-91|[12][0-9]|3[01])[- /.1(19]|20)\d\d
email="[ A-Za-z0-9-]+(\.[ A-Za-z0-9-]+)*@[A-Za-z0-9-1+(\.[A-Za-z0-9-]+)+$
bad e-mail address="[ A-Za-z0-9-1+(.[ A-Za-z0-9-]+)*@badrobot.com+$
digit=\\\\d*k*
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Enable Status Notifications

Modified in 8.5.211

Version Update

The Callback service can now publish notifications
to GMS that distributes these notifications to the
target specified in the callback's service request,

8.5.105 and consequently, to the subscribers of these
T notifications. The possible targets can be an ORS
session of an existing GMS service (orsch
notification type) or any URL (httpcb notification
type).

You can now receive two types of notifications:
Callback SCXML and additional GMS Callback
notifications.

8.5.107
By default, this feature is turned off for all callback
services.

85211 GMS can now send a notification reminder event

before the callback is dialed.

e The cbe on dial done eventis now sent for
each dial request, not just one time.

* The cbe on service exit eventis always
8.5.232 sent at the end of the Callback strategy before
the subscription is removed. Its parameters,
such as the c_last dialed number parameter,
are set in the different states of the strategy,
according to the status of the Callback.

To enable Callback Status Notifications (SCXML), you can either:

¢ Enable the Default Status Notifications (fromm SCXML).

* Create a Transaction Event object that overwrites the list of default notifications and assign it to your
Callback Service. You can configure additional GMS Callback Status notifications by using the
Transaction List entries which override the defaults. In that scenario, the notifications will only report
the events specified in this Transaction List.

e Add notifications parameters to your Callback Services query.
Callback will send the notification events and provides two subscription modes to receive them:

e subscribe notify—Callback subscribes for your application to the notifications.

e notify—Your application must subscribe to receive events.
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Enable Default Status Notifications in a Callback Service

Callback Later

Q,~ _status ®x  Select Al rd + Add New @ ) Advanced Parameters ¢ Collapse All Y Refresh
Mame ¥ Value e Description 3,
v General (4) /
& httpch Both httpcb and orsch can be configured to send out status netifications

_status_notification_type

& http://<host=:1664/test Mame of the notification target that receives status notifications. If
_status_natification_target notification type is orscb then ORS session id is required. If notification tyoe
is httpcb then target is the url of the appication.

& MName of the notification provider to be used for status notifications. If left
_status_notification_provid blank default provider information is used.

er

& subscribe_notify defaults to false. If set to subscribe_notify callback application will subscri
_enable_status_notification for status notification on behalf of the client; if set to to notify it is assum

that client has already subscribed for status notifications. This setting wil
override setting in GMS events transaction list object.

To receive default callback status notifications (SCXML), open the Service Management User Interface
and navigate to your Callback Service (in the Configured Services panel).

Enable Advanced Parameters and configure the following options in the General section:

e enable status notification= subscribe notify
e status notification type= httpcb (or orschb)

e status notification target = Target URL (or the ORS session id if status notification type
= orsch)

You can add the following additional parameters to your Callback queries:

e status notification debug = false—Set to true to enable the debug mode for notification.

e status notification language = <language> where the language matches one of the supported
languages used for push notifications.

The _status_notification_debug option defines the URL where the notifications will be pushed using
HTTP POST requests.
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Tip

The orscb notification type should be used for advanced ORS customization only.

Enable Reminder Notifications

If you enabled default status notifications, you can also enable the Reminder Notifications in your
Callback service.

* Configure _enable_notification_reminder to true and, by default, the system will send the
_cbe on_callback reminder notification event 300 seconds before the dial time of the call.

* You can change the value of the _notification_reminder_buffer option to get the reminder notification
earlier or later. The default value is 300 seconds.

The time when the reminder is sent depends on the URS Estimated Wait Time (URS
EWT) of the callback. You can get the URS EWT value by checking the callback's
position in queue (ewt) using the callback API.

The Reminder feature periodically checks the EWT retrieved from URS for each call.

e IfURS EWT < notification reminder buffer, the Reminder feature sends the reminder event status
notification.

¢ If not, depending on the EWT's value, the Reminder feature schedules the next check for the call:
e Every 30 seconds if URS EWT is not defined,
* Every 45 seconds if URS EWT < 600 seconds,
* Every 300 seconds if 600 seconds < URS EWT < 3600 seconds
e Every 1800 seconds if URS EWT > 3600 seconds

Limitation: The frequency of the Reminder periodical checks is not configurable.
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Overwrite Default Notifications with a Transaction List

< Genesys Genesys Administrator

M| Peovisionne [

PROVISIOMING = Routing/eServices > Transactions > MNew Transaction

Navigation # - \Transactions\

Lggl Emvironment +||| 3¢ cancel [l save & Close [ save (=l Save & New | [ Reload
Ly Switching iy J Configuration " Options H Permissions
= Routing/eServices =

5] Business Attributes * Name: GMS_Evants

[} Objective Tables Tenant:

[} Voice Prompts * Type: List

@ Statistical Tables * Alias: GMS_Events

[} Statistical Days Recording Period: 0

[} Transactions Format:

[l Routing Scripts State: Enzbled

[} Orchestration

Start by defining a Transaction List object that includes the notifications and the associated events
triggering notifications.

Open Genesys Administrator. In PROVISIONING > Routing/eServices > Transactions, click New
to create the GMS_Events list.

In the Options tab, create a properties section with:

e enable status notification = subscribe notify

e status notification provider = <customerprovider> or blank for default provider
e status notification type = httpcb

e status notification target=<Target URL>

e status notification debug= false

e status notification language = <language> where the language matches one of the supported
languages used for push notifications.

Then, create a section for each subscribed event and define the data that your application needs to
receive in the notification event.

e notify params—The comma-separated list of callback parameters to retrieve. See the reference to get
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the list of parameters that can be retrieved. Note that you can also retrieve some specific user data
there in addition to callback parameters.

e notify custom—(Optional) A JSON object of the custom attached data to send in the notification in
addition to the callback parameters set in notify params.

Tip
* Either click New to add the following options or copy the source below to a
GMS_Events.cfg file that you can import in your Transaction List.
e You do not have to include all the events listed below.

* The notify custom parameter should suite your use case or can be removed if not
needed.

In the XML sample below, c_target must match c_target as provided by URS.
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[properties]

_status notification type

enable status notification = notify
status notification provider =

= httpch

_status notification target =<your URL>

[ cbe on service create]

notify params = service id, service name,

notify custom

{"namel":"valuel", "name2":

[ cbe on virtual ixn createl

notify params
notify custom

[ cbe on target found]

_service id, service name
{"namel" :"valuel", "name2":

notify params = service id, service name,
notify custom = {"namel":"valuel", "name2":

[ cbe on dial init]

notify params = service id, service name,
notify custom = {"namel":"valuel", "name2":

[ cbe on dial donel
notify params
notify custom

_service id, _service name,
{"namel" :"valuel", "name2":

[ cbe on connect treatment start]
notify params = service id, service name,

notify custom

[ cbe on customer queued]
notify params

{"namel":"

'valuel", "name2":

_service id, _service name,

_customer_number,
"value2"}

"value2"}

_urs_virtual queue

c target, urs virtual queue

"value2"}

_customer number,
"value2"}

_customer _number,
"value2"}

_customer number,
"value2"}

customer _number,

notify custom {"namel":"valuel", "name2": "value2"}

[ cbe on route to agent]

notify params = service id, service name, _customer number,
c_agent extension

notify custom = {"namel":"valuel", "name2": "value2"}

[ cbe on service exit]

notify params = service id, service name, _customer number,
notify custom = {"namel":"valuel", "name2": "value2"}

c_dialed number

c_dialed number, c call result, c_call num attempt

~vq_for outbound calls, c dialed number

_vqg_for_outbound calls, c dialed number

_urs_virtual queue, c_agent id,

c last dialed number, c_termination type
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[ cbe on callback scheduled]
notify params= customer number, phone number, desired time
notify custom={"state":"scheduled"}

[ cbe on callback rescheduled]
notify params=_customer number, phone number, desired time
notify custom={"state":"rescheduled"}
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SCenesys Genesys Administrator Tonant: Envronmen: 2| Newiingon | sgout | v | @

IONITORING PERATIONS

PROVISIONING > Routing/eServices > Transactions > GMS_Events

Navigation [ 6MS_Events - \Transactions\
[ Environment 3 Cancel =l Save & Close [ save [ Save &New | [ Reload
[y Sukching | confguation | options_ gmemmee——| laport your configuration file

Lyl Routing/eServices [=] [CNew [ Delete % Bﬂ]‘(#mwt \ View:| Advanced View (Annex) |
[3) Business Attributes

Name Section Option Value
(3 Objective Tables T | Fiter |[Fitter |[Filter |[Fitter |
g\]uice Prampts cbe_on_service_create/notify_params tbe_on_service_create notify_params __service_id, __service_name, __customer_number, __urs_v... -
m Statistical Tables cbe_on_service_create/notify_c ustom tbe_on_service_cresate notify_custem {"name1™"value1”, "name2"; “value2}
[ Statistical Days = che_on_service_exit (2 Ttems)
(5 Transactions cbe_on_service_exitinotify_params cbe_on_service_exit notify_params __service_id, __service_name, __customer_number, _ c_las__
X . cbe_on_service_exitinotify_custom cbe_on_service_exit notify_custom {"name1""value1”, "nameZ"; "value2}
[ Routing Seripts
m Orchestration = cbe_on_target_found (2 Items)
cbe_on_target_foundinctify_params cbe_on_target_found notify_params _service_id, __service_name, __c_target, __urs_virtual_gueue
cbe_on_target_foundinctify_c ustom cbe_on_target_found notify_custem {"name1™"value1”, "name2"; “value2}

S cbe_on_virtual_ixn_create (2 Items)

che_on_virtual_ixn_create/otify_params che_on_virtual_ixn_create notify_params __service_id, __service_name

che_on_virtual_ixn_create/otify_custom cbe_on_virtual_ixn_create notify_c ustom {"name1”value1”, "name2”: "value2}

= properties (3 Items)

g Desktop properties/status_notific ation_provider properties status_notfication_provider  default

[og Accounts properties/status_notifistion_type properties status_notfiztion_type httpeb

u Voice Platform properties/enable_status_notific ations properties enable_status_notific ations true -

[ Outbound Contact 4 4 |pagelt Jof1| b bl | @ Displaying objects 1 - 21 of 21
Ready 6/17/2016
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Add the Event Transaction List to the Callback Service

Callback Now
Q- General rd + AddNew [ Delete @ ) advanced Parameters

Name v Value B Description

& _customer_number Bequest Parameter - Customer's phone number. Can be used to¥natch
with service data when call direction is set to USERORIGINATED.
call direction is USERTERMINATED to establish connection wi

@ _service aclback  Make sure to display Advanced Parameters

_type ors l

v General (26) \

& _attach_udata single_json Specifies the format in which the user data should be attached to the
prior to routing to agent. Select data_id to attach only the storage data
GMS_UserData). Select single_json will attach all user data as one json
(key: GMS_UserData). Select separate_keys to attach each user data as
separate key. Mame of the key will be the same as the user data key.

_business_hours_service Specifies a configured office-hours service. Request Desired Time is veri
against the defined regular and specific calendar hours.

@ _call_direction USERTERMINATED When value is USERORIGINATED, this implies the user (device) will ini
call to be connected to the agent. If USERTERMINATED is specified,
enterprise will initiate the call to the specified target.

) _callback_events_list GMS._Events - MName of the transaction list object which has the customized versi
events list. If value is set to empty string then default hardcoded s
used.

Edit the Advanced Parameters in the General section of your Callback Service.

Set the callback events list to the name of the Transaction List created above, GMS_Events in
our example.

If you set other status notification parameters (_status notification type,
_status notification target, status notification provider) in your Callback
service configuration or in your REST queries, they override the values set in the
Transaction List object.
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Callback Status Notifications Events

Callback notifications consist of a JSON object which contains:

e deviceId—The custom id provided at subscription time by the subscriber.

* message—The notification message as defined in the Callback Events Transaction List.
¢ timestamp—The timestamp for this notification.

e _service_id—The ID of the service which sent the notification.

e _service_name—The name of the service which sent the notification.

The Notification events can include some additional attributes detailed in this table. Check the
Notification Event reference to get the list of attributes available for a given notification.

Optional attributes Description Example

"c target": { "agent": "KSippola",
Ildnll: II7001II’ Ilidll:

A selected target that "Customer Service", "place":
c_target specifies the agent/queue "SIP Server Placel", "resource":
- resource that will process this  "7001", "return": "target",
request. "stat value": "0", "switch":
"SIP Switch", "type": "GA", "vq":
"SIP VQ SIP Switch" }
c_agent_id Equals to c_target.id. "c agent id": "Customer Service"

The agent's DN target (equals

Cc_agent_extension to c_target.dn). c_agent extension": "7001
c_dialed_number The customer number. "c_dialed number": "5115"
Indicates the
_genesys.ixn.callState
c_call_result state. Possible values are "c call result": "O"
listed in the
IxnIntfObjectModel page.
c_call_num_attempt The number of outbound call "c_call _num attempt": "1"

dialing attempts.

The termination type, also

known as Disposition value. It  "c termination type":
equals to the "COMPLETED .AGENT"
_CB _DISPOSITION value.

c_termination_type

The following JSON code is an event sample where the notify_custom parameter was configured to
{"namel":"valuel", "name2": "value2"}.

{

"event id": " cbe on service create",
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"timestamp": "1467575991",

" service id":

"445-20e740d3-8458-43d6-834d-3713c3385bac",

_service name": "samples dev",

" callback state": "QUEUED",

customer number": "5115",

" urs_virtual queue": "SIP VQ SIP Switch",
"namel": "valuel",
"name2": "value2"

i

"event id":

_cbe on virtual ixn create",

"timestamp": "1467575992",

_service id":

"445-20e740d3-8458-43d6-834d-3713c3385bac",

" callback state": "QUEUED",
"namel": "valuel",
"name2": "value2"

i

"event id":

cbe on dial init",

"timestamp": "1467575992",

" service id":

"445-20e740d3-8458-43d6-834d-3713c3385bac",

" service name": "samples dev",
" callback state": "QUEUED",

" customer number": "5115",

"c dialed number": "5115",
"namel": "valuel",

"name2": "value2"

i

"event id": " cbe on dial done",
"timestamp": "1467576012",

" service id":

"445-20e740d3-8458-43d6-834d-3713c3385bac",

_service name": "samples dev",

" callback state": "QUEUED",
" customer number": "5115",
"c_dialed number": "5115",
"c call result": 0,
"c_call num attempt": 1,
"namel": "valuel",

"name2": "value2"

e

"event id": " cbe on connect treatment start",
"timestamp": "1467576012",

" service id":

"445-20e740d3-8458-43d6-834d-3713c3385bac",

_service name": "samples dev",

" callback state": "QUEUED",

" vq_for outbound calls": "VQ GMS REP SIP Switch",
"c_dialed number": "5115",

"namel": "valuel",

"name2": "value2"

e

"event id": " cbe on customer queued",
"timestamp": "1467576016",

" service id":

"445-20e740d3-8458-43d6-834d-3713c3385bac",

_service name": "samples dev",

" callback state": "QUEUED",

" vq_for outbound calls": "VQ GMS REP _SIP Switch",
"c_dialed number": "5115",

"namel": "valuel",

"name2": "value2"
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{
"event id": " cbe on target found",
"timestamp": "1467576016",
" service id": "445-20e740d3-8458-43d6-834d-3713c3385bac",
" service name": "samples dev",
" callback state": "QUEUED",
" urs_virtual queue": "SIP VQ SIP Switch",
"c_target": {
"agent": "KSippola",
"dn": "7001",
"id": "Customer Service",
"place": "SIP Server Placel",
"resource": "7001",
"return": "target",
"stat value": "0",
"switch": "SIP Switch",
"type": "GA",
"vq": "SIP VQ SIP Switch"
}I
"namel": "valuel",
"name2": "value2"
}
{
"event id": " cbe on service exit",
"timestamp": "1467576291",
" service id": "445-20e740d3-8458-43d6-834d-3713c3385bac",
" service name": "samples dev",
" callback state": "QUEUED",
"c termination type": "COMPLETED.AGENT CONNECTED",
"namel": "valuel",
"name2": "value2"
}

Reference for Notification Events
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Event Name

_cbe_on_service_create

_cbe_on_virtual_ixn_create

_cbe_on_target_found

_cbe_on_dial_init

_cbe_on_dial_done

_cbe_on_connect_treatment_start

_cbe_on_customer_queued

List of attributes specific to this

event

_customer_number

_urs_virtual_queue

_urs_virtual_queue
c_target
c_agent id

C_agent_extension

_customer_number

c_dialed_number

_customer_number
c_dialed_number
c_call_result

c_call_num_attempt
_vg_for_outbound_calls
c_dialed_number

_vqg_for_outbound_calls

c_dialed_number

When this event is triggered

As soon as the callback service (ORS session) is started.

When the virtual interaction is successfully created in URS.

When the callback has found the target and URS reports the target to ORS.

When the dialing to the customer is started. Note: This behavior applies to
both standard and preview callback.

When the dialing result is known. Starting in 8.5.232, the
_cbe _on_dial done event is now sent for each dial request, not just one
time.

Only genesys.ixn.callState types related to dial tone will be mapped with the
c_call result attribute of the cbe on dial done event. Refer to the
IxnIntfObjectModel to get the list of call states.

When the greeting treatment is started right after the successful CPD.

In User Terminated scenarios, as soon as the onconnect treatment is over,
the virtual interaction becomes routable and the customer is placed into a
queue to wait for an agent.
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List of attributes specific to this

Event Nam
e ame event

_urs_virtual_queue

_cbe_on_route_to_agent c_agent_id

C_agent_extension
c_last _dialed_number
_cbe_on_service_exit —Customer_number
c_termination_type
_desired_time
_cbe_on_callback_scheduled _customer_number
_v_queue
_desired_time
_cbe_on_callback_rescheduled _Customer_number
_V_queue
_desired_time
_cbe_on_callback_cancelled _Customer_number
_V_queue
_desired_time
_cbe_on_callback_status_updated —Customer_number
_V_queue

When this event is triggered

When the call is transferred from Routing Point to the agent.

In all exit scenarios. Starting in 8.5.232, the cbe on service exit eventis
always sent at the end of the Callback strategy before the subscription is
removed. Its parameters, such as the ¢ _last dialed number parameter,
are set in the different states of the strategy, according to the status of the
Callback.

When a callback in SCHEDULE status is created.

When a callback in SCHEDULE status is re-scheduled.

When the callback is canceled.

When the callback state field is updated by a REST query. This can be
due to ORS updates.
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Event Nam
e ame event

_urs_virtual_queue

_cbe_on_callback_reminder
Added in 8.5.211

_desired_time

_cbe_on_callback_submitted R

_urs_virtual_queue

_cbe_on_callback_resubmitted
_cbe_on_callback_submit_failed

_desired_time

_cbe_on_callback_processing_failed _Customer_number

_V_queue
_customer_number

_cbe_on_callback_queued oISl

_v_queue_for_outbound_calls

List of attributes specific to this

When this event is triggered

By default, you receive the reminder event 300 seconds before the dial time of the call.
Configure _enable_notification_reminder to true to enable this event and change the value of

_notification_reminder_buffer to get the reminder earlier or later.

When the callback is submitted for ORS execution.

When the callback is re-submitted for ORS execution.
When submit for execution fails.

When the callback processing fails.

When the callback is successfully submitted and its state changed to
QUEUED.
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Configure Agent Reject

To ensure that agents will be able to reject callbacks, Genesys recommends to configure the following
values by using the Genesys Administrator Extension to edit your configuration.

1. In your T-Server application:
divert-on-ringing=false

after-routing-timeout=30

2. In the gts section of your ORS application:
cti-transaction-timeout=45

3. In the General section of your Callback service:
_agent_transfer_confirm_timeout=0

Note:

In a callback strategy (and via the URS WaitForTarget strategy), when looking for an agent, a target
agent is selected and the callback call is routed to that agent. If that agent does not answer the call
or if they decline the call, the callback strategy should be able to look for another agent.

But when RONA is setup on the SIP Server option (agent-no-answer-overflow=<RoutePoint>), the
callback call is sent to an overflow RoutePoint, and the callback strategy receives a Call Forwarded
event,

"Ixn queued on RONA:

{"data":{"interactionid": "HSUUCOCM3H1DJI6KDG70VBN496KOOOO4T" , "partystate":"queued","focusdeviceid":"6660",
"hints":{"callstate":23,"cause":7,"ccevent":8},

"partyid":"HSUUCOCM3H1DJ6KDG70VBN496KOOOO4T-3"}, "invokeid":"","name":"interaction.partystatechanged", "sendid":"

instead of a Call Redirected event.

"Ixn diverted from agent:
{"data":{"divertingdeviceid":"7001","divertingpartyid":"G7DE9E5NHHINF4ACFTKSEIEFUVKOOO002-2","divertingpartystat
"hints":{"callstate":22,"cause":7,"ccevent":13},"interactionid":"G7DE9E5NHHINF4CFTKSEIEFUVKOO0002", "newdestinat

"invokeid":"","name":"interaction.ondivert", "sendid":"","type":"platform"}
The callback strategy is not able to manage the forwarded event and it is locked.

When a call is under the control of an ORS callback strategy, sending it to another RP will not start a
new strategy. It must be detached before sending it, if that is the intended outcome. The current
solution is to let the callback strategy to manage the agent lookup without the RONA configuration to
forward to another RP.
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Get EWT for Callback

Modified in 8.5.109, 8.5.205

In your Callback service, you can configure some options to specify how Callback should query the
Estimated Wait Time.

e See set up an EWT method for Callback.
To retrieve the Expected Wait Time (EWT), you have three possibilities:

¢ Directly query URS.
e Use the EWT API for virtual queues (added in 8.5.109).

¢ Use the urs-stat Service.

Set up an EWT method for Callback

In your Callback service, you can configure some options to specify how Callback should query the
Estimated Wait Time. The following options are used to define when a request should be submitted to
the Callback Orchestration execution service. You can either:

e Set the request queue_time_stat parameter to provide the Stat Server statistics. For example, you can
use the ExpectedWaitTime statistic to set this option:
"ExpectedWaitTime;Queue;8999@SIP_Server;Environment"

* Configure the Callback service option named request ewt service to specify the urs-stat service
to use to retrieve EWT value from URS stats.

e Configure the option _urs_virtual_queue or _urs_ewt_vq in your Callback service to be able to use the
REST API as detailed below.

Query URS

To retrieve the Expected WaitTime (EWT) for callback, you can use the lvg method of the URS Web
APl and directly query the following URS URL:

http://<urshost>:<ursport>/urs/call/max/lvg?name=VQ Name&aqt=urs&tenant=TenantName

To view additional URS 1lvq input parameters and output information, open a browser with URS
running and run the help method for 1vq as follows:

http://<urshost>:<ursport>/urs/help/call/lvqg
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The help method is described in the Universal Routing 8.1 Reference Manual, Appendix C, "Supported
Methods."

Use the Callback EWT API for Virtual Queues

Configure the URS Virtual Queue
Introduced in 8.5.109
You can query Estimated Wait Time statistics if you configure a Virtual Queue for your Callback

service by using the service option _urs_virtual_queue. Then, you can use the new REST API, Query
EWT, as detailed in the Stat Service API page.

In your GMS configuration, add a connection to an active URS to enable this service.

Configure another Callback Queue
Introduced in 8.5.205

If you configure different Virtual Queues for different calls, for example, scheduled callbacks,
callbacks, and regular calls, those queues may share the same agent group. In this use case, URS
cannot retrieve EWT for scheduled callbacks because it has its own queue and URS doesn't have any
EWT info for this queue yet.

To avoid this issue, configure the correct VQ name to query for EWT in the _urs_ewt vqg option of your
Callback service. If this option is configured, the system will use this specific queue to query EWT,; if
not, the system uses the queue defined in _urs_virtual _queue to query EWT as usual.

You need to define this option for each service.

Use the urs-stat Service

Create a GMS built-in service using the urs-stat template that provides the following benefits:

» Statistics caching of the statistic to reduce the load on URS. The caching policy parameter sets the
cache period in seconds (see below).
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¢ Load balancing and scaling across multiple GMS nodes.

¢ A single point of contact for your app.

Create a urs-stat Service
To create this GMS built-in service, select the urs-stat template when creating a new service.

X

Add New Service

Service Template
Choose among the following...  ~

capacity

get
match-interaction
office-hours

request-access

request-chat

request-interaction

urs-stat

callhack

Configure urs-stat parameters

Configure the following parameters in your <name-of-urs-stat-service> service:

_caching policy=30 # Cache refresh time in seconds
_service=urs-stat

_type=builtin

_urs_stat url parameters=name=<VQ Name>&tenant=<Tenant Name>&aqt=urs
_urs_url=http://<urshost>:<ursport>/urs/call/max/1lvq

Where: VQ Name, Tenant Name, urshost, and ursport match the environment and Callback service's
Virtual Queue (VQ). The following screenshot shows the creation and configuration of the my-urs-
stat service.
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my-urs-stat
Q- =+ Add New Advanced Parameters ¥

Name - Value & Description
& _caching_policy 30 LIRS Statistic caching policy (seconds)
& _service & urs-stat
_type builtin
o name=MyCallbackVQ&tenant=Environm Statistic parameters (url encoded format)
_urs_stat_url_parameters ent&aqt=urs
& _urs_url http://urs-demo:2828/urs/call/max/lvgq URS URL

The urs url option can point to the load balancer in front of the URS that should be
configured as part of the GMS provisioning steps in that scenario.

Query EWT using the urs-stat service

The following query example shows the resulting response that you get when you call the service:
GET http://<gmshost>:<gmsport>/genesys/1l/service/<name-of-urs-stat-service>

Response:

{ "wcalls" : 20, "wpos" : 21, "time" : 1467922222, "hit" : 95, "calls" : 20,
"wt" : 0, "ewt" : 300, "pos" : 21, "aqt" : 300 }

¢ The value of interest here is ewt: the time unit is seconds and can be a float value.

* An empty object will be returned if there is no activity for the VQ.
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You can use a single service for multiple VQs by omitting the urs stat url parameters option
from the service and including the value for that option (for example, name of virtual queue, tenant
ID, or statistical method) in the HTTP request as follows:

http://<gmshost>:<gmsport>/genesys/1l/service/<name-of-urs-stat-service>
?name=<one-of-the-callback-VQs>&tenant=<tenant-name>&aqt=urs

The URS stat service will append the content of the urs stat url parameters option and the HTTP
request parameters to the URS query. To view additional URS lvq input parameters and output
information, open a browser with URS running and run the help method for 1vq as follows:

http://<urshost>:<ursport>/urs/help/call/lvq

The help method is described in the Universal Routing 8.1 Reference Manual, Appendix C, "Supported
Methods."

If, for example, you set the following configuration for the <name-of-urs-stat-service> service:

_caching policy=5

_service=urs-stat

_type=builtin

_urs_stat url parameters=scale=true&tenant=Environment&aqt=urs
_urs_url=http://<ursloadbalancer>:<ursport>/urs/call/max/lvq

You can can use this service for multiple VQs by specifying only the name of a virtual queue in the
HTTP request as follows:

http://<gmshost>:<gmsport>/genesys/1l/service/<name-of-urs-stat-service>
?name=<one-of-the-callback-VQs>

Calculate Estimated Wait Time using AHT or Time in Queue

When Callback queries Estimated Wait Time, you can select one of the following methods:

e urs - EWT calculated based on average time in queue. To use this method, specify agqt=urs in the strings
used to retrieve statistics, which can be specified either in options or URLs, as detailed in the previous
sections.

e urs2 - EWT calculated based on average agent handle time. To use this method, specify aqt=urs2 in the
strings used to retrieve statistics, which can be specified either in options or URLs, as detailed in the
previous sections.

urs method

If you specify aqt=urs, URS calculates the Estimated Wait Time based on the recent history of the
calls distributed from the Virtual Queue. For example, for a given VQ, if a call was distributed in 60
seconds, another call in 120 seconds, and the third one in 60 seconds, then URS calculates that the
average time per call is 80 seconds: (60+120+60)/3. So, if the Virtual Queue already has 6 calls
waiting, then the Estimated Wait Time for a new call is 560 seconds: 80*(6+1).
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urs2 method

If you specify aqt=urs2, URS calculates the Estimated Wait Time based on the average time spent by
agents to handle calls from this Virtual Queue.

¢ URS calculates the average time per call for each agent. URS tracks the periods when the agent
becomes ready then busy, and using this data, it gets the average time that the agent spends per call.

¢ URS also needs to know which agents are answering calls from the given Virtual Queue, so the precision
of aqt=urs2 depends on how precisely URS can get this list of agents.

* If URS already has pending calls in the Virtual Queue, then it looks for which agents the calls are
waiting for and uses their average time per call.

* If the Virtual Queue is empty and has no waiting call, URS considers the agents from the agent
group (or skill expression) used as a target for this Virtual Queue in the past.

When URS calculates Estimated Wait Time based on agent handle time, the result shows that agents
working together handle calls faster than each agent does separately. Let's say that agentl has an
average of 60 seconds per call, agent2 of 120 seconds per call, agent3 of 60 seconds per call. URS
considers that agentl handles 1/60 part of a call per second, agent2 handles 1/120 part of a call per
second, and agent3 handles 1/60 part of a call per second. So, working together, they handle 1/
60+1/120+1/60 = 5/120 = 1/24 part of the call per second, which means an average of 1 call in 24
seconds.

As a result, if there are 6 calls in the queue, the Estimated Wait Time for a new call will be 168
seconds: 24*(6+1).

Note that URS also takes into count whether agents are shared between several Virtual Queues.

For example, if URS notes that agentl is handling calls from 3 Virtual Queues, then instead of
counting an average of 60 seconds for this agent, it will count 180 seconds because the agent is
supposed to spend 1/3 of their time working on calls from each queue. As a result, URS will calculate
that the average time per call is now 33 seconds for all of the 3 agents handling this queue.

In this scenario, if there are 6 calls in the queue, the Estimated Wait Time for a new call will be 231
seconds: 33*%(6+1).
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Callback Scenarios and Configuration

This chapter details the scenarios that you can implement based on the provided templates and
options.
e User Terminated Immediate: The customer requests that an agent immediately makes a callback.
¢ User Terminated Delayed: The customer delays the callback and an agent will call him.
e User Terminated Scheduled: The customer schedules the callback and an agent will call him.

e User Terminated Delayed Agent Preview: The customer schedules the callback and an agent will
preview the callback before calling.

e User Terminated Agent First with Implicit Reservation: The customer requests a callback. The Callback
service first calls an agent with Implicit Reservation Information (ISCC) and starts an outbound
consultation call with the customer.

e Capacity: You define the number of agents that are available for Callback for a given time slot during
the week.

¢ |VR Classic Callback: The IVR handling an inbound call has logic to check for a long waiting time and
offers to call back the caller.

e Preview and Disposition Scenarios: Integrate the Preview and Disposition scenarios to your Callback
application.

Additional User-Originated scenarios are covered in GMS Documentation. See User Originated
Delayed and User Originated Immediate.

Also, consider reading the Universal Routing Voice Call Back White Paper that details two types of
Voice Call Back (VCB) solutions managed by Universal Routing Server (URS):

* Pre-emptive Agent Reservation

¢ Dialing Notifications

Learn about the Callback Templates

Callback provides a set of templates that you can use to create your customized workflow. Templates
are already loaded at the product installation and show up in the Templates panel.
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et Configure Configure

Built-in ORS Use APls
templates : :

services services

Templates include two types of services:

e Built-in services of type builtin that are basic services executed in the Genesys Mobile Services server.

They provide fixed functionality that you can tune only through configuration options in the
Configured services section.

¢ Orchestration Server-based (ORS) services of type ors that implement ORS scenarios. The implemented
scenarios depend on the ORS service configuration.

These templates enable you to create Callback services that provide the GMS APIs.

Note that ors and builtin services may implement some cross-dependencies.

The Callback services are executed in the Orchestration Server and managed in the

Genesys Mobile Services server. See the Scenarios section of the Callback User's
Guide for more information.

Relationship between Configured Services and APl queries

When you create a new {service-execution-name} service in the Configured Services section of

the Service Management Ul, this service is also created in the service. {service-execution-name}
section of your GMS configuration.
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-]
Do Mobile Services  Configured Services

Callback ools « demo ~

© Match interaction €——— {service~execution-name}

+ Create g Delete Q-

t, Configured Services + Add New @) Advanced Parameters i

Name & Value £ Description
Match interaction

s
Originated Immediate Dgpgndgncy Request Parameter - Access code returned as a resu
Preview request-access

Camnlac

B & _access_number Request Parameter - Number to which the user called
™ Office Hours

_phane_number Request Parameter - Phone number of the mobile phone

business-hours where the service request originated

Ml capacity & _service & match-interaction

Capacity “type buitin &—— builtin or ors

The URLs used by the Service API are dependent on the execution name of the service that you have
just created. Services are available at the following URL:

http://<host>:<port>/genesys/1/service/{service-execution-name}

For instance, if you create a service named match-interaction, then {service-execution-name} is
match-interaction and the service is available at:

http://<host>:<port>/genesys/1/service/match-interaction

To use a service, you should start by allocating resources to this service with a create
service request. Note that for some builtin services, this may not be necessary.
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Customized ORS Scenarios

ORS Service

Configuration

To implement a customized ORS scenario, you will need to create an ORS service and select the
Callback template.

Choose your scenario in the list that the template displays. Then, refer to the pages of this chapter
for configuration details and sequence diagrams.

[+] See the list.
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Add Mew Service
ervice Termolk e

CHDEE

Common Default Configuratiorn
Chooss smong the Pollowng

User Depnated Immedale

User Qeagnated Colared

User Termanated Immeadie

User Termanated Deiayhl

User Termanaind Previes

CNat imesadune

Chat Delipea

Advanced Customization

If you are an advanced user of Composer, you can customize the SCXML and VXML of the Classic
Callback sample that includes a Composer project.

Services Cross-Dependencies

According to the services that you plan to use, you may need to create and configure the following
services in the Configured Services panel, even for services of type builtin.

* request-access — Use the request-access template to create a request-access.

* match-interaction — Use the match-interaction template to create a match-interaction service.

The following table presents the builtin services and the ORS scenarios that require one of these
services (or both) before you can start using them.
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Builtin or Scenario name request-access match-interaction

match-interaction

request-interaction

User Terminated Delayed Voice
(notification)

User Terminated Immediate Voice
ORS Service

User Terminated Scheduled Voice

User Terminated Delayed Voice
Agent Preview

Q00000
Q0000

Callback User's Guide 170



Callback Scenarios and Configuration User Terminated Immediate

User Terminated Immediate

Call flow

Genesys

J
Callback ESIN

Customer Agent

App requests a callback

—

User is informed of success

Callback initiates phone call

-

Call is placed over PSTN

|

Call is routed to best resource

B 2

In this scenario, the customer requests an immediate callback, that is, as soon as the agent is
available. This Callback scenario is an outbound voice service that goes through the following stages:

Start Callback

Callback service: Returns a message to expect a call, immediately to the mobile device.

Callback service: Calls the mobile device.

Mobile device: Accepts the call.

Callback service: Identifies that a human has answered the call.

Connect to Agent

* Callback service: Plays treatment until the target is available.
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e Callback service: Reserves target to route call.
¢ Callback service: Routes the call to the target agent.

e Callback service terminates.

Create your Scenario

+ Add New Service
Configure Service
callback v

Service Name

voice-userterm-immediate

Common Default Configurations

User Terminated Immediate v

Cancel Save

In the Admin Ul > Services > Configured Services tab, add a Callback service with User-
Terminated-Immediate as the Common Default Configuration (see Adding a Service for details).

Enter a service name. This name is the callback execution name of your service and will be used in
URLSs to access this service. For example, if you set this name to voice-userterm-immediate, your
service URL will be:
http://host:port/{base-web-application}/service/callback/voice-userterm-immediate

When you add this service and default configuration, many options are automatically populated with
the appropriate default values.

Configuration Options

The table below lists the key options applicable to this scenario. Some options, however, will require
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you to enter your own values. See the Description column in the following table for these details.

Predefined Values

These are the default values, which are automatically populated when using the pre-defined User-
Terminated-Immediate service. You do not need to change these values.

Option Description

Media type of the interaction that the service is expected to handle. This

option enables URS to select an agent who has the appropriate media

capabilities. This is a default value, automatically populated when using

the predefined User-Terminated scenario. You do not need to change this
_media_type=voice value.

This option is mandatory.

True to wait for an agent to connect. If this option is set to true,

the service will wait for the agent to initiate the interaction and to send the notification to
the customer. If the option is set to false, the interaction can start right after the creation of
the service instance. In voice scenarios, the access information will be returned

wait_for_agent = false immediately with the service ID.

This option is mandatory.

True to wait for confirmation of the customer's availability. If this option is
set to true, the service sends a push notification to the customer's
) i device to get confirmation that the customer is ready to have a
_wait_for_user_confirm = conversation with the agent. This scenario is possible only if the
false ~wait for agent option is set to true.

Maximum number of attempts to transfer the call to the agent. If greater
_max_transfer_ to_agent_attemptian 1, set the URS option on_route_error=try other.

=5

This is a default value, automatically populated when using the
predefined User-Terminated scenario. You do not need to change this
value.

 |If this option is set to USERORIGINATED, the customer's device will
initiate the call to get connected to the agent.

 If this option is set to USERTERMINATED, the agent or the system will
initiate the call to contact the customer.

_call_direction =
USERTERMINATED

_userterminated_first_connect_pé&itst party to connect when call direction is set to USERTERMINATED.
= CUSTOMER Set this option to CUSTOMER to call the customer first; set this option to
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Option
_ttl = 86400
_type = ors

_provide_code= false

_use_debug_push_certificate
= false

Description
AGENT to call the agent first.

This option is mandatory.

Duration (in seconds) for which the service will be kept in storage after
the Desired Time is passed (Time To Live).

Once expired, the service is removed from the system. For example, if you want the
callbacks to be visible in the Service Management Ul for one week past the execution time,
then you should set 7 days of Time To Live, which means tt1=604800.

This option is mandatory.

* For Genesys Mobile Services-based services: builtin

e For Orchestration Server-based services: ors

If true, returns a randomly generated code to be used for the
authentication of the user originated (inbound) call.

This option is mandatory.

Use debug certificates for the push notification provider

Additional Required Options

You must enter a string value for the following options:

Option

_route_point= "{Route Point}@{Telephony

Switch}"

Description

Route point from which the system can create a
user-terminated (outbound) call.

This option is mandatory.

Resource group from which access number is to be
allocated.

_resource_group="{name of the resource pool

configured under Transactions/GMS_Resources/

Annex}"

This option is mandatory.

Virtual queue (alias) to which the service request

_urs_virtual_queue = "MyVirtualQueue will be added.

Callback User's Guide

174



Callback Scenarios and Configuration User Terminated Immediate

Option Description

Routing target that specifies the agent/queue
resource that will process this request.

e Starting in 8.5.108.02, you can set multiple
targets in this option, limited to 5.

e Starting in 8.5.114.09, the limit is increased to
15.

Single Target

For a single target, format the string according to the URS
target specification: <Target String>@<StatServer
name>.<Target Type> where Target Type is one of the
following:

* A (Agent)

Agent Place)

AP (

¢ GA (Group of Agents)
GP (Group of Places)
GC (

Campaign Group)

<Target String> can be a skill expression. In that case,
<Target String> must start with '?:".

_target = "MyTarget@StatServer.GA" For example:

e Billing@StatServer.GA—Routes to Agent
Group "Billing".

e ?:English=20&;Loans=2@StatServer.G
A—Routes to any agent matching the skill
expression.

See the Universal Routing Server (URS) documentation for
additional information about URS targets.

Multiple Targets

To set multiple targets, create a JSON-formatted string array of
maximum 15 elements as follows:

[
{

"target": "<Target

String>@<StatServer name>.<Target Type>",
"timeout": "<integer>",
"clear":<true/false>,
"stat to check": "<stat name>",
"stat_operator": "< or >",
"stat value": "1"
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Option Description

e The timeout property specifies how long to
wait in seconds before switching of targets.

e The stat_to_check property can be set to any
of the values supported by the Statistics
parameter passed to the IRD function
SData(Target, Statistics), unless target is
a skill expression. If target is a skill expression,
you must choose one of the following values:

* RStatAgentsReadyvoice—agents ready for
voice media.

* RStatAgentsReady—agents ready for any
media.

* RStatAgentsTotal—agents logged in.

* The stat value property specifies the
threshold for the statistic passed in
stat_to_check. If the condition set by the
combination of stat to check,
stat _operator, and stat value is met, the
current target is skipped, except if it is the last
target of the list.

e |If clear=true, the target will be overridden
when switching to the next target; if
clear=false, the target will be expanded with
the next target.

If you set multiple targets in this option, then
_urs_queued_ttl should be set to the total queue
time across all targets.

more...

By default, these options respectively match the
_urs_prioritization_strategy = WaitForTarget names of the URS strategy and subroutine that you
imported into IRD. If you changed one of these
names, update the corresponding option to reflect
the correct name.

_urs_strategy_update_sub_routine = SetRouteDelay

Customization

All of the options in the Voice-User Terminated section are applicable. You can use the default values,

or you can set your own values. For the route point option, you must select a value from the drop-
down list.

Option Description
Section: Voice-User Terminated
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Option Description

Prefix required to perform a user-terminated

prefix_dial out = 91 (outbound) call from the system.

Section: Voice Treatment

Music file to be played when the service fails to find
the agent in the time specified by the Max Time To
Wait For Agent on the Call parameter. This
parameter accepts a URI as a string or as a JSON-
formatted string. See also
treatment_find_agent_fail = _treatment waiting for agent. By default, this

GMSApplications/<treatmentfilel> option has an empty value and Callback will use
the <GMS installation>/Resources/
SampleTreatments/all agents busy.wav file
available in the callback template.

Music file to play when the customer is waiting for
an agent. This parameter accepts a URI as a string
or as a JSON-formatted string. If you do not set this
option, Callback will use the default <GMS
installation>/Resources/SampleTreatments/
next customer rep.wav file of the callback
template.

_treatment_waiting_for_agent =
GMSApplications/<treatmentfile2>

URI of the music file to play when the customer
answers the callback.

The JSON-formatted strings can be used to specify hints to the
treatment customer connect = RequestApplyTreatment. For example:
GMSApplications/<treatmentfile3> { "file": "file url", "hints":

{"hintl":"value"}}

URI of the music file to play when a call is not
answered by the customer and is forwarded to the
answering machine.

JSON-formatted strings can be used to specify hints to the
RequestApplyTreatment.

The following example makes the music start playing after the
answering machine beep is detected: { "file": "file url",

_treatment_call_failure_answering_machine = i i g e s e L T

GMSApplications/<treatmentfile4>

By default, the value of this option is empty and Callback uses
the <GMS installation>/../Resources/SampleTreatments/
call fail ans_machine.wav file from the Callback template.

To deactivate the play treatment, set the value of this option to

{1}
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In the Voice Treatment section, the GMSApplications/<treatmentfile> path is
applicable if you are using the treatments builtin to the Callback strategy. If you are
not using the builtin treatments, enter the path where you have placed your voice
treatment files.

Sample Request and Response Sequence

Create outbound immediate service

For instance, if your callback service is named voice-userterm-immediate, create the following
POST request:
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Request URL:http://localhost:8080/genesys/1/service/callback/voice-userterm-immediate
Request Method:POST

Status Code:200 OK

Request Headersview source

Accept:*/*

Accept-Encoding:gzip,deflate, sdch

Accept-Language:en-US,en;q=0.8

Connection:keep-alive

Content-Length:660

Content-Type:multipart/form-data; boundary=----WebKitFormBoundaryIWtKHpA86nG3FsWy
Cookie:JSESSIONID=4xjf734hb3pcnh5wd515j6f4; BAYEUX BROWSER=86721lorubxagcqhwOhjl4cpyaqgk?2
gms_user:b16416334828b1d26ef14f329628b55b5a8c631d8928a371a5584722dd7fb673
Host:localhost:8080

Origin:http://localhost:8080

Referer:http://localhost:8080/gmstester/chat.html

User-Agent:Mozilla/5.0 (Windows NT 6.1; WOW64) AppleWebKit/537.36 (KHTML, like Gecko) Chrome/27.0.1453.110 Safari/537.36
Request Payload

------ WebKitFormBoundaryIWtKHpA86nG3FsWy

Content-Disposition: form-data; name="_ customer number"

916504661232
------ WebKitFormBoundaryIWtKHpA86nG3FsWy
Content-Disposition: form-data; name="usr_ customer name"

Bob Markel
------ WebKitFormBoundaryIWtKHpA86nG3FsWy
Content-Disposition: form-data; name="usr reason"

billing question
------ WebKitFormBoundaryIWtKHpA86nG3FsWy
Content-Disposition: form-data; name=" device notification id"

b16416334828b1d26ef141329628b55b5a8c631d8928a371a5584722dd7fb673
------ WebKitFormBoundaryIWtKHpA86nG3FsWy
Content-Disposition: form-data; name=" device os"

------ WebKitFormBoundaryIWtKHpA86nG3FsWy - -
Response Headersview source
Cache-Control:no-cache
Cache-Control:no-store
Content-Type:application/json;charset=UTF-8
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Content-Type:application/json;charset=UTF-8

Date:Tue, 30 Jul 2013 07:02:36 GMT

Expires:Thu, 01 Jan 1970 00:00:00 GMT

Pragma:no-cache
Set-Cookie:JSESSIONID=4ieeqn8sa8nilo2u2ndlbr8a4;Path=/genesys
Transfer-Encoding: chunked

Response Body:

{

" dialog id": "0",

" action": "ConfirmationDialog",

" text": "You will receive the call shortly",

" ok title": "Ok",

" id": "369-f5d50cel-488e-4dbl-a472-8c1560b621b6"
)
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Sequence Diagram

Click the diagram to access full resolution.
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User Terminated Immediate - High Level
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“Wirtialan Stabus: DELETED
[25)viat tor real call to De delete: :I
Resl Call Status: DELETED
[2€] interaction deleted event :l
|27] Send UserEvent AgertDisposition -
- 128]
28] reporting userevent finad »
[P 139) Calback status update
Calilback Status: COMLETED SUCCESS
[ ] SERWICE EXIT :I
| Sustomeravs | | oms | 988 | | ues | e || Ascabestice || MedisScrver |
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Call flow

This Callback scenario is an outbound voice service that goes through the following stages:

Genesys
Callback

Customer

App requests a callback

—

User is informed of success

Start Callback

Callback request

reached front of queue

Callback initiates phone call

Call is placed over PSTN

Callback service: Returns session id to the user.

Callback service: Waits for an agent to be available.

PSTN

Agent

——

Call is routed to best resource

B 2

Callback service: When an agent is available, notifies mobile device that agent is available.

* Next: Mobile device is expected to send connect request to confirm user's availability.

Connect

¢ Callback service: Returns a message to expect a call, to the mobile device.

£
I
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e Callback service: Calls the mobile device.

¢ Mobile device: Accepts the call.

» Callback service: Identifies that a human has answered the call.
e Callback service: Reserves target to route call.

e Callback service: Routes the call to the target.

e Callback service terminates.

Create your Scenario

+ Add New Service
Configure Service
callback v

Service Name

voice-userterm-delay

Common Default Configurations

User Terminated Delayed v

Cancel Save

In the Admin Ul > Services > Configured Services tab, add a Callback service with User-
Terminated-Delayed as the Common Default Configuration (see Adding a Service for details).

Enter a service name. This name is the callback execution name of your service and will be used in
URLSs to access this service. For example, if you set this name to voice-userterm-delay, your
service URL will be:

http://host:port/genesys/1/service/callback/voice-userterm-delay

When you add this service and default configuration, many options are automatically populated with
the appropriate default values.
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Configuration Options

The table below lists the key options applicable to this scenario. Some options, however, will require
you to enter your own values. See the Comments column in the following table for these details.

Pre-defined Values

The following options are the default values, which are automatically populated when selecting the
pre-defined User-Terminated-Delayed service. You do not need to change their values.

Option

_call_direction =
USERTERMINATED

_media_type = voice

_wait_for_agent = true

_wait_for_user_confirm = true

_ttl = 86400

Description

This is a default value, automatically populated when using the
predefined User-Terminated scenario. You do not need to change this
value.

* If this option is set to USERORIGINATED, the customer's device will
initiate the call to get connected to the agent.

 If this option is set to USERTERMINATED, the agent or the system will
initiate the call to contact the customer.

Media type of the interaction that the service is expected to handle. This
option enables URS to select an agent who has the appropriate media
capabilities. This is a default value, automatically populated when using
the predefined User-Terminated scenario. You do not need to change this
value.

This option is mandatory.

True to wait for an agent to connect. If this option is set to true,

the service will wait for the agent to initiate the interaction and to send the notification to
the customer. If the option is set to false, the interaction can start right after the creation of
the service instance. In voice scenarios, the access information will be returned
immediately with the service ID.

This option is mandatory.

True to wait for confirmation of the customer's availability. If this option is
set to true, the service sends a push notification to the customer's
device to get confirmation that the customer is ready to have a
conversation with the agent. This scenario is possible only if the
~wait for agent option is set to true.

Duration (in seconds) for which the service will be kept in storage after
the Desired Time is passed (Time To Live).
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Option Description

Once expired, the service is removed from the system. For example, if you want the
callbacks to be visible in the Service Management Ul for one week past the execution time,
then you should set 7 days of Time To Live, which means tt1=604800.

This option is mandatory.

* For Genesys Mobile Services-based services: builtin

_type =ors e For Orchestration Server-based services: ors

First party to connect when call direction is set to USERTERMINATED.
Set this option to CUSTOMER to call the customer first; set this option to

_userterminated_ﬁrst_connect_pép('gj\IT o Gl W et i,
= CUSTOMER This option is mandatory.

Additional Required Options

You must configure the following options. See the Universal Routing Server (URS) documentation for
additional information about URS targets.
Option Description

Routing target that specifies the agent/queue
resource that will process this request.

e Starting in 8.5.108.02, you can set multiple
targets in this option, limited to 5.

e Starting in 8.5.114.09, the limit is increased to
15.

Single Target

For a single target, format the string according to the URS
target specification: <Target String>@<StatServer

target="MyTarget@StatServer.GA" name>.<Target Type> where Target Type is one of the
- following:

e A (Agent)

e AP (Agent Place)

e GA (Group of Agents)
e GP (Group of Places)
e GC (Campaign Group)

<Target String> can be a skill expression. In that case,
<Target String> must start with '?:".
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Option Description
For example:

e Billing@StatServer.GA—Routes to Agent
Group "Billing".

e ?:English=20&;Loans=2@StatServer.G
A—Routes to any agent matching the skill
expression.

See the Universal Routing Server (URS) documentation for
additional information about URS targets.

Multiple Targets

To set multiple targets, create a JSON-formatted string array of
maximum 15 elements as follows:

[

{

"target": "<Target

String>@<StatServer name>.<Target Type>",
"timeout": "<integer>",
"clear":<true/false>,
"stat to check": '"<stat name>",
“stat operator": "< or >",
"stat value": "1"

]

e The timeout property specifies how long to
wait in seconds before switching of targets.

e The stat to check property can be set to any
of the values supported by the Statistics
parameter passed to the IRD function
SData(Target, Statistics), unless target is
a skill expression. If target is a skill expression,
you must choose one of the following values:

* RStatAgentsReadyvoice—agents ready for
voice media.

» RStatAgentsReady—agents ready for any
media.

» RStatAgentsTotal—agents logged in.

e The stat value property specifies the
threshold for the statistic passed in
stat to check. If the condition set by the
combination of stat to check,
stat operator, and stat value is met, the
current target is skipped, except if it is the last
target of the list.

e If clear=true, the target will be overridden
when switching to the next target; if
clear=false, the target will be expanded with
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Option

_urs_virtual_queue="MyVirtualQueue"

_urs_prioritization_strategy = WaitForTarget

_urs_strategy_update_sub_routine = SetRouteDelay

Customization

Description

the next target.

If you set multiple targets in this option, then
~urs_queued ttl should be set to the total queue
time across all targets.

more...

Virtual queue (alias) to which the service request
will be added.

By default, these options respectively match the
names of the URS strategy and subroutine that you
imported into IRD. If you changed one of these
names, update the corresponding option to reflect
the correct name.

The options shown here and all of the options of the Voice User Terminated section are applicable for
this scenario. You can use the default values, or you can set your own values. For the route point
option, you must select a value from the drop-down list in the Ul.

Option

Description

Section: Voice User Terminated

_on_user_confirm_timeout=CONNECT-ANYWAY

_prefix_dial_out=91

_route_point={Route Point}@{Telephony Switch}

Selects the action to perform if the user does not
submit his or her confirmation in response to the
push notification.

e CONNECT-ANYWAY will continue with the call.

e CANCEL cancels the service request.

Prefix required to perform a user-terminated
(outbound) call from the system.

Route point from which the system can create a
user-terminated (outbound) call.

This option is mandatory.

Section: Voice Treatment
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Option

_treatment_call_failure_answering_machine

_treatment_find_agent fail =
GMSApplications/<treatmentfilel>

_treatment_waiting_for_agent =
GMSApplications/<treatmentfile2>

_treatment_customer_connect =
GMSApplications/<treatmentfile3>

Description

URI of the music file to play when a call is not
answered by the customer and is forwarded to the
answering machine.

JSON-formatted strings can be used to specify hints to the
RequestApplyTreatment.

The following example makes the music start playing after the
answering machine beep is detected: { "file": "file url",
"hints":{ "am-beep-detection":"on"} }

By default, the value of this option is empty and Callback uses
the <GMS installation>/../Resources/SampleTreatments/
call fail ans_machine.wav file from the Callback template.

To deactivate the play treatment, set the value of this option to
{1}

Music file to be played when the service fails to find
the agent in the time specified by the Max Time To
Wait For Agent on the Call parameter. This
parameter accepts a URI as a string or as a JSON-
formatted string. See also

_treatment waiting for agent. By default, this
option has an empty value and Callback will use
the <GMS installation>/Resources/
SampleTreatments/all agents busy.wav file
available in the callback template.

Music file to play when the customer is waiting for
an agent. This parameter accepts a URI as a string
or as a JSON-formatted string. If you do not set this
option, Callback will use the default <GMS
installation>/Resources/SampleTreatments/
next customer rep.wav file of the callback
template.

URI of the music file to play when the customer
answers the callback.

The JSON-formatted strings can be used to specify hints to the
RequestApplyTreatment. For example:

{ "file": "file url", "hints":
{"hintl":"value"}}

In the Voice Treatment section, the GMSApplications/<treatmentfile> path is
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applicable if you are using the treatments builtin to the Callback strategy. If you are
not using the builtin treatments, enter the path where you have placed your voice
treatment files.

Sample Request and Response Sequence

Create outbound delay service

For instance, if your callback service is named voice-userterm-delay, create the following POST
request:
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Request URL:http://localhost:8080/genesys/1/service/callback/voice-userterm-delay
Request Method:POST

Status Code:200 OK

Request Headersview source

Accept:*/*

Accept-Encoding:gzip,deflate, sdch

Accept-Language:en-US,en;q=0.8

Connection:keep-alive

Content-Length:662

Content-Type:multipart/form-data; boundary=----WebKitFormBoundaryABpcDouIWQ5inBW1l
Cookie:JSESSIONID=4ieeqn8sa8nilo2u2ndlbr8a4; BAYEUX BROWSER=86721lorubxagcqhwdhjl4cpyaqk2
gms_user:b16416334828b1d26ef14f329628b55b5a8c631d8928a371a5584722dd7fb673
Host:localhost:8080

Origin:http://localhost:8080

Referer:http://localhost:8080/gmstester/chat.html

User-Agent:Mozilla/5.0 (Windows NT 6.1; WOW64) AppleWebKit/537.36 (KHTML, like Gecko) Chrome/27.0.1453.110 Safari/537.36
Request Payload

------ WebKitFormBoundaryABpcDouIWQ5inBW1

Content-Disposition: form-data; name="_ customer number"

916504661232
------ WebKitFormBoundaryABpcDouIWQ5inBW1
Content-Disposition: form-data; name="usr_ customer name"

Bob Markel
------ WebKitFormBoundaryABpcDouIWQ5inBW1
Content-Disposition: form-data; name="usr reason"

billing question
------ WebKitFormBoundaryABpcDouIWQ5inBW1
Content-Disposition: form-data; name=" device notification id"

b16416334828b1d26ef141329628b55b5a8c631d8928a371a5584722dd7fb673
------ WebKitFormBoundaryABpcDouIWQ5inBWL
Content-Disposition: form-data; name=" device os"

------ WebKitFormBoundaryABpcDouIWQ5inBW1- -
Response Headersview source
Cache-Control:no-cache
Cache-Control:no-store
Content-Type:application/json;charset=UTF-8
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Content-Type:application/json;charset=UTF-8

Date:Tue, 30 Jul 2013 07:04:31 GMT

Expires:Thu, 01 Jan 1970 00:00:00 GMT

Pragma:no-cache
Set-Cookie:JSESSIONID=1b81btxjbrblwybz5a93i24io0;Path=/genesys
Transfer-Encoding: chunked

Response Body:

{
" id": "369-b100700a-4ce8-48f7-blb0-1944b12359h9",
" text": "We will notify you when agent is available"
}
Push notification data:
{
" dialog id": "0",
" action": "ConfirmationDialog",
" text": "You will receive the call shortly",
" ok title": "Ok",
" id": "369-b100700a-4ce8-48f7-b1lb0-1944b12359h9"
}
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Connect (user confirmation)

Callback User's Guide 193



Callback Scenarios and Configuration

User Terminated Delayed

Request URL:http://localhost:8080/genesys/1/service/369-b100700a-4ce8-48f7-b1lb0-1944b12359b9/connect

Request Method:POST

Status Code:200 OK

Request Headersview source
Accept:*/*
Accept-Encoding:gzip,deflate, sdch
Accept-Language:en-US,en;q=0.8
Connection:keep-alive
Content-Length:44

Content-Type:multipart/form-data; boundary=----WebKitFormBoundaryNY841d7wm70HB9fp
Cookie:JSESSIONID=1b81btxjbrblwybz5a93i24i0; BAYEUX BROWSER=86721orubxagcqhwdhjl4cpyaqk?2
gms_user:b16416334828b1d26ef14f329628b55b5a8c631d8928a371a5584722dd7fb673

Host:localhost:8080
Origin:http://localhost:8080
Referer:http://localhost:8080/gmstester/chat.html

User-Agent:Mozilla/5.0 (Windows NT 6.1; WOW64) AppleWebKit/537.36 (KHTML, like Gecko) Chrome/27.0.1453.110 Safari/537.36

Request Payload

------ WebKitFormBoundaryNY841d7wm70HB9fp- -
Response Headersview source
Cache-Control:no-cache
Cache-Control:no-store

Content-Length:26
Content-Type:application/json;charset=UTF-8
Content-Type:application/json;charset=UTF-8
Date:Tue, 30 Jul 2013 07:04:35 GMT
Expires:Thu, 01 Jan 1970 00:00:00 GMT
Pragma:no-cache
Set-Cookie:JSESSIONID=mjjvtphwb8lpce7io23ggxcu;Path=/genesys

Response Body:

{

" dialog_id": "e",

" action": "ConfirmationDialog",

" text": "You will receive the call shortly",

" ok title": "Ok",

" id": "369-b100700a-4ce8-48f7-blb0-1944b12359b9"
)
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Sequence Diagram

Click the diagram to access full resolution.
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User Terminated Scheduled Scenarios
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Overview

This page describes two Callback scenarios:

¢ User Terminated Scheduled, also known as User Terminated at Desired Time.

¢ User Terminated Delayed Scheduled, also known as User Terminated Delayed at Desired Time.

The _wait for_agent option selects between Delayed ( wait for agent=true) and Not Delayed ( wait for agent=false). The scenarios go
through the following stages:

Find Available Slot

e Mobile device: Request for availability at the desired time.
e Availability API: Provides available time slots during the open business hours encompassing the desired time.

¢ Mobile device: Starts Callback with user selected available time slot.

Start Callback

Start Callback Not Delayed Start Callback Delayed
_wait_for_agent = false _wait_for_agent = true
» Callback service: Returns session id to the user. » Callback service: Returns session id to the user.
* Callback service: Starts execution at a time determined by the scheduled * Callback service: Starts execution at a time determined by the scheduled
time minus the current EWT time minus the current EWT
* Callback service: Initiates the outbound call after execution starts. e Callback service: Waits for an agent to be available.
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Start Callback Not Delayed Start Callback Delayed

_wait_for_agent = false _wait_for_agent = true

e Callback service: When an agent is available, notifies mobile device that
agent is available.

Confirm user's availability and Connect

e Callback service: Returns a message to expect a call, to the mobile
device.

» Callback service: Calls the mobile device.

* Mobile device: Accepts the call.

e Callback service: Identifies that a human has answered the call.
e Callback service: Reserves target to route call.

e Callback service: Routes the call to the target.

e Callback service terminates.

Create your Scenario

In the Service Management Ul, select Callback and Mobile Engagement™' and in the Configured Services tab, add a Callback service with
User-Terminated (Immediate or Delayed) as the Common Default Configuration (see Adding a Service for details).

Enter a service name. This is the callback execution name of your service that will be used in URLs to access this service. For example, if you set this
name to user-scheduled, your service URL will be:
http://host:port/genesys/1/service/callback/user-scheduled
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Configuration

When you add a service and default configuration, many options are automatically populated with the appropriate default values. Refer to the User
Terminated Delayed and the User Terminated Immediate scenarios for further details. You will also need to create and configure an Office Hours
service that you will use to configure the business hours service option in your callback scenario: No results

The _wait_for_agent option selects between Delayed (_ wait for agent=true) and not Delayed ( wait for agent=false). If you choose a User
Terminated Delayed scenario, the outbound call will not occur until an agent is available.
* User Terminated Scheduled scenario:
1. Start the callback service at the scheduled time minus the current EWT defined for the _target.

2. The outbound call occurs immediately after starting the service.

e User Terminated Delayed Scheduled
1. Start the callback service at the scheduled time minus the current EWT defined for the _target.

2. Wait for the time dial notification from URS before making the outbound call.

User Terminated Scheduled scenarios might create a longer delay between the time of the outbound call and being connected to an agent if the EWT
is not accurate.

Sample Request and Response Sequence

Get timeslots

Request URL:http://192.168.184.128:8080/genesys/1/service/callback/user-scheduled/
availability?timestamp=2014-07-30T14:00:00.000Z& =1406647599350

Request Method:GET

Status Code:200 OK

Request Headersview source

Accept:application/json, text/javascript, */*; g=0.01
Accept-Encoding:gzip,deflate, sdch
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Accept-Language:en-US,en;q=0.8

Cache-Control:no-cache
Connection:keep-alive

Cookie:JSESSIONID=1mmvrcO6utu9lls9azezm677ns; BAYEUX BROWSER=db7alsl3ad7b0Oxvghy78iy6yl7cq
Host:192.168.184.128:8080

Pragma:no-cache

Referer:http://192.168.184.128:8080/genesys/admin/js/sample/cb/index.html

User-Agent:Mozilla/5.0 (Windows NT 6.1; WOW64) AppleWebKit/537.36 (KHTML, like Gecko) Chrome/31.0.1650.57 Safari/537.36

Query String Parametersview sourceview URL encoded

timestamp:2014-07-30T14:00:00.000Z

:1406647599350

Response Headersview source

Cache-Control:no-cache
Cache-Control:no-store

Content-Type:application/json;charset=UTF-8

Date:Wed, 30 Jul 2014 14:36:01 GMT

Pragma:no-cache

Transfer-Encoding: chunked

Response Body:

{
"2014-07-30T06:00:
"2014-07-30T07:00:
"2014-07-30T08:00:
"2014-07-30T09:00:
"2014-07-30T10:00:
"2014-07-30T11:00:
"2014-07-30T12:00:

Create outbound scheduled delay service

Request URL:http://192.168.184.128:8080/genesys/1/service/callback/user-scheduled

Request Method:POST
Status Code:200 OK

.000Z":
.000Z":
.000Z":
.000Z":
.000Z":
.000Z":
.000Z":

Request Headersview source

Accept:application/json, text/javascript, */*; q=0.01

100,
100,
100,
100,
100,
100,
100,

Accept-Encoding:gzip,deflate, sdch

Accept-Language:en-US,en;q=0.8

Cache-Control:no-cache
Connection:keep-alive
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Content-Length:915

Content-Type:multipart/form-data;boundary=AaB03x;charset=UTF-8
Cookie:JSESSIONID=1mmvrcO6utu9lls9azezm677ns; BAYEUX BROWSER=db7alsl13ad7b0Oxvghy78iy6yl7cq
gms_user:jdoe desktop

Host:192.168.184.128:8080

Origin:http://192.168.184.128:8080

Pragma:no-cache

Referer:http://192.168.184.128:8080/genesys/admin/js/sample/cb/index.html
User-Agent:Mozilla/5.0 (Windows NT 6.1; WOW64) AppleWebKit/537.36 (KHTML, like Gecko) Chrome/31.0.1650.57 Safari/537.36
Request Payload

- -AaB03x

Content-Disposition: form-data; name="first name"

John
--AaB0O3x
Content-Disposition: form-data; name="last name"

Doe
- -AaB0O3x
Content-Disposition: form-data; name=" provide code"

false
- -AaB03x
Content-Disposition: form-data; name=" desired time"

2014-07-30T15:00:00.000Z
- -AaB03x
Content-Disposition: form-data; name=" customer number"

5115
- -AaB0O3x
Content-Disposition: form-data; name="location_ lat"

37.8197
- -AaB03x
Content-Disposition: form-data; name="location long"

-122.4786
- -AaB03x
Content-Disposition: form-data; name=" device os"

comet
- -AaB0O3x
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Content-Disposition:

USERTERMINATED
--AaB03x

Content-Disposition:

true
--AaB03x

Content-Disposition:

true
- -AaB03x

Content-Disposition:

voice
- -AaB03x

form-data;

form-data;

form-data;

form-data;

Response Headersview source
Access-Control-Allow-Credentials:true
Access-Control-Allow-0rigin:http://192.168.184.128:8080
Access-Control-Expose-Headers:
Cache-Control:no-cache

Cache-Control:no-store

Content-Type:application/json;charset=UTF-8
Date:Wed, 30 Jul 2014 14:36:16 GMT

Pragma:no-cache

Transfer-Encoding: chunked

Response Body:

name=

name=

name=

name=

~call direction"

~wait for agent"

~wait for user confirm"

_media type"

{" id":"440-96984577-a614-4f18-b80e-aaf91e78b178"}

Push notification data:

{

" dialog id": "e",

" action": "ConfirmationDialog",

" text": "You will receive the call shortly",

" ok title": "Ok",

" 1d":"440-96984577-a614-4f18-b80e-aaf91e78b178"
}
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Connect (user confirmation)

Request URL:http://localhost:8080/genesys/1/service/440-96984577-a614-4f18-b80e-aaf91e78b178/connect
Request Method:POST

Status Code:200 OK

Request Headersview source

Accept:*/*

Accept-Encoding:gzip,deflate, sdch

Accept-Language:en-US,en;q=0.8

Connection:keep-alive

Content-Length:44

Content-Type:multipart/form-data; boundary=----WebKitFormBoundaryNY841d7wm70oHB9fp
Cookie:JSESSIONID=1b81btxjbrblwybz5a93i24io0; BAYEUX BROWSER=86721orubxagcqhwOhjl4cpyaqk2
gms_user:b16416334828b1d26ef14f329628b55b5a8c631d8928a371a5584722dd7fb673
Host:localhost:8080

Origin:http://localhost:8080

Referer:http://localhost:8080/gmstester/chat.html

User-Agent:Mozilla/5.0 (Windows NT 6.1; WOW64) AppleWebKit/537.36 (KHTML, like Gecko) Chrome/27.0.1453.110 Safari/537.36
Request Payload

------ WebKitFormBoundaryNY841d7wm70HBOfp- -

Response Headersview source

Cache-Control:no-cache

Cache-Control:no-store

Content-Length:26

Content-Type:application/json;charset=UTF-8

Content-Type:application/json;charset=UTF-8

Date:Tue, 30 Jul 2013 07:04:35 GMT

Expires:Thu, 01 Jan 1970 00:00:00 GMT

Pragma:no-cache

Set-Cookie:JSESSIONID=mjjvtphwb8lpce7io23ggxcu;Path=/genesys

Response Body:

{

" dialog id": "0",

" action": "ConfirmationDialog",

" text": "You will receive the call shortly",

" ok title": "Ok",

" id": "440-96984577-a614-4f18-b80e-aaf91e78b178"
}
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Sequence Diagram

Click on the diagram to access full resolution.
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User Terminated Delayed Agent Preview

Call flow
Genesys PSTN \ J
Callback
Customer Agent
App requests a callback
Available times sent to user
User chooses available time
Callback request
reached front of queue Best agent chosen and alerted
with callback information
Agent initiated call is placed
over PSTN
Customer receives call _
| I

This Callback scenario is an outbound service that goes through the following stages:
Start Callback

¢ Callback service: Returns session id to the user.

¢ Callback service: Waits for an agent to be available.

* Callback service: Reserves agent.

e Callback service: Sends preview invite to agent.

¢ Agent Desktop: Displays customer attached data with actions Accept and Cancel.

e Agent: Accepts the invitation by clicking the Accept button.

e Callback service: Receives the agent acceptance request.

e Callback service: Calls the mobile device from reserved agent's DN.

* Mobile device: Accepts the call.
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¢ Callback service: Waits for interaction to be deleted.

¢ Callback service: Terminates after interaction is deleted.

Create your Scenario

+ Add New Service
Configure Service
callback v

Service Name

user_term_preview

Common Default Configurations

Samples v

User Originated Immediate
User Originated Delayed
User Terminated Immediate
User Terminated Delayed

User Terminated Preview
Chat Immediate

Chat Delayed
Samples

In the Admin Ul > Services > Configured Services tab, add a Callback service with User
Terminated-Preview as the Common Default Configuration (see Adding a Service for de

Enter a service name. This name is the callback execution name of your service and will be L
URLs to access this service. For example, if you set this name to user_term preview, yours
URL will be:
http://host:port/{base-web-application}/service/callback/user term preview

When you add this service and default configuration, many options are automatically popula
the appropriate default values.
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Configuration Options

Predefined Values

These are the default values, which are automatically populated when using the pre-defined User-
Terminated-Immediate service. You do not need to change these values.

Option

_media_type=voice

_wait_for_agent = true

_wait_for_user_confirm =
false

_agent_preview = true

_call_direction =
USERTERMINATED

Description

Media type of the interaction that the service is expected to handle. This
option enables URS to select an agent who has the appropriate media
capabilities. This is a default value, automatically populated when using
the predefined User-Terminated scenario. You do not need to change this
value.

This option is mandatory.

True to wait for an agent to connect. If this option is set to true,

the service will wait for the agent to initiate the interaction and to send the notification to
the customer. If the option is set to false, the interaction can start right after the creation of
the service instance. In voice scenarios, the access information will be returned
immediately with the service ID.

This option is mandatory.

True to wait for confirmation of the customer's availability. If this option is
set to true, the service sends a push notification to the customer's
device to get confirmation that the customer is ready to have a
conversation with the agent. This scenario is possible only if the
~wait for agent option is set to true.

Enables Agent Preview. If set to true, the Preview Dialog with caller
information is displayed to the agent.

This is a default value, automatically populated when using the
predefined User-Terminated scenario. You do not need to change this
value.

* If this option is set to USERORIGINATED, the customer's device will
initiate the call to get connected to the agent.

 If this option is set to USERTERMINATED, the agent or the system will
initiate the call to contact the customer.
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Option Description

Duration (in seconds) for which the service will be kept in storage after

the Desired Time is passed (Time To Live).

Once expired, the service is removed from the system. For example, if you want the

callbacks to be visible in the Service Management Ul for one week past the execution time,
_ttl = 86400 then you should set 7 days of Time To Live, which means _tt1=604800.

This option is mandatory.

» For Genesys Mobile Services-based services: builtin

_type = ors e For Orchestration Server-based services: ors

If true, returns a randomly generated code to be used for the
authentication of the user originated (inbound) call.

provide code= false i .
- - This option is mandatory.

Enables CPD. If this option is set to true, CPD will be performed on a
callback made to the customer.

e |If CPD results in a human or silence detection, the call will be routed
to the agent.

e |If a fax is detected, the call will be disconnected and marked

_cpd_enable = false complete.

e If an answering machine is detected, the answering machine
treatment is played.

This option is mandatory.

. Use debug certificates for the push notification provider
_use_debug_push_certificate

= false

Additional Required Options

You must enter a string value for the following options:

Option Description
_route_point= "{Route Point}@{Telephony Route point from which the system can create a
Switch}" user-terminated (outbound) call.
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Option Description

This option is mandatory.

Virtual queue (alias) to which the service request

. , will be added.
_urs_virtual_queue = "MyVirtualQueue"

Resource group from which access number is to be

allocated.
_resource_group="{name of the resource pool

configured under Transactions/GMS_Resources/

Annex}" This option is mandatory.

Routing target that specifies the agent/queue
resource that will process this request.

e Starting in 8.5.108.02, you can set multiple
targets in this option, limited to 5.

e Starting in 8.5.114.09, the limit is increased to
15.

Single Target

For a single target, format the string according to the URS
target specification: <Target String>@<StatServer
name>.<Target Type> where Target Type is one of the
following:

¢ A (Agent)

Agent Place)

_target = "MyTarget@StatServer.GA"

AP (

* GA (Group of Agents)
GP (Group of Places)
GC (

J Campaign Group)
<Target String> can be a skill expression. In that case,

<Target String> must start with '?:".
For example:

e Billing@StatServer.GA—Routes to Agent
Group "Billing".

e ?:English=20&;Loans=2@StatServer.G
A—Routes to any agent matching the skill
expression.

See the Universal Routing Server (URS) documentation for
additional information about URS targets.

Multiple Targets

To set multiple targets, create a JSON-formatted string array of
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Option Description

maximum 15 elements as follows:

[
{

"target": "<Target

String>@<StatServer name>.<Target Type>",
"timeout": "<integer>",
"clear":<true/false>,
"stat to check": "<stat name>",
"stat operator": "< or >",
"stat value": "1"

]

* The timeout property specifies how long to
wait in seconds before switching of targets.

e The stat to check property can be set to any
of the values supported by the Statistics
parameter passed to the IRD function
SData(Target, Statistics), unless target is
a skill expression. If target is a skill expression,
you must choose one of the following values:

* RStatAgentsReadyvoice—agents ready for
voice media.

* RStatAgentsReady—agents ready for any
media.

* RStatAgentsTotal—agents logged in.

* The stat value property specifies the
threshold for the statistic passed in
stat_to_check. If the condition set by the
combination of stat to check,
stat operator, and stat value is met, the
current target is skipped, except if it is the last
target of the list.

e |If clear=true, the target will be overridden
when switching to the next target; if
clear=false, the target will be expanded with
the next target.

If you set multiple targets in this option, then
_urs_queued ttl should be set to the total queue
time across all targets.

more...
urs_prioritization_strategy = WaitForTarget By default, these options respectively rr_latch the

- - - names of the URS strategy and subroutine that you

_urs_strategy_update_sub_routine = SetRouteDelay imported into IRD. If you changed one of these

names, update the corresponding option to reflect
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Option

Customization

Description

the correct name.

All of the options in the Voice-User Terminated section are applicable. You can use the default values,
or you can set your own values. For the route point option, you must select a value from the drop-

down list.

Option

Description

Section: Voice-User Terminated

_prefix_dial_out = 91

_userterminated_first_connect_party = CUSTOMER

_agent_preview_allow_reject = false

_agent_preview_timeout = 30

_prefix_dial_out

First party to connect when call direction is set
to USERTERMINATED. Set this option to CUSTOMER to
call the customer first; set this option to AGENT to
call the agent first.

This option is mandatory.

Allows the agent to reject the call in the preview
dialog.

e If the option is set to 0, the preview dialog does
not display the reject button.

e If the option is greater than 0, its value
determines the number of times that an agent
can reject the service request; the reject option
will not be displayed to the next agent.

Duration in seconds that the agent has to preview
the callback information and submit a reply. The
Preview dialog will automatically close after this
timeout and submit a reject from the agent. In this
scenario, the call will go back in the queue. During
this period, the agent is reserved for the Callback
interaction and is not an eligible target for other
interactions; therefore, Genesys recommends to
evaluate carefully when extending this timeout
beyond 30 seconds (default).

Section: Voice Treatment

_treatment_find_agent fail =
GMSApplications/<treatmentfile1>

Music file to be played when the service fails to find
the agent in the time specified by the Max Time To
Wait For Agent on the Call parameter. This
parameter accepts a URI as a string or as a JSON-
formatted string. See also

_treatment waiting for agent. By default, this
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Option Description

option has an empty value and Callback will use
the <GMS installation>/Resources/
SampleTreatments/all agents busy.wav file
available in the callback template.

Music file to play when the customer is waiting for
an agent. This parameter accepts a URI as a string
or as a JSON-formatted string. If you do not set this
option, Callback will use the default <GMS
installation>/Resources/SampleTreatments/
next customer rep.wav file of the callback
template.

_treatment_waiting_for_agent =
GMSApplications/<treatmentfile2>

URI of the music file to play when the customer
answers the callback.

The JSON-formatted strings can be used to specify hints to the
treatment customer connect = RequestApplyTreatment. For example:
GMSApplications/<treatmentfile3> { "file": "file url", "hints":

{"hint1":"value"}}

URI of the music file to play when a call is not
answered by the customer and is forwarded to the
answering machine.

JSON-formatted strings can be used to specify hints to the
RequestApplyTreatment.

The following example makes the music start playing after the
answering machine beep is detected: { "file": "file url",

_treatment_call_failure_answering_machine = "hints":{ "am-beep-detection”:"on"} }

GMSApplications/<treatmentfile4 >

By default, the value of this option is empty and Callback uses
the <GMS installation>/../Resources/SampleTreatments/
call fail ans machine.wav file from the Callback template.

To deactivate the play treatment, set the value of this option to

{r

In the Voice Treatment section, the GMSApplications/<treatmentfile> path is
applicable if you are using the treatments builtin to the Callback strategy. If you are
not using the builtin treatments, enter the path where you have placed your voice
treatment files.
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Sample Request and Response Sequence

Request

URL:http://192.168.184.128:8080/genesys/1/service/callback/user term preview
Request Method:POST

Status Code:200 OK

Request Headersview source

Accept:application/json, text/javascript, */*; g=0.01
Accept-Encoding:gzip,deflate, sdch

Accept-Language:en-US,en;q=0.8

Cache-Control:no-cache

Connection:keep-alive

Content-Length:513
Content-Type:multipart/form-data;boundary=AaB03x;charset=UTF-8
Cookie:JSESSIONID=1q2r9rzpkelzas5uh2lvrubqd; BAYEUX BROWSER=c397-1v94320p0gfmni2a3d4xsl2mv
gms_user:jdoe desktop

Host:192.168.184.128:8080

Origin:http://192.168.184.128:8080

Pragma:no-cache
Referer:http://192.168.184.128:8080/genesys/admin/js/sample/cb/index.html
User-Agent:Mozilla/5.0 (Windows NT 6.1; WOW64) AppleWebKit/537.36 (KHTML, like Gecko) Chrome/
31.0.1650.57 Safari/537.36

Request Payload

- -AaB0O3x

Content-Disposition: form-data; name="first name"

John
- -AaB03x
Content-Disposition: form-data; name="last name"

Doe
- -AaB0O3x
Content-Disposition: form-data; name=" provide code"

false
- -AaB03x
Content-Disposition: form-data; name="_ customer number"

5125
--AaB03x
Content-Disposition: form-data; name="location lat"

37.8197
- -AaB03x
Content-Disposition: form-data; name="location long"

-122.4786
- -AaB03x
Content-Disposition: form-data; name=" device os"

comet
--AaB03x
Content-Disposition: form-data; name=

_agent preview data"

FieldlVal, Field2Val,Field3Val,Field4Val
--AaB03x
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Response

HTTP/1.1 200 OK
{" dialog id":"0"," action":"ConfirmationDialog"," text":"You will receive a call from the
agent"," ok title":"Ok"," id":"440-f86e4dff-2c00-4753-a876-5b52354566de"}

Sequence Diagram

Click on the diagram to access full resolution. For a more detailed diagram, click here.
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User Terminated Agent First with Implicit
Reservation

The Callback service first calls an agent with Implicit Reservation Information (ISCC) and starts an
outbound consultation call with the customer. Then, Callback merges the two calls.

Call flow

This Callback scenario is an outbound service that goes through the following stages:

Start Callback

e Callback Service: Creates a call from trunk to the agent.

e Callback Service: Holds the call (implicit reservation).

e Callback Service: Starts a consultation call from trunk to the customer.
e Callback Service: Waits for the customer to accept the call.

¢ Callback service: Transfers and merges the held interaction with the consultation call to connect the
agent with the customer.

Create your Scenario

In the Admin Ul > Services > Configured Services tab, add a Callback service with User-
Terminated-Immediate as the Common Default Configuration (see Adding a Service for details).

Enter a service name. This name is the callback execution name of your service and will be used in
URLs to access this service. For example, if you set this name to agent-first, your service URL will
be:

http://host:port/{base-web-application}/service/callback/agent-first

When you add this service and default configuration, many options are automatically populated with
the appropriate default values.
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Configuration Options

Predefined Values

These are the default values, which are automatically populated when using the pre-defined User-
Terminated-Immediate service. You do not need to change these values.

Option

_media_type=voice

_wait_for_agent = true

_wait_for_user_confirm =
false

_agent_preview = false

_call_direction =
USERTERMINATED

_ttl = 86400

Description

Media type of the interaction that the service is expected to handle. This
option enables URS to select an agent who has the appropriate media
capabilities. This is a default value, automatically populated when using
the predefined User-Terminated scenario. You do not need to change this
value.

This option is mandatory.

True to wait for an agent to connect. If this option is set to true,

the service will wait for the agent to initiate the interaction and to send the notification to
the customer. If the option is set to false, the interaction can start right after the creation of
the service instance. In voice scenarios, the access information will be returned
immediately with the service ID.

This option is mandatory.

True to wait for confirmation of the customer's availability. If this option is
set to true, the service sends a push notification to the customer's
device to get confirmation that the customer is ready to have a
conversation with the agent. This scenario is possible only if the
~wait for agent option is set to true.

Enables Agent Preview. If set to true, the Preview Dialog with caller
information is displayed to the agent.

This is a default value, automatically populated when using the
predefined User-Terminated scenario. You do not need to change this
value.

 |f this option is set to USERORIGINATED, the customer's device will
initiate the call to get connected to the agent.

 If this option is set to USERTERMINATED, the agent or the system will
initiate the call to contact the customer.

Duration (in seconds) for which the service will be kept in storage after
the Desired Time is passed (Time To Live).
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Option Description

Once expired, the service is removed from the system. For example, if you want the
callbacks to be visible in the Service Management Ul for one week past the execution time,
then you should set 7 days of Time To Live, which means _tt1=604800.

This option is mandatory.

e For Genesys Mobile Services-based services: builtin

_type = ors e For Orchestration Server-based services: ors

If true, returns a randomly generated code to be used for the
authentication of the user originated (inbound) call.

provide code= false . .
- - This option is mandatory.

Enables CPD. If this option is set to true, CPD will be performed on a
callback made to the customer.

e |f CPD results in a human or silence detection, the call will be routed
to the agent.

e If a fax is detected, the call will be disconnected and marked

_cpd_enable = false complete.

e |If an answering machine is detected, the answering machine
treatment is played.

This option is mandatory.

Use debug certificates for the push notification provider
_use_debug_push_certificate K P P

= false

Additional Required Options
You must enter a string value for the following options:

Option Description

If true, enables the call dialing from the trunk group
(configured in the trunk group option) in the
following user-terminated scenario. When the trunk
_agent _first_via_tg=true group dials the call to the customer, it makes a call
to the agent first where the agent preview mode is
disabled, and the agent can consult the call to the
customer. Finally, the agent can merge the two
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Option

_trunk_group= "{TRUNK Route Point}@{Telephony
Switch}"

_route_point= "{Route Point} @{Telephony
Switch}"

_agent _first_via_rp=true

_ixn_redirect_hints

Description

calls. If the option is false, the call is dialed from
the agent's DN.

Trunk Group from which the system can create a
user-terminated (outbound/inbound) call. If you
configured _agent_first via_tg = true, this option is
mandatory.

Optional - if agent first via tg=false

Route point from which the system can create a user-terminated
(outbound) call.

This option is mandatory.

Enables dialing of the call from the route point (set
inthe route point option) in a user-terminated
scenario connect to agent first where the agent
preview mode is disabled. Otherwise, the call will
be dialed directly from the agent's DN.

This option is mandatory.

The extensions parameters of the JSON object must include
values for implicit reservation information (ISCC). For example:

{"extensions":{"iscc-ar-
duration":15000,"iscc-ar-agent-dn":"","iscc-
ar-agent-id":"","iscc-ar-place":"","iscc-ar-
priority":1000,"iscc-ar-priority-1":0,"iscc-
ar-priority-2":0}}

Note: iscc-ar-agent-dn, iscc-ar-agent-id, and iscc-ar-
place options are set in the SCXML strategy.

Additionally, edit your SIP server configuration and set sip-enable-moh=false in the T-Server

section.
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Troubleshooting

How to display the correct ANI on the agent and customer's end
in a GMS Agent-First Scenario?

If you have a pool of external numbers and one of them is used for an outbound customer call, if you
want the customer to get the correct ANI displayed, follow the instructions below.

For each external number of the pool, create a DN of type trunk in your configuration.

e Each trunk DN must have a unique prefix option, an empty replace-prefix option, and a unique cpn
option.

e Other options can be identical for all of the trunks.

In this scenario, the strategy adds the matching trunk to the dialing number prefix with the proper
cpn and prefix options. Then, after finding the matching trunk, the SIP Server removes the prefix
option by applying the replace-prefix empty option. As a result, the SIP Server uses the cpn value
as an invite for the username.
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IVR Classic Callback

In this scenario, the IVR handling an inbound call has logic to check for a long waiting time and offers
to call back the caller. To see an implementation example of this IVR, refer to the Classic Callback
Sample.

Call Flow

IVR Check Wait Time

¢ |VR: Requests a statistic to determine the estimated wait time for the target.

¢ |VR: If the waiting time is above the configured threshold, offers a callback.

Start Callback

e |VR: Callback is accepted and IVR submits a request to the callback service.

Callback service: Returns GMS service ID to the IVR.

Callback service: If _wait_for_agent = true, waits for an agent to be available.

Callback service: Calls the customer number.

e Customer: Accepts the call.

Connect to Agent

Callback service: Identifies that a human has answered the call.

Callback service: Reserves the target to route the call.

Callback service: Routes the call to the target.

Callback service terminates.
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Create your Scenario

Add New Service

Service Template

callback b

Service Name

Commeon Default Configuration
Choose among the following...  ~

User Originated Immediate
User Originated Delayed
User Terminated Immediate
User Terminated Delayed
User Terminated Preview
Chat Immediate

Chat Delayed

Samples

In the Admin Ul > Services > Configured Services tab, add a Callback service with one of the
User-Terminated scenario as the Common Default Configuration (see Adding a Service for
details).

Enter the service name, which is the callback execution name of your service. It will be used in URLs
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to access this service. For example, if you set this name to voice-userorig-immediate, your service
URL will be:

http://host:port/{base-web-application}/service/callback/voice-userterm-immediate

When you add this service and default configuration, many options are automatically populated with
the appropriate default values.

Configure the Scenario

The following parameters are mandatory in the configuration of your callback service and in the
parameters of the requests that your application submits:

Option Description

Customer's phone number. The parameter is
mandatory to match the call with service data
when the call direction is set to USERORIGINATED.
Also used to establish the connection with the
customer when the call direction is

USERTERMINATED.
_customer_number

Normally provided as a request parameter o )
This is a request parameter that you can use in REST
queries.

This option is mandatory.

This is a default value, automatically populated
when using the predefined User-Terminated
scenario. You do not need to change this value.

e |f this option is set to USERORIGINATED, the
customer's device will initiate the call to get
_call_direction = USERTERMINATED connected to the agent.

 If this option is set to USERTERMINATED, the
agent or the system will initiate the call to
contact the customer.

True to wait for confirmation of the customer's
availability. If this option is set to true, the service
sends a push notification to the customer's device
to get confirmation that the customer is ready to

wait for user confirm = false have a conversation with the agent. This scenario
- T B is possible only if the wait for agent option is
set to true.
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Include the Originating Call in Callback Historical Reporting

To connect the originating call to the Callback Historical Reporting, the IVR should add the following
Callback KVPs to the attached data of the originating call.

e (B _SERVICE ID: Set this value to the GMS Service ID. This value is returned in the _id key in the
response to the callback service request.

e CB T SERVICE START:

e |f the callback was not scheduled, set this value to the time at which the callback service was
requested.

* For a scheduled callback, set this value to the scheduled time. The required format is number of
seconds since January 1, 1970, 00:00:00 UTC; for example, you can get this value in javascript
as follows: Math.floor((new Date()).getTime()/1000)

e (B T CALLBACK ACCEPTED: Set to the time at which the caller accepted the callback. The format is the
same as for CB T SERVICE START.

The callback strategy includes optional support for adding these attached data keys to
the originating call. To enable this support, include the parameter

_originating interaction id (set to the originating call interaction ID) in the HTTP
request that starts the Callback service.

Terminate the Originating Call

After you have requested a callback and set the required attached data, the originating call might be
set to the ABANDONED state. To avoid this issue, you can customize your SCXML code.

For example, open the Composer project of the Classic Callback sample and, under Workflows, edit
the classic.workflow SCXML.

1. Add a new Block of type State before Exit, for example, ProperlyTerminatingOriginatingCall.
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E Composer - ClassicCallbackSample/Workflows/classic.workflow - Eclipse
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2. Edit the Body and add the following script:

<script>
var reason = { ReasonSystemName : "Callback" };
var hints = { 'reasons' : reason };
</script>
<ixn:redirect requestid="somevariable" interactionid="InteractionID"
from="routingPoint" to="'_STOP '"

type=" genesys.queue.rType.RouteTypeReject" hints="hints"/>
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Body X

Configure Body

Value: |<onentry>

<!-- optional executable content to be run upon entering this state -->
<script>
<! [CDATA[
var reason = { ReasonSystemName : "Callback" };
var hints = { 'reasons' : reason };
11>
</script>

<ixn:redirect requestid="somevariable to be changed"”
interactionid="InteractionID"
from="routingPoint™
to="'_STOP '"
type=" genesys.queue.rType.RouteTypeReject”
hints="hints"/>
</onentry>
<onexit>
<!-- optional executable content to be run upon exiting this state -->
</onexity|

@ oK || cancel

As a result, the script is added to the generated code.
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Capacity

The Capacity Service enables you to define the number of scheduled callbacks that are allowed for
Callback for a given time slot in the week. Then, your Callback service refers to your Capacity service
and to your Office Hours service to adjust the agent availability and the number of scheduled
callbacks. You can also implement exceptions that allow you to set a specific capacity for a given
date.

If your Callback Service needs to define its scheduled callback capacity, you must map the
_capacity service parameter value with the name of the Capacity service that you have created.
Depending on the defined capacity and on the defined business hours, the number of scheduled
callbacks during certain days or hours will increase or decrease.

Callback services that need fixed capacity levels can continue to use the
_max_request_by time_bucket option. But, if your Callback service includes both
_capacity_service and max_request by time bucket options, then
_max_request by time bucket is ignored.

REST API

The Capacity service is similar to Office Hours and is accessible through REST API for external
queries.

Refer to the APl Reference for further details.

Configuration

Option Value Comment
_type builtin Mandatory option.
_service capacity Mandatory

Multiple properties that start with
a prefix capacity and describe
capacity allocation through the
course of the week. The JSON
structure specifies the day of the
week, and capacity for hourly
slots during that day. Days of the
week are numbered as
recommended by ISO-8601 from
1 (Monday) to 7 (Sunday).

_Capacity_* JSON-formatted String
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Option

_capacity_add*

_timezone

Value

JSON-formatted String

Comment

_capacity 1 : {
1 : { // Monday

"0900" : 5,
"1000" : 7,
“1100" : 10,
"1200" : 10 }

}
capacity 2 {
{// Tuesday

"0900" 3
"1000" : 5,
"1100" : 7,
"1200" : 7 }

Multiple properties that start with
the capacity add_prefix and
describe the capacity exceptions
for additional working days.

The format is similar to the format of
_capacity * properties but instead of a
weekday, the full date for the extra day is
used to prefix the capacity exception.
This date is entered in the format of
yyyyMMdd (year, month, day of the
month).

_capacity add 20160508 : {
20160508 : { // May 8, 2016

"0900" : 5,
"1000" : 7,
"1100" : 10 }

3
_capacity add 20161111 : {

20161111 : { // November
11, 2016
"0900" : 3,
"1000" : 5,
"1100" : 7 }

Timezone for your capacity
service. For instance, if you
configured "EST", or "PST"
timezones with the CME, your
parameters must use the
timezones defined for Java such
as "America/Toronto", or "Europe/
Paris". See here Wikipedia to get
the list of correct timezones.
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Pausing Callback

For certain situations, you can temporarily pause outbound calling and routing to agents with
callbacks that have reached the QUEUED state. You can set this up globally to suspend all callback
services, or individually for particular services. This feature is useful, for example, to deal with a fire

alarm where all agents need to exit the facility.
Consider the following:
e For callbacks where the outbound call has not yet connected to the customer, pausing these calls will

disable outbound calling altogether.

e For callbacks where the outbound call has already connected to the customer, pausing the callback
disables routing the call to the agent; the customer will continue listening to the "waiting for next
available agent" prompt. As soon as you unsuspend the callback service, normal operation resumes.

e The state of paused callbacks will be PAUSED in the Callback Ul.

Set up the list for the callback pause service

You can control how and when callbacks are paused using a transaction list entry in the
Transactions folder of your tenant configuration.

Enter the name you want to use for the list of paused services by setting the paused_services_list
option in your callback service. If you don't specify a value for this option, the name
GMS Paused Services is used by default.

Enable callback pause (globally or per individual service)

The Transactions folder of your tenant configuration includes an object called
GMS Paused Services, of type list. In the Annex of this object, add the following settings to the

section called services.

* Pause callback globally for all services by adding the following key:
key: all

value: true (pauses calling), false (enables calling)

* Pause callback for individual services based on the service name, by adding a key for each service:
key: The service name.

value: true (pauses calling), false (enables calling)

» Pause callback for individual services based on IDs, by adding an identification text passed in the HTTP

request that starts the callback:
key: Identification text, where the text value is passed in the option _paused_services_id of the
HTTP request. This key can contain any alphanumeric characters, except the blank character.
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value: true (pauses calling), false (enables calling)

If any of the keys ("all", callback service name, or paused_services id) is found in the transaction list
with its value set to true, the system pauses the service.

Tip

If you anticipate using this feature, be careful that active callbacks do not expire while
in the PAUSED state. For example, make sure that the callback service options values
are all set to a longer time period than you expect the callbacks to be paused: _ttl,
_urs_queued_ttl, and _max_time_to_wait_for_agent_on_the_call.
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Preview and Disposition Scenarios

If you implement a custom agent desktop and wish to integrate the Preview and Disposition scenarios
into your Callback application, you need to configure preview and disposition options in your callback
service. If you implement the Disposition scenario, you also need to create an Office Hours service.

After you do this, your custom agent application will receive the following UserEvent events from
Orchestration Server:

e CallbackInvitationEvent—The callback invitation that contains the attached data for the preview.
The invitation includes the list of actions that the agent can perform-accept, reject, or cancel. Your
Agent application displays the actions and the attached data for the preview to the agent, then submits
a Preview Response to your Callback service.

e CallbackDispositionEvent—The callback disposition event that provides the URL to which you submit
the disposition selected by the agent. Your Agent application then submits a Disposition Response to
your Callback service through this URL.

If the agent needs to reschedule the callback, he or she can select the retry later disposition

option provided in the disposition event. This event also provides the business hours url that lists
the available timeslots to reschedule.

Disposition scenarios do not support transfers.

Preview and Disposition Event Flow

This diagram shows the sequence of events involved in your callback service and in your Agent
Desktop application if the agent receives a preview invitation and submits a disposition call after the
call is done.

Callback User's Guide 234



Callback Scenarios and Configuration Preview and Disposition Scenarios
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Steps to Handle a Preview Request

If you configure the preview feature, as detailed below, the Callback service sends a preview request
to your Agent Desktop application. This request is a user event that includes the preview-specific
data in the event's udata and extensions attributes. Your Agent Desktop application can use this data
to:

* Show the available action(s) in the preview dialog.

¢ Use the provided URLs to submit their response(s) to the action(s) they select.

Configure the Preview Request Feature

To implement a preview scenario, check your settings:
1. Add an ORS Application (CME) connection to the agent's switch T-Server by using Configuration
Manager or Genesys Administrator Extension (GAX).
2. In the Service Management Ul, set the callback service options to the following values:
* _agent_preview=true to enable the preview feature
* preview_userevent_mediatype = 0 to set the voice media (default)

* _agent_preview_allow_reject = [0..n]
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e If _agent preview allow reject=0, the reject option will not be displayed to agents.

¢ Any other values indicate how many times the call can be rejected by agents, to make sure that
the call cannot be rejected indefinitely.

* _agent_preview_timeout = 30—Specify the number of seconds that the agent will be given before
the preview times out. If the limit is exceeded, GMS assumes that the agent has rejected the
request. (Note that the value shown here is only an example.)

e _urs_udata_xfer keys = "" and _attach_udata = ""-List of KVPs available within the user-data key
of the CallbackInvitationEvent event.

Starting in 8.5.105, the user data contains all of the KVPs attached to the real call.

In 8.5.201, additional options were added to enable new scenarios. You can now enable the rejection
of previews if the agent does not accept or reject the preview invitation in the configured
_agent_preview_timeout time.

If _agent preview timeout set notready=true, and if the agent does not
accept or reject the preview in the configured agent preview timeout:

» If the _agent_preview_set notready_reason is not configured, the EventAgentNotReady event will be
visible in the ORS logs, but will not contain a ReasonCode in its extensions.

» If the _agent_preview_set notready_reason is configured, for example, if its value is '999', then is case,
the extensions of the the EventAgentNotReady event will contain ReasonCode = '999".

Starting 8.5.201, if the agent rejects the preview invitation, this agent will not receive
the preview invitation again for that callback.

Wait for the CallbacklnvitationEvent

If the Preview Request Feature is configured, ORS will use the Tlib/UserEvent protocol to send a
preview request invitation for Callback as a CallbackInvitationEvent UserEvent to your desktop
application.

* UserEvent Name: CallbackinvitationEvent

* Limitations: The expected target is an Agent DN.

This event includes the response-options list of actions that the preview invitation dialog should
display to the agent: accept, reject, or cancel (xcancel). For each action, the url property
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indicates the URL that the event response will be submitted to.

Example of CallbackinvitationPreview UserEvent

@12:38:49.5410 [0] 8.1.101.10 distribute user event: message EventUserEvent
AttributeEventSequenceNumber 00000000000018eb
AttributeCustomerID '"Environment'
AttributeTimeinuSecs 541000
AttributeTimeinSecs 1467229129 (12:38:49)
AttributeReferenceID 2223
AttributeUserData [1438] 00 03 03 00..
'display-data'(list) '1' 'vl1'
2! 'v2'!
'3 'v3'
'response-options'(list) 'accept'(list) 'button' 'accept!’
‘url' "http://2XX.XX.1XX.1XX:8080/genesys/1/ors//scxml/session/
UGHKD84S9H6M995N2PQV70FN3000002F/ request/accept preview'
'reject' (list) 'button' 'reject!’
‘url' "http://2XX.XX.1XX.1XX:8080/genesys/1/ors//scxml/session/
UGHKD84S9H6M995N2PQV70FN3000002F/request/reject preview'
'xcancel' (list) 'button' 'xcancel'’
‘url' "http://2XX.XX.1XX.1XX:8080/genesys/1/ors//scxml/session/
UGHKD84S9H6M995N2PQV70FN3000002F/ request/cancel preview'
'user-data' (list) 'GMS Call Direction' '"USERTERMINATED'
'GMS_Cb Desired Time' '2016-06-29T19:38:39.788Z"
'GMS_Cb_Type' 'immediate’
'GMS_Customer Number' '5115"
'GMS_Orig Service ID' ‘test123’
'GMS_ROUTABLE' '0!
'GMS_RP_Used' '8999@SIP Switch'
'GMS_ServiceName' 'samples dev'
'GMS_Service Data ID' '445-748c2c27-2010-47f7-91cc-49d19a7734c3"
'GMS_Service ID' '445-36922082-275-4d44-8200-92bc5¢c49a965"'
'GMS_Target Selected'
"{"agent":"KSippola","dn":"7001","id": "Customer Service",

"place":"SIP Server Placel","resource":"7001","return":"target","stat value":"0",
"switch":"SIP Switch","type":"GA","vq":"SIP_VQ SIP Switch"}'
'GMS_UserTerminated First Connect Party' "AGENT"
'GMS_VQ Used' 'SIP VQ SIP Switch'
'RPVQID' 'I5Q83URTDDOFT2BTGOMO3PTOP40000DT"
'RTargetAgentGroup' 'Customer Service'
'RouterData70' '("t"="1467229122 158")"
'first name' "John'
‘last _name' 'Doe’
‘location_ lat' '37.2638324"
'location_long' '-122.02301459999998"
AttributeExtensions [118] 00 04 00 00..
'event' 'CallbackInvitationEvent'
"invitation-timeout' '60"'
'session' 'UGHKD84S9H6M995N2PQV70FN3000002F '
'source’ "ORS'
AttributeMediaType ‘0"
AttributeUserEvent EventUserEvent
AttributeThisDN ‘7001

[+] Show CallbacklinvitationPreview as a JSON schema
// JSON Schema for udata passed in CallbackInvitationPreview userevent

"title": "CallbackInvitationPreview Udata",
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"type": "object",
"properties": {
"response-options": {
"type": "object",
"properties": {
"responseOptionl": {
"type": "object",
"properties": {
"button": "accept",
"url": "../request/accept preview"

}
}I
"responseOption2": {
"type": "object",
"properties": {
"button": "reject",
"url": "../request/reject preview"

}

}!

"responseOption3": {
"type": "object",
"properties": {

"button": "xcancel",
"url": "../request/cancel preview"
}
}l
"required": ["responseOptionl", "responseOption3"]

}I

"display-data": {
Iltypell : Ilarrayll ,
"items": {

}
}I
"user-data": {
Iltypell: IlobjectlI’
"properties": {

}

"type": "string"

}I
"required": ["response-options", "display-data"l]

}

// JSON Schema for extentions passed in CallbackInvitationPreview userevent

{
"title": "CallbackInvitationPreview Extensions",
"type": "object",
"properties": {
"source": {
"enum": ["ORS"]
}l
"event": {
"enum": ["CallbackInvitationEvent"]
}I
"session": {
"type": "string"
"invitation-timeout": {
“"type": "string" // _agent preview timeout
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}
}I

"required": ["source", "event", "session", "invitation-timeout"]

Send Preview Response

The Agent Desktop application must send the Preview Response after the agent selects one of the
actions presented in the agent preview dialog.

* Description: Preview response

¢ Protocol: HTTP

¢ Method: POST

e URL: Value of the url property received in the CallbackInvitationEvent user event corresponding to
the agent-selected option.

e Content-type: application/json
e Body: None

¢ Response from callback: HTTP 200 - Response received: (Accept|Reject|Cancel)

Reduce Processing Delays in Scheduled Preview Callback Scenario

When GMS schedules a preview callback, at a given time T, GMS sends the request to ORS at time T
and ORS sends the CallbacklnvitationEvent request to SIP Server at T+60 up to T+90 seconds. You
can use the following options to reduce the processing delay:

e Configure _wait for_user_confirm = false to disable the user confirmation for this service.

e Configure _max_number_of user_availability _confirmation_attempts to limit the number of retries in
your Callback service.

e Configure _user_confirm_timeout to a smaller value to reduce the waiting time for the user confirmation
timeout.

Steps to Handle the Disposition Response

If you configure the Disposition feature, the Callback service will send a disposition request to the
Agent Desktop application. The Agent Desktop application uses information retrieved from the user
event data and the extension attributes to display the disposition dialog to the agent. It then replies
with the disposition selected by the agent, as discussed in greater detail in the Disposition response
section.

You must create an Office Hours service before configuring the Disposition feature.
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Configure the Disposition Feature

To enable the Disposition feature, configure the following settings:

1. Add an ORS Application connection to the Agent Switch T-Server Application in Configuration Manager

or in Genesys Administrator Extension.
2.

In the Service Management Ul, set the callback service options to the following values:

* enable disposition dialog = true to enable the disposition dialog; this option is false by

default to disable the feature.

e disposition_userevent mediatype

0 (voice is default)

* agent disposition timeout = 45 to set the duration in seconds for receiving an agent response.
If this time elapses with no reply from the agent, GMS sets the disposition to COMPLETED with the

reason NO AGENT DISPOSITION.

* Setthe business hours service option with the name of your Office Hours service.

Wait for the Disposition Request

Once the callback is completed, if the disposition feature is enabled, GMS sends a Disposition request
as a CallbackDispositionEvent UserEvent using the Tlib protocol:

Description: Disposition request

Protocol: Tlib/UserEvent

UserEvent Name: CallbackDispositionEvent
Limitations: The expected target is an Agent DN

Body: Contains udata and extensions.

12:39:05.224 Trc 04541 RequestDistributeUserEvent received from [628]

Orchestration Server 216.38.144.133:34716)
message RequestDistributeUserEvent

AttributeThisDN '7001"
AttributeUserEvent EventUserEvent
AttributeCommunicationDN '7001"
AttributeMediaType ‘0"
AttributeExtensions [121] 00 04 00 00..
'disposition-timeout’ '120'

(00000004

'event' 'CallbackDispositionEvent'
'session' 'UGHKD84S9H6M995N2PQV70FN3000002F !
‘source’ "ORS'

AttributeUserData [665] 00 03 03 00..

‘config'(list) ' gms external base url'
' service name'

'display-data’'(list) 'business hours url'

"http://216.38.144.133:8080/"'

'samples dev'

'$ gms_external base url$genesys/1l/

service/callback/$ service name$/availability?start=$desired time$#ber-of-days=1&max-time-

slots=5"'

'completed dispositions'

"SUCCESS, BUSY,NO_ANSWER,SIT TONE, ANSWERING MACHINE,CUSTOMER NOT KNOWN,CUSTOMER NOT PRESENT,WRONG CUSTOMER NUMBE

'customer number!'
'response-options' (list) 'done'(list)
'options' '["completed","retry now
'url'

‘5115"

'button'

non
’

"done’
retry later"]'

'$ gms_external base url$genesys/l/ors/scxml/session/

UGHKD84S9H6M995N2PQV70FN3000002F/ request/callback disposition'
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AttributeReferencelD 2228

In this UserEvent:

e display-data contains the information that the Agent Desktop application needs to present the agent
disposition dialog.

e business hours url provides the list of available timeslots in case the agent selects the retry later
disposition option.

e completed dispositions contains the list of common dispositions. The Agent Desktop can provide its
own list of dispositions.

e url contains the URL to be used for submitting the disposition response.

[+] Show CallbackDispositionEvent as a JSON schema

Note that the JSON schema below is provided for the sake of clarity, as this event is always sent as a
UserEvent.

// JSON Schema for udata passed in CallbackDispositionEvent UserEvent

"title": "CallbackDispositionEvent Udata",
"type": "object",
"properties": {
"response-options": {
"type": "object",
"properties": {
"responseOptionl": {
"type": "object",
"properties": {

"button": "done",
"url": "../request/callback disposition",
"options": {
"enum": ["completed", "retry now", "retry later"]

}
}

"required": ["responseOptionl"]

}
}I
"display-data": {
"type": "object",
"properties": {
"customer number": "string",
"business hours url": "/service/
callback/$ service name$/availability?start=$desired time$&number-of-days=1&max-time-slots=5",
"completed dispositions": {
"enum": "array",
"properties": {
"button": "done",
"url": "../request/callback disposition",
"options": {
"enum": ["SUCCESS", "BUSY", "NO ANSWER", "SIT TONE",
"ANSWERING MACHINE", "CUSTOMER NOT KNOWN", "CUSTOMER NOT PRESENT", "WRONG CUSTOMER NUMBER"]

}
I
"required": ["customer number", "business hours url",
"completed dispositions"]

}I

"config": { // to be used to evaluate business hours url specified earlier
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"‘type": "Ob_‘jec‘t",
"properties": {

" gms_external base url": "string",
" service name": "string"
}I
"required": [" gms_external base url", " service name"]
}
}I
"required": ["response-options", "display-data"]

// JSON Schema for extensions passed in CallbackDispositionEvent UserEvent

{
"title": " CallbackDispositionEvent Extensions",
"type": "object",
"properties": {
"source": {"enum": ["ORS"]},
"event": {"enum": ["CallbackDispositionEvent "]},
"session": {"type": "string"},
"disposition-timeout": {"type": "string"}},
"required": ["source", "event", "session", "disposition-timeout"]
}

Send a Disposition Response

The Agent Desktop application must send the Disposition Response after the agent selects one of the
dispositions presented in the agent disposition dialog and before the agent disposition timeout
timeout occurs.

e Description: Disposition response

¢ Protocol: HTTP

¢ Method: POST

¢ URL: Value of the url property received in the CallbackDispositionEvent UserEvent

e Content-type: application/json

* Body:
// JSON Schema for agent response from callback disposition dialog
{
"title": "HTTP POST body received from callback disposition dialog",
Iltypell : Ilobj ectll ,
"properties": {
"reason" : "SUCCESS", // only for completed
"disposition": {
"enum": ["retry later","retry now", "completed"],
T
"customer_number": "string", // only for retry later
"desired time": "string" //only for retry later
}I
"required": ["disposition"] // desired time required when disposition = "retry later"
}

Callback Response:
HTTP 200 Response received: <agent response from body of the request>

For a “completed” use case, if you choose “SUCCESS” in your agent desktop, the Disposition
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response contains:

¢ "reason" = "SUCCESS"

e "disposition" = "completed"

For a “retry_later” use case, the Disposition response contains:

e "disposition" = "retry_later"
e "customer_number" = "<customer number>"
e "desired _time" = "<timestamp>"
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Forget Me (GDPR)

Introduced in 8.5.201

This APl enables you to support General Data Protection Regulation and enables you to "forget"
customers.

What is GDPR

The General Data Protection Regulation (GDPR) is a rule passed by the European Union in 2016,
setting new rules for how companies manage and share personal data. It addresses the export of
personal data outside the EU. The GDPR is applicable for enterprises across the globe that store EU
citizens' data.

The regulation applies if the data controller, an organization that collects data from EU residents, or
data processor, an organization that processes data on behalf of a data controller like cloud service
providers or the data subject (person) is based in the EU. The regulation also applies to organizations
based outside the EU if they collect or process personal data of individuals located inside the EU.
Genesys is considered a data processor under these terms.

The purpose of this document is to help organizations understand how Genesys Services can be utilized to
help them comply with certain regulatory requirements, including EU General Data Protection Regulation.
Some of the Genesys Services features described herein may or may not be available based upon an
organization’s specific environment and Genesys Services acquired.

The information in this document may not be construed or used as legal advice about the content,
interpretation or application of any law, regulation or regulatory guideline. Customers and prospective
customers must seek their own legal counsel to understand the applicability of any law or regulation on
their processing of personal data, including through the use of Genesys’ products or services.

What data comes under the scope of GDPR?

According to the European Commission, "personal data is any information relating to an individual,
whether it relates to his or her private, professional or public life. It can be anything from a name, a
home address, a photo, an email address, bank details, posts on social networking websites, medical
information, or a computer’s IP address." This data is called as Personally Identifiable Information
(PII).

Rights defined by GDPR

The following Rights are defined by the GDPR:
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¢ Right of Consent

¢ Right of Access and Portability
e Right of Erasure (Forget Me)

* Breach Notification

e Privacy by Design

Forget Me Scenario

If you need to forget a customer and his or her related information, you can use the Delete Callback
API to delete one or more Callbacks by passing service IDs or Customer Numbers. See Delete
Callback API for details.

You will be able to delete a Callback only if it is in SCHEDULED or COMPLETED status.

Callback State Scenario

e COMPLETED
e SCHEDULED

Delete the Callback.

* PROCESSING

1. Cancel the Callback.
e QUEUED

2. Delete the Callback.
e ROUTING
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Callback Service Options Reference

Refer to the Callback Service Options of the Genesys Mobile Services Options Reference.
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Callback Services API

APIs related to Callback Services, builtin services, and ORS scenarios are detailed in GMS API
References.

¢ Callback Services API
e Calendar API
» Capacity API

For custom samples, see:

e ClassicCallbackSample illustrates how to implement an IVR (Genesys Voice Platform VoiceXML)
application that communicates with GMS and performs classic Callback scenarios.

¢ Custom Callback Sample implements an On-Dial plugin to interface with the GMS Callback service.
Developers should use this sample as a reference to build a Composer application that is invoked as a
plugin from GMS Callback.

The Service Management Ul also includes a Sample panel to test your Callback Services.

Modified in: 8.5.2

Getting Started

When you add a callback service, you define a Service Name, which is referred to as {callback-
execution-name} in this APl documentation. Each time that you perform a callback query, you must
specify the {callback-execution-name} in the URI parameters.

Accessing your Callback Service

The URLs used by the Callback API are dependent on the execution name of the Callback service that
you have just created. Callback services are available at the following URL:

http://<host>:<port>/genesys/1/service/callback/{callback-execution-name}

For instance, if you create a callback service named callback-for-mobile, then {callback-
execution-name} is callback-for-mobile, its configuration in GMS is located in the
service.callback-for-mobile section, and you can access the callback service at the following
URL:

http://<host>:<port>/genesys/1/service/callback/callback-for-mobile
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Overwriting Configuration in Queries
To overwrite service configuration parameters in your POST REST queries (Start-Callback), use the

_overwritable_options option. This option lets you define a list of overwritable parameters that you
will be able to pass in the Body of your REST request.

This list can include the ors and target options only.

For example, if you set:
_overwritable_options = _ors,_target

Then, you can pass ors and target in your REST query:

POST /1/service/callback/callback-for-mobile

{
" ors": "http://myors:4421",
" target": Billing@Stat Serverl.GA

Passing Configuration Tokens in Queries

Added in: 8.5.104

In your service configuration, you can create token variables that can be used in other configuration
parameters. Then, at runtime, you can pass values for these tokens in POST REST queries (Start-
Callback) and these values will be used to modify your configuration.
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To create a token variable, create a new service parameter and configure its value with a string
matching the following format: $<any-token-name>$

For instance, create:

my token name = $my token$

Then, you can use the body parameter my token=<anyvalue> in your REST queries. As a result, the
occurrences of $my token$ in this service configuration will be replaced with the query's provided
value.

For example, if you wish to create a callback request for the CLBCK-terminated-preview service
using the Stat Serverl server target, use the following query:

POST /genesys/1/service/callback/CLBCK-terminated-preview
HTTP/1.1

Host: 127.0.0.1:8080

Cache-Control: no-cache

Content-Type: application/x-www-form-urlencoded
_customer number=01822256&my token=Stat Serverl

When GMS receives my token=Stat Serverl in the query information, it replaces the $my token$
placeholder with Stat Serverl everywhere that it is used in the configuration of CLBCK-terminated-
preview. Using our example, the result would be:

_target = Billing@Stat_Serverl.GA

Tip
Use this feature to avoid duplicating configuration for multiple services that handle
the same functionality, but use different queues or servers.

Understanding Callback States

When the Callback request is submitted, it gets through several callback states and ORS handles
some of these callback states while processing the associated callback interaction. You can access
the callback status in the callback state parameter of the callback's JSON representation.

The callback state parameter is incompatible with the new desired time
property.
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PROCESSING
QUEUED
COMPLETED
SCHEDULED ROUTING
Intermediate states Final state
Callback states While in ORS Description
PROCESSING The customer is connected to an

agent and talking with this agent.

The callback is actively waiting
QUEUED for an agent in ORS/URS; the

agent is not assigned yet.

The Callback service handles the

callback (there are no sessions

started in ORS). While in this
SCHEDULED state, the request is handled by

the callback service running in

GMS until the specified

desired time is approaching.

Customer phone is reached and
ROUTING o waiting for an agent.

The call has ended and the
COMPLETED Callback is completed with the

reason specified in
_callback reason.

The call is paused. See Pausing
PAUSED o Callback for details.

Callback reasons in COMPLETED State

You can get the following reasons in the callback reason parameter when receiving the COMPLETED
state.

ABANDONED_IN_QUEUE
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The Callback interaction was deleted prior to routing the interaction to the agent because the customer abandoned.

AGENT_CONNECTED

Callback Service successfully routed the interaction to the agent.

AGENT_PREVIEW_CANCEL

The agent canceled the callback preview request. To get this state reason, create an Agent First Preview service and configure the
following options with the following values, for example: _agent_preview=true, agent preview_allow_reject=3,
_agent_preview_set notready reason='Coffee Break',

_agent_preview_set notready_reason_attribute=false, agent_preview_set notready reason_key='ReasonCode',
_agent_preview_timeout_set_notready=true, agent_preview_via_rp=false

AGENT_PREVIEW_CANCEL_AFTER_<n>REJECTS

The agent rejected the request '<n>' times.

AM_CONNECTED

Callback Service successfully routed the interaction to the answering machine.

CANCELLED

Callback Service received a cancel request for this callback.

CANCELLED_BY_ADMIN

Callback Service received a cancel request from the Service Management Ul for this callback.

FAIL_AGENT_CONNECT

The Callback interaction could not be connected to the agent. This error may happen when the value of
_max_time_to_wait_for_agent_on_the_call is too short.

FAIL_CALL_TO CUSTOMER

Replaces FAIL USER UNREACHABLE since GMS 8.5.102.14. Callback Service could not connect the customer.

FAIL_ERROR

Callback Service failed due to an unknown error.

FAIL_FAX_REACHED

Callback Service could not connect the customer. The provided number was answered by a fax machine.

FAIL_INBOUND_TIMEOUT

The customer did not make the call within the expected _booking_expiration_timeout period defined for User-Originated scenarios.

FAIL_INCORRECT CONFIG_MEDIA_TYPE

The _media_type option is set to an incorrect value. Callback Service only processes voice and chat interactions.

FAIL_INTERACTION_DELETED

The callback interaction was deleted prior to routing the interaction to the agent. This error may happen when
_wait_for_agent=true and the agent hung up the call.
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FAIL_IXN_UNKNOWN_MEDIA_TYPE

The media type of the interaction is not supported by Callback Service. Callback Service only processes voice and chat
interactions.

FAIL_LOAD_MESSAGE_FILE

Callback Service cannot load the strings resource file specified in the _notification_message_file option.

FAIL_NO_CUSTOMER_NUMBER

Customer number is missing.

FAIL_QUEUEING

The Callback request could not be queued. This error may happen when an error occurs while requesting the route delay to URS.

FAIL_TARGET_NOT_FOUND

Callback Service cannot reserve the requested target to handle the request. This error may happen when the value of
_urs_queued_ttl is too short.

FAIL_TIMEOUT_TTL

Callback Service did not manage to handle the request in the specified time (_ttl).

FAIL_USER_NO_CONFIRM

The user confirmation was not received although it was required; this issue can occur if _on user confirm timeout is not set to
CONNECT-ANYWAY.

FAIL_USER_UNREACHABLE

Reported as FAIL_CALL_TO_ CUSTOMER prior to GMS 8.5.102.14.

NOT_AVAILABLE

Callback Service exited with no specified reason.

SUBMIT_ERROR

GMS did not manage to submit the Callback service request to Orchestration Server for processing.

List of APl Queries

Start or Schedule Callback

Initiates a callback request. It validates the request by doing the following:

¢ Checks parameters, in general (in particular, if the target queue is valid).
¢ Checks the customer number against exceptions.

e Checks the time criteria of the request against the business.
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e If invalid:
e Returns the appropriate error.

* Sends a reporting event to the GMS data manager indicating that the callback request has been
rejected.

o If valid:
¢ Creates a unique ID for the request.

¢ Sends a reporting event to the GMS data manager indicating that the callback request has been
accepted and started.
This event also indicates the state of the request (immediate or scheduled).

* |If the request needs to be scheduled for a later date/time, the request and its associated data
will be stored in the module persistent data storage.

e If the request can be started now, an ORS session is initiated using the associated SCXML-based
service with this particular callback request.
Note: the provisioned data for the execution service to be started will be used as input
along with the input parameters from the request itself.

Returns the ID generated for this request.

Starting in 8.5.2, you can redial a COMPLETED callback by submitting the callback ID to create a copy
of this callback. The properties and user data of the copied callback are merged with the parameters
of the new callback submitted in the POST query.

e The parameters specified in the POST query override the copied properties.

e Internal retry flags and properties such as callback state, ors session id, desired time will be
ignored when creating the callback copy.

Tip

You can include any of the _xxx callback option parameters in your start query if they
are not configured in the service; for example _target, wait_for_agent,
_paused_services _list, paused_services_id, or any other xxx parameter listed
in the Callback Service Options Reference Guide. If the option is already configured in
the service, the query parameter's value is ignored and the service option value is
used. See Overwriting Configuration in queries to learn about overwriting
configuration in queries.

Important:

The desired time parameter is used together with service options to decide if a callback should be
created for a later execution or the callback should be triggered as soon as the corresponding API
request is processed.

The Callback will be IMMEDIATE based on the following rule:

immediate = desired time < {current time} + { request execution time buffer} +
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{Estimated Wait Time} where, {Estimated Wait Time} is computed from either of following
options (in priority): { request ewt service} or { request queue time stat} or { urs ewt vq}
or { urs virtual queue} or { vq}.

Example 1:

Assuming current time is 16:15, and desired time is today at 17:05,

_request execution time bufferis 300 (5 mins), EWT is computed as 10 mins.

Then the Callback is SCHEDULED (not IMMEDIATE) and will be kept in the GMS queue to be submitted
later for execution because:

immediate = (17:05 < 16:15 (now) + 5 min + 10 min)

immediate = (17:05 < 16:30)

immediate = false

Example 2:

Assuming current time is 13:10, desired time is today at 13:15,

_request _execution time bufferis 120 (2 mins), EWT is computed as 5 mins.

Then the Callback is IMMEDIATE and is submitted for execution upon API request creation because:
immediate = (13:15 < 13:10 (now) + 2 min + 5 min)

immediate = (13:15 < 13:17)

immediate = true

When used together with Office Hours, note that the enable reject out of office hours
option allows to accept or reject callbacks taking into account the statistics.

POST /genesys/1/service/callback/{callback-execution-name}
Initiates a callback request.

Header

application/json

multipart/form-data

Content-type
application/x-www-form-urlencoded

URI Parameters

Name Type Description
callback-execution-name string Name of the callback execution
*required path service provisioned in GMS.

Body (JSON content)
Number to call back.

This parameter can also be replaced by

*required string any parameter specified in the option
_mandatory_customer_lookup_keys
(comma-separated list of attributes) that
can identify a unique customer.

_customer_number

ID of a Callback in COMPLETED
state. The properties and user
data of this completed callback
are copied in the new callback

_copy_from_id
Introduced in 8.5.2 string
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and use for redial.

e Properties specified in the
POST request will override
copied properties.

e The following properties and
internal retry flags will be
excluded from the copy:

Desired time to have the
callback. By default, the desired

time is the current time.
desired_time string
- - This option format is ISO 8601 "yyyy-MM-
ddTHH:mm:ss.SSSZ" such as
"2013-05-28T15:30:00.000Z"

Any properties key/values to be
attached. Key/Values may be
used in Orchestration

execution service. Keys without an
underscore prefix are User Attached Data.

_ The key must be a valid

<property> string ECMAScript variable name.
This means that variable
semantics that include
elements like "." (for
example, foo.foo) and "-"
(for example, foo-foo) are
not allowed.

Forces creation of Callback in a
specified state.
Important: This is for
advanced users that handle

—Ca”baCk—State string Callback life-cycle externally to GMS. By

default, the callback state valueis
either QUEUED or SCHEDULED depending if
the Callback is processed as immediate
or scheduled (respectively).

Queue to use for this callback if
several virtual queues are used
for callback with identical
configuration.

_urs_virtual_queue string

Queue statistics. For example,
"ExpectedWaitTime;Queue;8999@SIP_Server;En
Note: If the
_request_queue_time_stat
_request_queue_time_stat string option is configured in the
Callback service, the
request parameter is
ignored.
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Responses
Name
200 OK
Response Body (JSON content)
_id
required
ID

only for immediate callback

Action
only for immediate callback

Text
only for immediate callback

OkTitle
only for immediate callback

Name

500 Internal Server Error
Response body (JSON Content)

code

phrase
message
exception

properties

Name

429 Too Many Requests
Response body (JSON Content)

Description

The service id for which a successful callback
request was registered.

Dialog Event ID

Dialog Action.

Text to display

Label for the OK button.

Value

50006

ORS_MAX_SUBMIT_RETRIES

"Callback {id} reached maximum attempts to submit to ORS
reached ({max-attempts})"

com.genesyslab.gsg.services.callback.CallbackExceptionMaxORSSubmitAttempts

{ "id": "callback id", "max-attempts": <value for
_max_ors_submit_attempts> }

Value
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Name
code
phrase
message
exception
properties
Name

429 Too Many Requests
Response body (JSON Content)

code
phrase
message

exception

properties

Name

429 Too Many Requests
Response body (JSON Content)

Value

40001

NUMBER_ALREADY_BOOKED

"There is already {max_queued} or more Callbacks QUEUED for
this number, please refer to _enable_in_queue_checking for
detail."

com.genesyslab.gsg.services.callback.CallbackExceptionAlreadyBooked

{ "max_queued": <1 if enable in queue checking=strict or
2 if enable in queue checking=true>}

Value

40002

THROTTLE_SERVICE_LIMIT

"Limit of queued callbacks for {service} is reached."

com.genesyslab.gsg.services.callback.CallbackExceptionThrottled

{

'service": <service name>

}

Value
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code

phrase

message

exception

properties

429 Too Many Requests
Response body (JSON Content)

code

phrase

message

exception

properties

Name

Name

Value

40003

THROTTLE_SERVICE_INTERVAL_LIMIT

"Limit of queued callbacks for {service} is reached for interval
{interval}s."

com.genesyslab.gsg.services.callback.CallbackExceptionThrottled

{

"'service": <service name>,
"interval": <interval throttling limit>

}

Value

40004

THROTTLE_SERVICE_PARAMETER_LIMIT

"Limit of queued callbacks for {service} is reached for
parameter {parameter}. Reached {attempts} times today."

com.genesyslab.gsg.services.callback.CallbackExceptionThrottled

{ "service": <service name>,

"parameter": <parameter triggering the
throttling>,

"attempts": <number of attempts reached> }
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Name Value

400 Bad Request
Response body (JSON Content)

code 40020

phrase INVALID_OPERATION

* "Request cannot be processed because callback
message {id} to copy is not COMPLETED. Check
parameter copy_from_id"

exception com.genesyslab.gsg.services.callback.CallbackExceptionlnvalidOperation

{"id": <callback id>,
"service": <service hame>,
"time": <ISO UTC time>,
properties "state": <callback state>,
"message": <ORS server's message>,

"filter": <filtering expression>

}

Name Value
400 Bad Request
Response body (JSON Content)
code 40030
phrase CALLBACK_NOT_FOUND
message "Callback {id} to copy from cannot be found"
exception com.genesyslab.gsg.services.callback.CallbackExceptionNotFound

{

properties "id": <callback service id>,
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Name

Name

400 Bad Request
Response body (JSON Content)

code

phrase

message

exception

properties

Name

500 Internal Server Error
Response body (JSON Content)

code

Value

'service": <service name>,
"time": <ISO UTC time>

}

Value

40050, 40051

* SLOT_UNAVAILABLE (40050)
* SLOT_UNAVAILABLE_PROPOSAL(40051)

¢ "No time slots available."

e "Too many requests at desired time slot {slot}.
Proposing time slots."

e "Office is closed at desired time slot {slot}.
Proposing time slots."

com.genesyslab.gsg.services.callback.CallbackExceptionAvailability

{
"slot": <ISO UTC time range>,

'service": <service name>

}

Value

50020
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phrase

message

exception

properties

Name Value

BAD_CONFIGURATION

» "Service option {service} / _default_country is
not configured. But option
_disallow_impossible_phone_numbers is set. We
cannot validate phone numbers without
knowing the country."

e "Service option {service} / _default_country is
not configured. But option
_disallow_premium_phone_numbers is set. We
cannot validate phone numbers without
knowing the country."

e "Unable to parse option:
_request_queue_time_stat={statistic}"

* "Missing default_chat_endpoint option in chat
section because this service has parameter
_media_type=chat"

* "Missing default _client_timeout option in chat
section because this service has parameter
_media_type=chat"

e "Option service.{service} /
_business_hours_service not configured."

e "Option _business_hours_service is invalid:
{message}"

e "Service undefined: {service}"

e "Service {service} has unknown value for
option _type"

e "Service {service} has option _type != ors"

e "Service {service} has option _service !=
callback"

com.genesyslab.gsg.services.callback.CallbackExceptionConfiguration

{

'service": <service name>

}
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Name

500 Internal Server Error
Response body (JSON Content)

code
phrase
message

exception

properties

Name

500 Internal Server Error
Response body (JSON Content)

code
phrase
message

exception

properties

Name

500 Internal Server Error
Response body (JSON Content)

code

phrase

Value

50005

CALENDAR_ERROR

message returned by Calendar service

com.genesyslab.gsg.services.callback.CallbackExceptionCalendarError

Value

50004

CAPACITY_ERROR

message returned by Capacity service

com.genesyslab.gsg.services.callback.CallbackExceptionCapacityError

Value

50030

ORS_ERROR
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Name
message
exception
properties

Name

500 Internal Server Error
Response body (JSON Content)

code
phrase
message

exception

properties

Name

400 Bad Request
Response body (JSON Content)

code

phrase

message

Value

e "Invalid ORS response"

* message returned by ORS strategy

com.genesyslab.gsg.services.callback.CallbackExceptionFromORS

Value

50040

SERVICE_REDIRECT_FAILED

message from redirected service

com.genesyslab.gsg.services.callback.CallbackExceptionServiceRedirect

Value

40040

NUMBER_REJECTED

e "Customer Number is not allowed, because it is
invalid. Check option "Customer Number is not
allowed, because it is invalid. Check option
_disallow_impossible_phone_numbers"

e "Customer Number is not allowed, because it's a
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Name Value
premium number. Check option
_disallow_premium_phone_numbers"

e "Customer Number is not allowed, because it
failed validating. Check option
_disallow_impossible_phone_numbers"

e "Customer Number is not allowed. Check option

_exceptions"

exception com.genesyslab.gsg.services.callback.CallbackExceptionNumber
properties

Name Value
500 Internal Server Error
Response body (JSON Content)
code 50050
phrase UNKNOWN_ERROR
message "Error processing callback {message} "
exception com.genesyslab.gsg.services.callback.CallbackExceptionUnknown
properties { "message": <message catched> }

Example

POST http://localhost:8080/genesys/1/service/callback/request-callback
{

" customer number": "5115",

"usr_customer name": "Bob Markel",

"usr _reason": "billing question",

" device notification id":
"b16416334828b1d26ef141329628b55b5a8c631d8928a371a5584722dd7fb673",

" device os": "comet",

" desired time":"2013-06-17T10:25:00.000Z"

}
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Result

200 OK

" id":"a550al2e-ca77-4146-98d0-58960e0939f7"
}

The result of this operation is different if the callback is immediate or schedule. If immediate, some
information may be returned in response along with service id.

200 0K
{
"ID": "0",
"Action": "ConfirmationDialog",
"Text": "You will receive the call shortly",

"OkTitle": "OK",
" id": "361-58ce803e-362c-477f-8ac8-5bbc93f9acc7"

Cancel-Callback

The Cancel-Callback API cancels a Callback request, by doing the following:

» Validates that the request is still in the queue.
e If not, returns the appropriate error.

* If valid, removes the request from the scheduling queue.

¢ Checks the state of the Callback request:

» If _callback_state=QUEUED, a callback cancel event is submitted to the execution service.

» Callback request is marked _callback_state=COMPLETED with _callback_reason=CANCELLED.

DELETE /genesys/1/service/callback/{callback-execution-
name}/{service_ id}

Cancels a Callback request

URI Parameters

Name Type Description
callback-execution-name string Name of the callback execution
*required path service of 'ors' type provisioned
in GMS.
) string This is the service id returned
service_id “meauired path from the initial start callback
response.

False by default. If true, GMS can
discard_ors_failure boolean bypass ORS failures and marks
the cancellation of the callback.
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Set this option to true to manage
troubleshoot cases that happen if the
callback session is exited in ORS while
the record is not marked as COMPLETED in
GMS.

Responses

200 OK
No JSON Body

Name Value
400 Bad Request
Response body (JSON Content)

code 40010

phrase BAD_PARAMETER

e Generic parser exception message: Typically, a
bad date parsing may fall there as a bad
parameter error with the appropriate

message statement.

e Generic missing parameter exception message
(case of controller level detection).

exception com.genesyslab.gsg.services.callback.CallbackExceptionBadParameter

{

"id": <callback id>,

"keys": <missing lookup key>,
properties "day": <specified day value>,

"properties": <lookup properties>,

"option": <invalid option key>

}
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Name

400 Bad Request
Response body (JSON Content)

code

phrase

message

exception

properties

Name

400 Bad Request
Response body (JSON Content)

code

Value

40020

INVALID_OPERATION

e "Callback {id} does not contain _desired_time
property."

e "Callback {id} cannot be cancelled or
completed - callback state={_callback_state}"

e "Callback {id} cannot be cancelled - unable to
process ORS cancel request : {message} "

e "Callback {id} cannot be cancelled - No ORS
session found. (_callback_state=QUEUED while
_ors_session_id=null?)"

e "Rejecting update : {service}=[{id} @ {time}] -
reached state COMPLETED"

com.genesyslab.gsg.services.callback.CallbackExceptioninvalidOperation

{"id": <callback id>,

"service": <service name>,

"time": <ISO UTC time>,

"state": <callback state>,

"message”: <ORS server's message>,
"filter": <filtering expression>

}

Value

40030
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Name Value

phrase CALLBACK_NOT_FOUND

e "Callback {id} cannot be found"

M=zl « "Callback {id} cannot be found - {service}=
[{id} @ {time}]"

exception com.genesyslab.gsg.services.callback.CallbackExceptionNotFound

{

"id": <callback service id>,

properties service": <service name>,
"time": <ISO UTC time>

}
Name Value
500 Internal Server Error
Response body (JSON Content)
code 50030
phrase ORS_ERROR

¢ "Invalid ORS response"

message

e message returned by ORS strategy
exception com.genesyslab.gsg.services.callback.CallbackExceptionFromORS
properties

Name Value

500 Internal Server Error
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Name Value
Response body (JSON Content)

code 50050
phrase UNKNOWN_ERROR
message "Error processing callback {message} "
exception com.genesyslab.gsg.services.callback.CallbackExceptionUnknown
properties { "message": <message catched> }
Examples

DELETE http://localhost:8080/genesys/1/service/callback/BasicCallback/a550al2e-
ca77-4146-98d0-58960e0939f7
Result 200 OK

DELETE http://localhost:8080/genesys/1/service/callback/BasicCallback/a550al2e-
ca77-4146-98d0-58960e0939f7
Result 400 Bad Request

{
"message": "No such request to cancel : [a550al2e-ca77-4146-98d0-58960e0939f7]",

"exception": "com.genesyslab.gsg.services.callback.CallbackException"

}

DELETE http://localhost:8080/genesys/1/service/callback/callback-test/361-cf088d4e-88ab-452c-
aclf-39086cc96¢che
Result 400 Bad Request

{

"message": "Request already cancelled or completed : [361-cf088d4e-88ab-452c-
aclf-39086cc96che]”,

"exception":
"com.genesyslab.gsg.services.callback.exceptions.CallbackExceptionInvalidOperation"

If you set discard ors failure=true, the previous query will get a 200 OK response, though the
error will be logged as an error in ORS.

DELETE http://localhost:8080/genesys/1/service/callback/callback-test/61-cf088d4e-88ab-452c-
aclf-39086cc96chbe?discard ors_failure=true

Result 200 OK

Reschedule-Callback

The Reschedule-Callback APl changes various input parameters associated with a given callback
service. This request will have the Callback request id that is to be updated. This API does the
following:
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¢ Validates that the request is still in the scheduling queue.
e If not, returns the appropriate error.

* If valid, updates the request in the scheduling queue.

Note: The Reschedule operation is available only for requests where callback state=SCHEDULED.

PUT /genesys/1/service/callback/{callback-execution-name}/{service id}

Reschedules a Callback request

Header

application/json
Content-type multipart/form-data

application/x-www-form-urlencoded

URI Parameters

Name Type Description
callback-execution-name string Name of the callback execution
*required path service of 'ors' type provisioned
in GMS.
) string This is the service id returned
service_id ‘Teauired path from the initial start callback
response.

Body (JSON content)

The new time for which to
reschedule the callback.

. . i If provided and validated through office-
_new_desired_time string hours, callback state will be
automatically switched to "scheduled" or
"immediate", discarding
_callback state property.

Possible values are SCHEDULED,
QUEUED, ROUTING, PROCESSING,
COMPLETED.

_callback_state string Note: The new desired time parameter
triggers the re-schedule operation,

discarding the callback state
parameter.

Properties to be updated in

<other properties> any request

Responses

200 OK
No JSON Body
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Name Value

400 Bad Request
Response body (JSON Content)

code 40010

phrase BAD_PARAMETER

e "Callback {id} does not contain the mandatory
customer lookup keys {keys}"

e "Callback {id} does not contain desired time
property."

e "Callback {id} contains desired time
property in the past (-%ds < %ds < %ds) -
epoch %ds"

» "Callback request contains desired time
property too far in future (-%ds < %ds < %ds) -

epoch %ds"
message

e "Cannot create service, missing mandatory
callback option {option}"

e "Cannot create service, empty mandatory
callback option {option}"

e Generic parser exception message: Typically, a
bad date parsing may fall there as a bad

parameter error with the appropriate
statement.

e Generic missing parameter exception message
(case of controller level detection).

exception com.genesyslab.gsg.services.callback.CallbackExceptionBadParameter

{"id": <callback id>,

"keys": <missing lookup key>,
properties "day": <specified day value>,

"properties": <lookup properties>,

"option": <invalid option key> }
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Name

400 Bad Request
Response body (JSON Content)

code

phrase

message

exception

properties

Name

400 Bad Request
Response body (JSON Content)

code

phrase

Value

40020

INVALID_OPERATION

¢ "Invalid service stored for callback {id}."

e "Request cannot be processed because callback
{id} to copy is not COMPLETED. Check
parameter _copy_from_id"

e "Callback {id} is no longer scheduled. State=
{state}"

e "Callback {id} has invalid desired time stored."

e "Rejecting update : {service}=[{id} @ {time}] -
reached state COMPLETED"

com.genesyslab.gsg.services.callback.CallbackExceptionlnvalidOperation

{"id": <callback id>,

"service": <service hame>,

"time": <ISO UTC time>,

"state": <callback state>,

"message": <ORS server's message>,
"filter": <filtering expression>

}

Value

40030

CALLBACK_NOT_FOUND
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Name
message
exception
properties

Name

400 Bad Request
Response body (JSON Content)

code

phrase

message

exception

properties

Value

e "Callback {id} cannot be found"

e "Callback {id} cannot be found - {service}=
[{id} @ {time}]"

com.genesyslab.gsg.services.callback.CallbackExceptionNotFound

{
"id": <callback service id>,
"'service": <service name>,

"time": <ISO UTC time>
}

Value

40050, 40051

e SLOT_UNAVAILABLE (40050)
e SLOT_UNAVAILABLE_PROPOSAL(40051)

¢ "No time slots available."

¢ "Too many requests at desired time slot {slot}.
Proposing time slots."

e "Office is closed at desired time slot {slot}.
Proposing time slots."

com.genesyslab.gsg.services.callback.CallbackExceptionAvailability
{

"slot": <ISO UTC time range>,

'service": <service name>

}
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Name

500 Internal Server Error
Response body (JSON Content)

code

phrase

message

exception

properties

Value

50020

BAD_CONFIGURATION

» "Service option {service} / _default_country is
not configured. But option
_disallow_impossible_phone_numbers is set. We
cannot validate phone numbers without
knowing the country."

e "Service option {service} / _default_country is
not configured. But option
_disallow_premium_phone_numbers is set. We
cannot validate phone numbers without
knowing the country."

e "Unable to parse option:
_request_queue_time_stat={statistic}"

* "Missing default_chat_endpoint option in chat
section because this service has parameter
_media_type=chat"

e "Missing default client_timeout option in chat
section because this service has parameter
_media_type=chat"

e "Option service.{service} /
_business_hours_service not configured."

e "Option _business_hours_service is invalid:
{message}"

e "Service undefined: {service}"

e "Service {service} has unknown value for
option _type"

e "Service {service} has option _type != ors"

e "Service {service} has option _service !=
callback"

com.genesyslab.gsg.services.callback.CallbackExceptionConfiguration

{
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Name

Name

500 Internal Server Error
Response body (JSON Content)

code
phrase
message

exception

properties

Name

500 Internal Server Error
Response body (JSON Content)

code
phrase
message

exception

properties

Value

'service": <service name>

}

Value

50005

CALENDAR_ERROR

message returned by Calendar service

com.genesyslab.gsg.services.callback.CallbackExceptionCalendarError

Value

50004

CAPACITY_ERROR

message returned by Capacity service

com.genesyslab.gsg.services.callback.CallbackExceptionCapacityError
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Name

500 Internal Server Error
Response body (JSON Content)

code

phrase

message

exception

properties

Name

400 Bad Request
Response body (JSON Content)

code

phrase

message

exception

properties

Value

50030

ORS_ERROR

e "Invalid ORS response"

* message returned by ORS strategy

com.genesyslab.gsg.services.callback.CallbackExceptionFromORS

Value

40040

NUMBER_REJECTED

e "Customer Number is not allowed, because it is
invalid. Check option "Customer Number is not
allowed, because it is invalid. Check option
_disallow_impossible_phone_numbers"

* "Customer Number is not allowed, because it's a
premium number. Check option
_disallow_premium_phone_numbers"

e "Customer Number is not allowed, because it
failed validating. Check option
_disallow_impossible_phone_numbers"

e "Customer Number is not allowed. Check option
_exceptions"

com.genesyslab.gsg.services.callback.CallbackExceptionNumber
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Name

500 Internal Server Error
Response body (JSON Content)

code 50050
phrase UNKNOWN_ERROR
message "Error processing callback {message} "
exception com.genesyslab.gsg.services.callback.CallbackExceptionUnknown
properties { "message": <message catched> }
Examples

Successful Rescheduling

PUT http://localhost:8080/genesys/1/service/callback/
BasicCallback/a550al2e-ca77-4146-98d0-58960e0939f7

" new desired time":"2013-05-27T15:05:00.000Z"
}
Result
200 0K

Failed Rescheduling

PUT http://localhost:8080/genesys/1/service/callback
/callback-test/361-d61e636da-3109-436c-877e-8d7174277bb9

{

}
Result
400 Bad Request

{

"message": "Callback '361-738dadcb-9d20-4557-8e24-fddb82f9c1b8'
is no longer scheduled. State=PROCESSING",

"exception": "com.genesyslab.gsg.services.callback.exceptions
.CallbackExceptionInvalidOperation"

}

" new desired time":"2014-07-22T10:00:00.000Z"

No availability

PUT http://localhost:8080/genesys/1/service
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/callback/BasicCallback/a550al2e-ca77-4146-98d0-58960e0939f7
{
" new desired time":"2013-05-27T16:45:00.000Z"
}
Result
400 Bad Request

{

"message": "Too many requests at desired time
[2013-05-27T16:45:00.000Z, 2013-05-27T16:50:00.000Z].
Proposing time slots.",

"exception": "com.genesyslab.gsg.services.callback
.CallbackExceptionAvailability",

"availability":

{

"2013-05-27T16:50:00.000Z":
"2013-05-27T16:35:00.000Z":
"2013-05-27T16:40:00.000Z":
"2013-05-27T16:55:00.000Z":
"2013-05-27T16:25:00.000Z":
"2013-05-27T16:30:00.000Z":

uuTwuruu,

}
Sample operation typically performed by ORS execution

PUT http://localhost:8080/genesys/1/service/callback
/callback-test/361-738dadcb-9d20-4557-8e24-fddb82f9c1b8

" callback state":"PROCESSING",
Ilireasonll : nn

}
Result
200 0K

{}

Delete Callback (Forget Me)
Introduced in 8.5.201

Deletes one or more Callback Service instance(s) by passing service IDs or Customer Numbers. You
can delete a Callback only if it is in SCHEDULED or COMPLETED status. This APl enables you to support
General Data Protection Regulation and enables you to "forget" customers.

To use this query, you need Basic Authentication. Therefore, you must provide the authentication
credentials in the auth parameter of the operation. There are two ways to provide credentials in an
auth object:

* In an open form containing the username and password fields of a user defined in the Configuration
Server.

¢ In an encoded form using encoded fields, similar to the Basic Authentication header, which is a
Base64-encoded composite string of "username:password".

POST /genesys/1/admin/callback/ops/delete
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Deletes one or more callback request(s).

Header

Content-type application/json

Body (JSON content)

_customer_number String array
_id String array
Responses
Name Description
200 OK

Response Body (JSON content)

success
required Array
errors
required Array

List of Customer Numbers or
Service IDs that identify the
callback service instances that
must be deleted.

List of service IDs that identify
the callback service instances
that must be deleted.

Array of service IDs and
Customer Numbers that were
deleted or were considered as
successful with a reason.
[{ " id": "68542134" },
{ "reason": "no
callback(s) to delete",
" customer number":
"132456" } 1]

Array of service IDs and
Customer Numbers that were
not deleted with the associated
error codes.
[{ "non-existing-lookup-
key": "132456", "code":
40010, "phrase":
"BAD PARAMETER",
"message": "No such
lookup possible for
{properties}" },

{ "code": 40020, "phrase":
"INVALID_OPERATION", "_id":
"118-576b21b4-a235-4ba5-92d4-102cbbb54bca",
"message": "Callback
118-576b21b4-a235-4ba5-92d4-102cbbb54bca
cannot be deleted -
_callback_state=PROCESSING" } ]
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Name

500 Internal Server Error
Response body (JSON Content)

code

phrase

message

exception

properties

Value

50020

BAD_CONFIGURATION

e "Service option {service} / _default_country is
not configured. But option
_disallow_impossible_phone_numbers is set. We
cannot validate phone numbers without
knowing the country."

e "Service option {service} / default_country is
not configured. But option
_disallow_premium_phone_numbers is set. We
cannot validate phone numbers without
knowing the country."

¢ "Unable to parse option:
_request_queue_time_stat={statistic}"

e "Missing default_chat _endpoint option in chat
section because this service has parameter
_media_type=chat"

e "Missing default _client_timeout option in chat
section because this service has parameter
_media_type=chat"

e "Option service.{service} /
_business_hours_service not configured."

e "Option _business_hours_service is invalid:
{message}"

e "Service undefined: {service}"

e "Service {service} has unknown value for
option _type"

e "Service {service} has option _type != ors"

e "Service {service} has option _service !=
callback"

com.genesyslab.gsg.services.callback.CallbackExceptionConfiguration

{

'service": <service name>

}
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Name Value
400 Bad Request
Response body (JSON Content)

code 40010

phrase BAD_PARAMETER

e "No such lookup possible for {properties}"
¢ "No lookup possible. No properties to look for."

e Generic parser exception message: Typically, a
bad date parsing may result in a bad parameter
error with the appropriate statement.

message

* Generic missing parameter exception message
(case of controller level detection).

exception com.genesyslab.gsg.services.callback.CallbackExceptionBadParameter

{

"id": <callback id>,

"keys": <missing lookup key>,
properties "day": <specified day value>,

"properties": <lookup properties>,

"option": <invalid option key>

}

Name Value
400 Bad Request
Response body (JSON Content)

code 40020
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Name Value
phrase INVALID_OPERATION
message "Cannot process 'filter' parameter correctly : {filter}"
exception com.genesyslab.gsg.services.callback.CallbackExceptioninvalidOperation

{"id": <callback id>,
"service": <service name>,
"time": <ISO UTC time>,
properties state": <callback state>,
"message": <ORS server's message>,

"filter": <filtering expression>

}

Name Value
500 Internal Server Error
Response body (JSON Content)
code 50050
phrase UNKNOWN_ERROR
message "Error processing callback {message} "
exception com.genesyslab.gsg.services.callback.CallbackExceptionUnknown
properties { "message": <message catched> }

Example

POST http://localhost:8080/genesys/1/admin/callback/ops/delete
{
" id": ["118-576b21b4-a235-4ba5-92d4-102cbbb54bca"],
" customer number": [
"132456",
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"1111" ,
||3333||

Result

Response: 200 0K

{
"success": [
{
"reason": "no callback(s) to delete",
" customer number": "132456"
}I
{
" id": "118-27f3bed5-6e3a-4c89-903f-dae562b30481"
}I
{
" id": "118-c2ce7a84-d33a-4d8d-88a0-b76a563f2324"
}
]I
"errors": [
{

"code": 40020,

"phrase": "INVALID OPERATION",

" id": "118-576b21b4-a235-4ba5-92d4-102cbbb54bca",

"message": "Callback 118-576b21b4-a235-4ba5-92d4-102cbbb54bca cannot
be deleted - callback state=PROCESSING"

}
]

Query Callback By ID
Introduced in 8.5.207
Retrieves a callback request by its ID.
GET /genesys/2/service/callback/{callback-execution-name}/{id}
Queries the outstanding callback associated with a given ID.

URI Parameters

Name Type Description
callback-execution-name string Name of the callback execution
*required path service of 'ors' type provisioned
in GMS.
) string
ig “required path Callback ID.
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Responses

Name

200 OK
Response Body (JSON content)

<none>

Name

400 Bad Request
Response body (JSON Content)

code

phrase

message

exception

properties

Description

* |f accepted, the currently outstanding callback
request.

" id": <callback id>,
"desired time": <ISO UTC time>,
"url": <service URL>,
" expiration time": <ISO UTC time>,
" service name": <service-name>,
" _customer_number": <customer
number>,
" callback state": <callback state>,
" time scheduled": <ISO UTC time>
}
]

¢ |If not, an error code indicating the reason.

Value

40010

BAD_PARAMETER

¢ "No such lookup possible for {properties}"
* "No lookup possible. No properties to look for."

e Generic parser exception message: Typically, a
bad date parsing may result in a bad parameter
error with the appropriate statement.

e Generic missing parameter exception message
(case of controller level detection).

com.genesyslab.gsg.services.callback.CallbackExceptionBadParameter

{
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Name Value
"id": <callback id>,

"keys": <missing lookup key>,
"day": <specified day value>,
"properties": <lookup properties>,

"option": <invalid option key>

}

Name Value
400 Bad Request
Response body (JSON Content)
code 40020
phrase INVALID_OPERATION
message "Cannot process 'filter' parameter correctly : {filter}"
exception com.genesyslab.gsg.services.callback.CallbackExceptioninvalidOperation

{"id": <callback id>,
'service": <service name>,
"time": <ISO UTC time>,
properties state": <callback state>,
"message": <ORS server's message>,

"filter": <filtering expression>

}

Name Value

500 Internal Server Error
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Name
Response body (JSON Content)

code
phrase
message
exception

properties

Example

Value

50050

UNKNOWN_ERROR

"Error processing callback {message} "

com.genesyslab.gsg.services.callback.CallbackExceptionUnknown

{ "message": <message catched> }

GET http://localhost:8080/genesys/1/service/callback/BasicCallback/120-07f85068-650d-4cce-

a5e7-396dfa22455b

Result
200 OK

{
" callback state": "SCHEDULED",

" expiration time": "2020-05-11T11:59:59.000Z",
service name": "BasicCallback",

"id": "124-07f85068-650d-4cce-a5e7-396dfa22455f",

" customer number": "12345",

" url": "/genesys/1l/service/callback/BasicCallback/120-07f85068-650d-4cce-

a5e7-396dfa22455b",

" time scheduled": "2020-04-16T12:52:31.5217",
" desired time": "2020-04-27T12:00:00.000Z"

}

Query-Callback by Lookup Properties

Modified in 8.5.111
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The Query-Callback API queries the current set of outstanding Callback services associated with a given property.
Notes:

¢ Qutstanding Callback services are requests where callback state is one of the following values: SCHEDULED, QUEUED, ROUTING, PROCESSING,
COMPLETED.

* Properties allowing the Callback request trackback are defined as comma-separated keys with the service option _customer_lookup_ keys.

The API returns each callback for which the looked-up property is or was equal to the value specified in the requested property.

Starting in 8.5.111, you can configure the list of values to be retrieved when calling this query by setting the returned-keys option at the GMS application
level.

e To use the customer number lookup property regardless of whether you specify a callback service name or not in the API URL, the
_fix_plus_on_int_phone_numbers option must be identical in the callback section and in each service-specific section.

e This is the expected behavior if you stick to defaults.

* If a callback service has a distinct value for _fix_plus_on_int_phone_numbers, you can only use the customer_number lookup property by specifying
the service name in the API URL.

GET /genesys/1/service/callback/{callback-execution-name}?{property=value}

GET /genesys/1/service/callback? {property=value}

Queries the current set of outstanding Callback services associated with a given property.

URI Parameters

Name Type Description
callback-execution-name string th Name of the callback execution service of 'ors'
pa type provisioned in GMS.
tri This is a property name used to query the
_value “redtired =iy " callback. Properties allowing the Callback request
property=value pa trackback are defined as comma-separated keys

with the service option _customer_lookup_keys.
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operand

_callback_state

Since 8.5.101.03

_desired_time_from

Since 8.5.101.03

string

string

string

If you specify several properties, you may need to use the
operand property.

Operand to use for the properties defined in the
service option _customer_lookup_keys. Possible
values are AND or OR. Default is AND.

When multiple property=value are provided in the query, the
operand specifies which operation to perform on matched
Callback requests:

* AND means that all property=value must
match;

* OR means any property=value can match.

Specifies a unique state to filter onto. For example:

e callback state='COMPLETED' filters
callbacks and returns only callbacks in
COMPLETED state.

e callback state='!COMPLETED" filter
callbacks and only return the ones that are not
COMPLETED.

The character "!" is used to negate a case.

You can query the following callback states: SCHEDULED,
QUEUED, ROUTING, PROCESSING, COMPLETED.

Specifies I1SO timestamps. All callback matching lookup
properties that were scheduled before this time will be filtered
out.
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_desired_time_to Specifies 1SO timestamps. All callback matching lookup

Since 8.5.101.03 string gzc;.pertles that were scheduled after this time will be filtered
Responses
Name Type Description

Response Body (JSON content)

e |f accepted, JSON array of service IDs of the
currently outstanding callback requests.

{
" id": <callback id>,
"desired time": <ISO UTC time>,
" callback state": <callback
state>,
<none> " expiration time":<ISO UTC time>,
" customer number": <customer
number>,
"url": <service URL>
}l

]

¢ |If not, an error code indicating the reason.
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Name Value
400 Bad Request
Response body (JSON Content)
code 40010
phrase BAD_PARAMETER

* "No such lookup possible for {properties}"
* "No lookup possible. No properties to look for."

message e Generic parser exception message: Typically, a bad date parsing may
result in a bad parameter error with the appropriate statement.

e Generic missing parameter exception message (case of controller level
detection).

exception com.genesyslab.gsg.services.callback.CallbackExceptionBadParameter

{

"id": <callback id>,

"keys": <missing lookup key>,

properties "day": <specified day value>,
"properties": <lookup properties>,
"option": <invalid option key>

}
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Name

400 Bad Request
Response body (JSON Content)

code
phrase
message

exception

properties

Value

40020

INVALID_OPERATION

"Cannot process 'filter' parameter correctly : {filter}"

com.genesyslab.gsg.services.callback.CallbackExceptioninvalidOperation

{"id": <callback id>,

"service": <service name>,

"time": <ISO UTC time>,

"state": <callback state>,

"message": <ORS server's message>,
"filter": <filtering expression>

}
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Name

500 Internal Server Error
Response body (JSON Content)

code
phrase
message
exception

properties

Example

GET http://localhost:8080/genesys/1/service/callback
/BasicCallback? customer number=555-5461206

Result

200 OK
[

{
" id": "a550al2e-ca77-4146-98d0-58960e0939f7",

"desired time": "2013-05-27T15:05:00.000Z",

" callback state": "QUEUED",

" expiration time": "2014-11-03T18:36:45.000Z"
" customer number": "555-5461206",

’

Value

50050

UNKNOWN_ERROR

"Error processing callback {message} "

com.genesyslab.gsg.services.callback.CallbackExceptionUnknown

{ "message": <message catched> }

"url": "/1/service/callback/BasicCallback/a550al2e-ca77-4146-98d0-58960e0939f7"
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" id": "4alea889-1lef7-432d-a543-cff96b4a2daf",

"desired time": "2013-05-27T15:10:00.000Z",

" callback state": "SCHEDULED",

" expiration time": "2014-11-03T18:36:45.000Z",

" customer number": "555-5461206",

"url": "/1/service/callback/BasicCallback/4aleaB889-1ef7-432d-a543-cff96b4a2daf"
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Query-Availability

v1

Query-Availability v1

This query returns a simple map of slots in which the office capacity is not full.

GET /genesys/1/service/callback/{callback-execution-name}/availability

Returns a simple map of slots in which the office capacity is not full.

URI Parameters

Name

callback-execution-name
*required

JSON Body

start

timestamp

number-of-days

end

max-time-slots

Type

string
path

date

date

integer

date

integer

Description

Name of the callback execution
service of 'ors' type provisioned
in GMS.

Start date is specified in IS0
8601 format, using UTC as the
timezone: yyyy-MM-
ddTHH:mm:ss.SSSZ. If not
specified, it is assumed to be
now.

Alias to start parameter; kept
for compatibility reasons.

Used as an alternative to the end
date. If neither end nor number-
of-days is specified, the end
date is assumed to be the same
as the start date.

End date is specified in ISO 8601
format, using UTC as timezone:
yyyy-MM-ddTHH:mm:ss.SSSZ. If
neither end nor number-of-days
is specified, the end date is
assumed to be the same as the
start date.

Maximum number of time slots
to be included in the response
when the office is open and
capacity is above zero. It can be
used to improve the performance
of the query over a long period of
time.
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If neither of the parameters number-of-days and end parameters are specified, the
default time range matches 1 bucket only (as configured in the request time_bucket
service option).

Request example:

GET http://localhost:8080/genesys/1/service/callback/Callback VQ/
availability?start=2014-12-03T15:00:00.000Z

Response

The Callback controller provides a facet to the availability service, which uses the calendar service
underneath. Just as the calendar service takes three non-mandatory input parameters (start, number-
of-days, end), the availability service should accept the same parameters and pass them on to the
calendar service.

e The response contains a map of time slots and capacity counters.
¢ The slots are ordered in ascending order.

¢ Any time slots where the capacity is full (for example, zero) are not provided in the response. Similarly,
if the office is closed, those time slots are not provided in the response.

200 OK
{

// All periods are ordered in ascending time order
"2014-10-17T13:00:00.000Z":"5",
"2014-10-17T13:10:00.000Z":"4",

// there were no agents available between 13:20 and 13:30 UTC
//hence the time slot is not reported
"2014-10-17T13:30:00.000Z":"5"

V2

Query-Availability v2

This query includes more query options than v1 and returns an array of ordered slots that include
detailed capacity information and timezone information.

GET /genesys/2/service/callback/{callback-execution-name}/availability
Returns an array of ordered slots that include detailed capacity information and timezone
information.

URI Parameters

Callback User's Guide 296



Callback Services API

Forget Me (GDPR)

Name Type
callback-execution-name string
*required path
start date
start-ms long
number-of-days integer
end date
end-ms long

Description

Name of the callback execution
service of 'ors' type provisioned
in GMS.

Start date in the "ISO 8601"
format, using the UTC timezone:
"yyyy-MM-ddTHH:mm:ss.SSSZ".
If not specified, the default start
date is the date on which the
query was submitted.

e |f you set the start
parameter, do not set the
start-ms or timestamp
parameters.

* You must also set the end or
number-of-days parameter;
otherwise, the end date is
assumed to be the start
date.

Start date in epoch time, that is,
the number of milliseconds since
00:00:00, Thursday, 1
January 1970 (UTC).

¢ You must also set the end-ms
or number-of-days
parameter; otherwise, the
end date is assumed to be
the start-ms date.

e If you set the start-ms
parameter, do not set the
start or timestamp
parameters.

Number of days used to define
the availability period starting at
the start or start-ms date. You
can use this parameter instead of
the end or of the end-ms
parameter.

End date, in "ISO 8601" format,
using the UTC timezone: yyyy-
MM-ddTHH:mm:ss.SSSZ. By
default, if neither the "end" nor
the "number-of-days" parameter
is specified, then the end date is
assumed to be the start date.

End date in epoch time, that is
the number of milliseconds since
00:00:00, Thursday, 1
January 1970 (UTC).
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max-time-slots

timezone

report-busy

JSON body: None.

Set only one of the end, end-ms, or
number-of-days parameters.

Maximum number of time slots
to include in the response if the
office is open and the capacity
greater than zero. You can use
this parameter to improve query
performance over a lengthy
period of time.

Timezone for the start and end
date parameters. Additionally,
the response object will return
the localTime fields formatted in
this timezone.

If true, the response includes the
slots where the office is open and
where callbacks are booked to
full capacity. By default, report-
busy is false.

If neither of the parameters number-of-days, end, and end-ms parameters are
specified, the default time range matches 1 bucket only (as configured in the

_request_time_bucket service option).

Responses

If successful, the response returns multiple values that describe the slots, availability, and capacity

for a given slot.

Name

200 OK
Response Body (JSON content)

slots
required

String array of slots

Description

Array of ordered slots and each slot
includes the minute duration
(durMinutes), and the timezone.

e The array of slots includes
detailed information about
each slot.

e Slots are sorted in ascending
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Name

Name

400 Bad Request
Response body (JSON Content)

code

Type

40010

Description

order by their time.

¢ Slots are all the same
duration, specified in the
durMinutes value.

e The "timezone" value
specifies the timezone used
for the "localTime" fields in
slots' information.

{
"slots": [
{
"utcTime": <UTC time>,
"localTime": <UTC
time>,

"capacity": <capacity>,
"total": <total>
}I
(.o.) 1
"durationMin": <duration
in minutes>,
"timezone": <timezone>

}

Each slot includes:

e "utcTime" specifies when this
slot begins in UTC time.

¢ "localTime" reports the same
time as "utctime", but
formatted using the
"timezone" set in the request.

e "capacity" value is the
number of available callbacks
that can be scheduled within
this timeslot.

e "total" is the total capacity
that is configured for this
timeslot.

Value
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Name Value

phrase BAD_PARAMETER

e "day parameter must be between 1 and 7,
inclusively. Actual value is: {day}"

* "No time slots available. The requested time
period is in the past."

message e Generic parser exception message: Typically, a
bad date parsing may fall there as a bad
parameter error with the appropriate
statement.

e Generic missing parameter exception message
(case of controller level detection).

exception com.genesyslab.gsg.services.callback.CallbackExceptionBadParameter

{

"id": <callback id>,

"keys": <missing lookup key>,
properties "day": <specified day value>,

"properties": <lookup properties>,

"option": <invalid option key>

}

Name Value
400 Bad Request
Response body (JSON Content)

code 40050, 40051

* SLOT_UNAVAILABLE (40050)
e SLOT_UNAVAILABLE_PROPOSAL(40051)

phrase

¢ "No time slots available."
message

¢ "Too many requests at desired time slot {slot}.
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Name Value

Proposing time slots."

e "Office is closed at desired time slot {slot}.
Proposing time slots."

exception com.genesyslab.gsg.services.callback.CallbackExceptionAvailability
{
"slot": <ISO UTC time range>,

FITE DEITIEE 'service": <service name>
}

Name Value

500 Internal Server Error

Response body (JSON Content)

code 50020

phrase BAD_CONFIGURATION

e "Option service.{service} /
_business_hours_service not configured."

e "Option _business_hours_service is invalid:

{message}"
e "Service undefined: {service}"
message . }
e "Service {service} has unknown value for
option _type"
» "Service {service} has option _type != ors"
e "Service {service} has option _service !=
callback"
exception com.genesyslab.gsg.services.callback.CallbackExceptionConfiguration
{
properties

'service": <service name>
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Name

Name

500 Internal Server Error
Response body (JSON Content)

code
phrase
message

exception

properties

Name

500 Internal Server Error
Response body (JSON Content)

code
phrase
message

exception

properties

Value

Value

50005

CALENDAR_ERROR

message returned by Calendar service

com.genesyslab.gsg.services.callback.CallbackExceptionCalendarError

Value

50004

CAPACITY_ERROR

message returned by Capacity service

com.genesyslab.gsg.services.callback.CallbackExceptionCapacityError
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Name Value

500 Internal Server Error
Response body (JSON Content)

code 50050
phrase UNKNOWN_ERROR
message "Error processing callback {message} "
exception com.genesyslab.gsg.services.callback.CallbackExceptionUnknown
properties { "message": <message catched> }

Examples

Request example:

http://localhost:8010/genesys/2/service/callback/callback-PST
/availability?start=2016-04-13T09:00:00.000&end=2016-04-13T16:00:00.000
&timezone=America/Toronto

"slots": [
{
"utcTime": "2016-04-13T13:00:00.000Z",
"localTime": "2016-04-13T09:00:00.000",
"capacity": 42,
"total": 100

"utcTime": "2016-04-13T13:05:00.000Z",
"localTime": "2016-04-13T09:05:00.000",
"capacity": 67,

"total": 100

"utcTime": "2016-04-13T13:10:00.000Z",
"localTime": "2016-04-13T09:10:00.000",
"capacity": 91,

"total": 100

]l
"durationMin": 5,
"timezone": "Eastern Standard Time"

}

Callback User's Guide 303



Callback Services API Forget Me (GDPR)

Existing calendar configurations must be updated for the time zone definition. Instead
of EST or PST time zones that were configured using Configuration Manager, you must
use time zones as allowed in Java (http://en.wikipedia.org/wiki/

List of tz database time zones), such as America/Toronto, or Europe/Paris. You
must also change the service option type from ors to builtin.

Query-Callback by Queue(s)
Modified in 8.5.111

The Query-Callback API queries the current set of outstanding Callback services in the given
queue(s).

Starting in 8.5.111, you can filter and configure the list of values to be passed and retrieved when
calling this query through the following options at the GMS application level: returned-keys and filter-
keys.

Outstanding Callback services are requested if their _callback state is one of the
following values: SCHEDULED, QUEUED, ROUTING, PROCESSING, COMPLETED.

To use this query, you need Basic Authentication. Therefore, you must provide the authentication
credentials in the auth parameter of the operation. There are two ways to provide credentials in an
auth object:

¢ In an open form containing the username and password fields of a user defined in the Configuration
Server.

* In an encoded form using encoded fields, similar to the Basic Authentication header, which is a
Base64-encoded composite string of "username:password".

GET /genesys/1/admin/callback/queues?target={callback-execution-
name} st time={iso_start time}&end time={iso_end time}

Queries the current set of outstanding Callback services in given queue(s).
URI Parameters

Name Type Description
{iso_start_time} string This is the minimum time for
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{iso_end_time} string

{states} string

{max} integer
callback-execution-name string

{max} integer

Responses
Name Mandatory

200 OK

Response Body (JSON content)

which to query callback requests.

The format is ISO 8601 "yyyy-MM-
ddTHH:mm:ss.SSSZ".

For example:
"2013-05-27T15:30:00.000Z"

This is the maximum time for
which to query callback requests.

If not specified, requests that are due in
the next 24 hours are returned.

The format is ISO 8601 "yyyy-MM-
ddTHH:mm:ss.SSSZ".

For example:
"2013-05-28T15:30:00.000Z"

Comma-separated list of callback
states used to filter the returned
results. For example, if
states=SCHEDULED, QUEUED, only
scheduled and queued callbacks
are returned.

If not specified, all the callbacks of the
given queue are returned.

This is the maximum number of
requests to return for each
queue.

If not specified, 500 maximum requests
per queue are returned.

Name of the callback execution
service provisioned in GMS. For
example, BasicCallback.

If not specified, the queues for all
services are returned.

This is the maximum number of
requests to return for each
queue.

If not specified, 500 maximum requests
per queue are returned.

Description
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Name Mandatory Description

If accepted, a tree list of target queues
and the following properties:

<Queue name>: {

" customer_number":
<customer number>,

List of target queues " callback state": <callback
required string state>,

" _desired_time": <callback
UTC desired time>,

" id": <callback service id>,
"url": <request>

}

Name Value

400 Bad Request
Response body (JSON Content)

code 40020
phrase INVALID_OPERATION

"Query range spans too wide time range (%d / %d). Adjust

IS query parameters for time range."

exception com.genesyslab.gsg.services.callback.CallbackExceptioninvalidOperation
{"id": <callback id>,
'service": <service name>,
“time": <ISO UTC time>,

properties “state": <callback state>,

"message": <ORS server's message>,
"filter": <filtering expression>

}
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Name Value

500 Internal Server Error
Response body (JSON Content)

code 50050
phrase UNKNOWN_ERROR
message "Error processing callback {message} "
exception com.genesyslab.gsg.services.callback.CallbackExceptionUnknown
properties { "message": <message catched> }
Example

GET http://localhost:8080/genesys/1/admin/callback/queues

Result
200 0K
"BasicCallback":
[
{
" customer number": "654321",
" callback state": "PROCESSING",
" desired time": "2013-06-07T16:25:00.000Z",
" id": "fd30abb97bd04885b544893276fb534b",
"url": "/1/service/callback/BasicCallback/fd30abb97bd04885b544893276fb534b"
)
] r
"AdvancedCallback":
[
{
" customer number": "654321",
" callback state": "QUEUED",
" desired time": "2013-06-07T16:35:00.000Z",
" id": "07d2ddd506f04b4ba9laba59c4fa8871",
"url": "/1/service/callback/AdvancedCallback/07d2ddd506f04b4ba91laba59c4fa8871"
I
{

_customer number": "654321",

" callback state": "SCHEDULED",

" desired time": "2013-06-07T16:45:00.000Z",

" id": "8f68d4969d904d039ccf0101fac39283",

"url": "/1/service/callback/AdvancedCallback/8f68d4969d904d039ccf0101fac39283"
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Query Counter Watermarks

This query counts the current set of executed callback instances per queues or for a given queue.
Executed callback instances are:

¢ Callbacks that are in execution within ORS
e Callbacks do not have their callback state property set to SCHEDULED

e Callbacks do not have their callback state property set to COMPLETED in GMS storage. Callbacks in
such a state for more than 3 hours are discarded.

To use this query, you need Basic Authentication. Therefore, you must provide the authentication
credentials in the auth parameter of the operation. There are two ways to provide credentials in an
auth object:

* In an open form containing the username and password fields of a user defined in the Configuration
Server.

¢ In an encoded form using encoded fields, similar to the Basic Authentication header, which is a
Base64-encoded composite string of "username:password".

You can use this API to ensure that you do not book more Callbacks than you have
licenses for.

GET /genesys/1/admin/callback/watermarks?service_name={callback-
execution-name}

GET /genesys/1/admin/callback/watermarks

Counts the current set of executed callback instances per queues or for a given queue.

URI Parameters
Name Type Description

Name of a callback execution
service. If you set this parameter,
the response will return the
watermarks for the specified
service only. If the service name
is not set, the response returns

{callback-execution-name} string
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the total count of executed
callback instances in queues and
the count per service.

You can query watermarks for several
services in a single query. To do so, add
as many service name values as you
need to your query:

GET /genesys/1/admin/
callback/
watermarks?service name=servicel&service nam

Responses
HTTP code 200
HTTP message OK

If accepted, a list of target queues and the count of
callbacks that are in execution within ORS or that
do not have their callback state property set to
SCHEDULED or COMPLETED) in GMS storage.

{

"total": <total of callbacks in
progress>,
"services": {
<service-1>: <number of callbacks in
progress for service-1 >,

Response Body (JSON content)

<service-n>: <number of callbacks in
progress for service-n>,

b

Name Value
500 Internal Server Error
Response body (JSON Content)
code 50050
phrase UNKNOWN_ERROR
message "Error processing callback {message} "
exception com.genesyslab.gsg.services.callback.CallbackExceptionUnknown
properties { "message": <message catched> }
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Example

Operation
GET http://localhost:8080/genesys/1/admin/callback/watermarks
Result
200 OK
{
"total": 1,
"services": {
"callback-immediate": 0,
"callback-test": 1

}
}

GET http://localhost:8080/genesys/1/admin/callback/watermarks?service name=callback-immediate
Result
200 OK

"total": O,

"services": {
"callback-immediate": 0
}

}

Check in Queue Position

This query enables your application to query for the position and Estimated Wait Time while the GMS
Service request is in QUEUED status. This query is used to provide additional details in the Callback UlI.

Name Type Description

POST /genesys/1/service/{callback-service-id}/check-queue-position

BODY Parameters

{callback-service-id} ID of the callback execution
required string service. For example,
445-f4fab53ec-8e93-4836-ba35-f0bd74a025a8.

The GET method is also supported for this feature.
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Response

HTTP code
HTTP message

Response Body (JSON content)

200

OK

JSON-formatted information for the given service ID:

app_version: Callback strategy version.
wt: The time that the call has waited in queue.
connid: Interaction ID in the Virtual Queue.

ewt: The estimated time that customer will wait
for the callback.

positioninqueue: The callback's current
position in the queue.

_position: position of the interaction in the
virtual queue (top position = 1).

_eta: estimated wait time to the agent
availability.

_total waiting: total number of requests
waiting in queue.

priority: The callback priority in the Virtual
Queue.

agents logged in: The number of agents that
have logged in.

ors_session_id: ORS session ID of the
callback.

ewt at offer: The estimated wait time when
the callback is offered.

pos at offer: The callback's position in the
queue when the callback is offered.

callback type: The type of callback.

time callback accepted: The time when the
callback is accepted.

channel: The callback channel.

skill expression: The callback's target or skill
expression.

ewt at first dial: The estimated wait time
when the first outbound call happened.

pos_at first dial: The callback's position in
the queue when the first outbound call
happened.

time at first dial: The time when the first
outbound call happened.
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e dial attempt: The number of dials that agent
has attempted.

* is snoozed: If true, shows that the callback is
snoozed.

e dial result: The result of callback dial.

e time customer connected: The time when the
customer connected.

Errors

Name Value

500 Internal Server Error
Response body (JSON Content)

code 50050
phrase UNKNOWN_ERROR
message "Error processing callback {message} "
exception com.genesyslab.gsg.services.callback.CallbackExceptionUnknown
properties { "message": <message catched> }
Example
Operation

POST /genesys/1/service/445-f4fa53ec-8e93-4836-ba35-f0bd74a025a8/check-queue-position HTTP/1.1
Connection: close

Content-Length: 0

Content-Type: application/x-www-form-urlencoded; charset=UTF-8

Response:

200 0K

{
"app_version":"v2.41",
"wt":26,
"connid":"006e02aea54bc008",
"ewt":0,

"positioninqueue":0,
" position":1,

" eta":0,

" total waiting":1,
"priority":500,
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"agents logged in":3,

"ors_session id":"QOACLUSNOOCV19601KO15B5AESO00003",
"ewt at offer":0,

"pos at offer":0,

"callback type":"WAIT FOR AGENT",

"time callback accepted":1508959666,
"channel":"WEB",

"skill expression":"GMSCallbackAgents@stat.GA",
"ewt at first dial":"100.0",

"pos at first dial":"1",

"time at first dial":1508959684,

"dial attempt":1,

"is snoozed":false,

"dial result":"PERSON",

"time customer connected":1508959690

Export Cancelled Callback Records

Added in: 8.5.110
This query exports the callbacks that were cancelled by the Service Management Ul only (Bulk
Cancel).

e The data will be exported in CSV format.

e The request will export the records cancelled from the last 30 days to the next 15 days.

¢ You can export additional fields with the retrieved callback records.

By default, the CSV report includes the following default properties: desired time, service name,
_customer _number, urs virtual queue, vq for outbound calls, and target.

To use this query, you need Basic Authentication. Therefore, you must provide the authentication
credentials in the auth parameter of the operation. There are two ways to provide credentials in an
auth object:

* In an open form containing the username and password fields of a user defined in the Configuration
Server.

* In an encoded form using encoded fields, similar to the Basic Authentication header, which is a
Base64-encoded composite string of "username:password".

Name Type Description

POST /genesys/1/admin/callback/reportcancelled

BODY Parameters

callback reason The reason for the cancellation.
required' string For example,
CANCELLED BY ADMIN.
exported_properties string List of properties to export for

Callback User's Guide 313



Callback Services API Forget Me (GDPR)

Name Type Description

each selected record. For
example:
["_service_id,_desired_time"]. If
this parameter is empty or
missing, the following properties
will be exported by default:
_desired time, service name,
_customer_ number,

urs virtual queue,

~vq_for outbound calls, and

target.
Response
HTTP code 200
HTTP message oK

CSV-formatted results for exported records:
<property-1>,<property-2>,...,<property-n>

<record-1-propertyl>,<record-1-property2>,...,<record-1-pr

Response Body (JSON content)

<record-n-propertyl>,<record-n-
property2>,...,<record-n-propertyn>

Errors
HTTP code 400
HTTP message Callback reason is missing.
HTTP code 204
HTTP message No record found.

Name Value

500 Internal Server Error
Response body (JSON Content)

code 50050

phrase UNKNOWN_ERROR

message "Error processing callback {message} "

exception com.genesyslab.gsg.services.callback.CallbackExceptionUnknown
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Name Value

properties { "message": <message catched> }

Example

Operation

POST /genesys/1/admin/callback/reportcancelled

{
"callback reason": "CANCELLED BY ADMIN",
"exported properties": []

Response:

Access-Control-Allow-Credentials -true

Access-Control-Allow-0rigin -chrome-extension://aicmkgpgakddgnaphhhpliifpcfhicfo
Access-Control-Expose-Headers -

Content-Disposition -attachment; filename="report.csv"

_desired time, service name, customer number, target, vq for outbound calls, urs virtual queue
2017-07-04T22:00:00.000Z, callback-
gms,5115,Billing@Stat Server.GA,GMS Callback VQ OUT,GMS Callback VQ

Operation

POST /genesys/1/admin/callback/reportcancelled

HTTP/1.1

Connection: keep-alive

Content-Type: application/json

User-Agent: Mozilla/5.0 (Windows NT 6.1; WOW64) AppleWebKit/537.36 (KHTML, like Gecko) Chrome/
50.0.2661.102 Safari/537.36

Cookie: JSESSIONID=1ff402zwehsbx6fzdfwb66jsa

Authentication: Basic=....

"callback reason": "CANCELLED BY ADMIN",
"exported properties": [" service id, desired time"]

)
Response

desired time,customer number,exported propertiesl,exported properties2
2017-05-11T12:22:00+00:00,3329284556,exported valuel,exported value2
2017-05-11T12:21:00+00:00,3329284576,exported valuel,exported value2
2017-05-10T07:21:00+00:00,3329284577 ,exported valuel,exported value2

Implement Preview and Disposition Scenarios

If you implement a custom agent desktop and wish to integrate the Preview and Disposition scenarios
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to your Callback application, you need to configure Preview and Disposition options in your Callback

service. After you do this, your Custom Agent Application will receive the following UserEvent events
from Orchestration Server:

¢ CallbackInvitationEvent—The Callback invitation that contains the attached data for the preview.
The invitation includes the list of actions that the agent can perform-accept, reject, or cancel. Your

Agent application displays the actions and the attached data for the preview to the agent, then submits
a Preview Response to your Callback service.

e CallbackDispositionEvent—The Callback disposition event that provides the URL to which you submit

the disposition selected by the agent. Your Agent application then submits a Disposition Response to
your Callback service through this URL.
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Troubleshooting

This troubleshooting page lists basic information to help you fix some common issues on Genesys
Callback. If you do not find the answer to your issue, please refer to the latest known issues from
GMS Release Note.

A callback that was answered is blocked in queued or processing
status

In this scenario, the update query for this callback has failed. This means that you should update the
DFM files to ensure correct callback processing.

URS replies with errorresponse 404
URS could not find the subroutine that was started by the original WaitForTarget strategy with the

callback start request.

13:25:56.750 R I [19:10] routing interface request received:

urs/call/011b02924f228001/invoke, client=34(0RS_RTP_Nodel PR), ref=773
13:25:56.750 R I [19:12] routing interface errorresponse '404' sent to

client=34(0RS RTP Nodel PR), ref=773

To solve this issue, compile both the strategy and subroutine as described here.

Callback Calls in PAUSED State

GMS may pause sessions if the conditions of the _do_not_call_items service option are met and it
does not coincide with the operation hours. In this scenario, you can resume or abandon/fail sessions
using the following events:

* resume session—Continue the session and disable the do not call items option for the session.

e fail session—Exit the session.
To send the resume_session event to the Callback session, use the following request:

On GMS (Forward API):

$ curl -v http://<GMS server: GMS port>/genesys/l/ors/scxml/session/<0ORS session id>/event/
resume _session
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On ORS:
$ curl -v http://<ORS server: ORS port>/scxml/session/<ORS session id>/event/resume session

To send the fail session event to the Callback session, use the following request:
On GMS (Forward API):

$ curl -v http://<GMS server: GMS port>/genesys/1l/ors/scxml/session/<ORS session id>/event/
fail session

On ORS:

$ curl -v http://<O0RS server: ORS port>/scxml/session/<ORS session id>/event/fail session
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